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2 CHAPTER

Note: Visit our website at www.blackbaud.com for the latest documentation and information.

The Program Basics chapter is designed to familiarize you with screens, buttons, menu options, and terms used
throughout our software. The items described in this chapter include standard parts of a screen, toolbar buttons,
standard screen buttons, menu options, function keys, and common procedures. By reading this chapter, you can
become more comfortable using the program by familiarizing yourself with the screens, tools, and commands
used to navigate.

Understanding the Interface

Our software provides a wide variety of tools to make using the programs quick and easy. These tools are
accessed through a common interface designed for efficiency. The main component of the interface is the shell,
which is a centrally located hub for accessing all programs. This section describes the parts of the shell and other
components of the interface.

Parts of the Shell

The shell provides a central area where you can enter all areas of a program. When you click a link for an area, it
appears as a page in the shell.

If you have multiple databases, you can switch to a different database from the shell. Using the Create Links to
Blackbaud Systems utility on the Plug-ins page, you can add links to the navigation bar to access 6.x subsidiaries
directly from the shell. For more information about the Create Links to Blackbaud Systems utility, see “Changing
Passwords” on page 56.
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If you have security rights to change user options, you can set up the system to display specific information on the
Home page of each program, such as commonly used accounts and vendors, or action reminders. You can also
use Options to select another program or page as the default that appears when you open the software.

H Menu Bar | ’—{ Action Bar |

#% The Financial Edge
FEile Edit Yiew Go Favoites Tools Help
4 Back % Farvyand I Comrmunity Services Inc, * General Ledger ~ ‘
Shortcuts
B e
¥ Gereral ¥ Fiscal Years ¥ Distributions General
Define currency Formatting Define fiscal vears and periods Create a template ko distribute P
activity to accounts, projects,
b Account Setup b Tables classes, and transaction codes Setup
Define account struckure, default Create tables and define short Account
descriptions, and inwalid description, long description and b Interfund Codes
combinations skabus of each entry Create, edit and delete intberfund = m
. seks to bransfer activity between ransaction
b Account Codes b atributes accounts Codes
Define the codes used ta build & Define bypes and characteristics of
unigue account number project, account and transaction ¥ International M
. attributes Define international sddress Fiscal Years
b Transaction Codes , ) \ Formats —J
Define Up ta S transaction codestn P BUSiNEss Rules Tables
be used on transactions Custamize standard procedures and P Fee Sthedules Attributes
¥ Funck requirements within the systerm Define amounts andfor percentages
uncis b Field charged when calculating expense Business
Create funds and set up closing Figlds distributions Rules
methods for classes and other IMake fields required; change field 5
transartion charactetistics types; edit Field labels b Allocation Pools Fields
Create a pool of accounts organized Distributi...
by project, class, transaction code —J
or atbribute Interfund
Fee
Schedules
E i Allocation
Fools o
E Plug-Ins
Navigation Bar
Monthly Reports
“Weh Links ﬂ
|We\come to General Ledger i

Navigation Tabs

Note: We do not recommend using the X button on the title bar to close the program. To properly exit the
software, from the File menu, select Exit.

Title Bar. The title bar displays the product name and has buttons to minimize, maximize, and close the shell.

Menu Bar. The menu bar displays menus containing commands for various functions throughout a program. The
commands available depend on the area of the program you have open.

Action Bar. The action bar displays your organization name and the name of the program in which you are
working. You can use the Back and Forward buttons to quickly move through screens and areas. Much like a
Web browser, you can use these buttons to move to previously accessed pages.

Navigation Bar. The navigation bar contains links to all main areas of a program. When you click a link, a page
for that area opens in the shell and displays additional links to the utilities found within that area.

By default, the navigation bar is displayed on the left side of the screen. You can hide the navigation bar or
move it to the top, bottom, left, or right side of the shell. To move or hide the navigation bar, place your
cursor over the navigation bar and right-click your mouse to display a shortcut menu. Select Hide to remove
the navigation bar or move the location of the navigation bar by selecting Align Top, Align Left, Align Bottom,
or Align Right.

Navigation Tabs. The navigation tabs mirror the links on each page and provide an additional way to navigate
through the program.



4 CHAPTER

Parts of a Record Screen

Many record screens in our software contain the same standard parts. Understanding the various parts and how
each works is helpful when navigating in the program. The following batch record screen from Journal Entry in
General Ledger is an example of a commonly used record screen.

| Menu Bar | [Toolbar

Title Bar

%% New Batch ®
File Edt Yiew Batch Favortes Tools

Q) sove rtCione - | X[ 2 @[ 4 - 6 [0 o8 b 7] 2 -
Description: | Status:IDpen j Hide detaill

Help

Default set: I ﬁl W Automatically create balancing interfund entries
[~ Create bank adiustments when posting to a bank's cash account
Batch Maotes: d
=
Account number Account des Pozt date Encurbran... | Debit Amaount | Credit &
0 | Teps | | | |
1
KI 2

. . . N [ 3
Diztributian | Attributes | Notes |

seljurzt Toial Distribute by: _

Project I I Class I Mission | Spendable/... I Performance | Amount | Percent I

Action Bar m

[ Action gar |
?

Title Bar. The title bar displays the name of the record.

Remaining: $0.00  [100.0000%)

[Debits: $0.00 |Credits: $0.00 |Balancs: $0.00 | Y

Menu Bar. The menu bar lists commands for program functions related to the record. Our software has several
common menus including File, Edit, View, Favorites, Tools, and Help.

Toolbar. The toolbar contains buttons representing common commands. If you are unsure what command a
toolbar button represents, you can place your cursor directly over the button to access a “tooltip,” a pop-up
description of the button. You can use these buttons as alternatives to menu commands.

Note: You can activate or deactivate “tooltips” in Options on the General tab.

Tabs. Some records and other screens in the programs contain tabs. Like tabs on folders in a filing cabinet, these
tabs help organize information in your records. You access information by clicking a tab. You can also select a
tab by pressing ALT + the underlined letter in the tab name.

Action Bar. Many screens throughout the software contain an action bar that provides a centralized location to
perform common actions such as adding, editing, or deleting information. If you click the down arrow beside
the title on an action bar button, additional selections appear for that button.

Note: To move between rows in a grid column, press CTRL + the up or down arrow key.
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Grids. Grids contain columns and rows made up of cells. You can enter information into a cell by making a
selection from a drop-down list or simply entering text. You can also sort information in a grid by clicking the
column heading.

Status Bar. The status bar at the bottom of a screen or record displays important messages or helpful tips. For
example, when you place the cursor in a date field, a message states you can “Press F3 for Today’s Date, F7 for
Calendar.”

Menus

Numerous menu bar commands appear throughout the program. When you select certain commands from the
menu bar, a submenu may appear listing additional options. Some commands appear only in certain areas.

Tip: A shortcut key accesses a menu item when it is pressed at the same time as the ALT key. The shortcut key
letter for a particular menu item is underlined in the menu bar or on a button or tab.

You can also access menu bar commands by using shortcut keys. Most menu items as well as some buttons and
other features contain shortcut keys. A shortcut key accesses a menu item when it is pressed at the same time as
the ALT key. The shortcut key is immediately recognizable because it is underlined on the menu bar, button, or
tab.

To access a menu item with a shortcut key, simultaneously press the ALT key and the shortcut key letter for that
particular menu item. To access a submenu, press ALT, the letter on the main menu, and the key for the
underlined letter in the submenu command.

File Menu

The options on the File menu depend on the program and area in which you are working. You can use keyboard
commands to quickly access some File menu options. Where applicable, each keyboard command is included
with the File menu option description.

New. If you select New from the File menu of an open record, you can add a new record of the same type as the
record currently open.

If you select New without a record open, a submenu appears from which you can select a record type. The
keyboard command for New is CTRL + N.

Open. If you select Open from the File menu of a record, you can search for a record of the same type as the
record currently open.

If you select Open without a record open, a submenu appears from which you can select a record type. The
keyboard command for Open is CTRL + 0.

Note: Deleted records cannot be recovered without restoring to a backup.

Delete. When you select Delete from the File menu of a record, that record is permanently removed from the
database.

Save. When you select Save from the File menu of a record, any changes made to the record are saved. The
record remains open, and you can continue adding and editing information. The keyboard command for Save
iS CTRL +S.

Tip: Save and New can save you time when adding numerous records.

Save and New. When you select Save and New from the File menu of a record, any changes you made are
saved, the record is closed, and a new blank record opens. This eliminates the additional steps of saving and
closing the record, and then selecting File, New to open the next blank record. This feature reduces data entry
time when adding a large number of records. The keyboard command for Save and New is CTRL + E.
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Save and Close. When you select Save and Close from the File menu of a record, any changes made are saved,
the record is closed, and you return to the page from which you accessed the record. This eliminates the
additional steps of saving and closing the record. The keyboard command for Save and Close is CTRL + L.

Properties. When you select Properties from the File menu of a record, the Properties screen for the record
appears. The Properties screen displays such information as when and by whom the record was created, and
when and by whom it was last changed.

Print Setup. When you select Print Setup, the Print Setup screen appears. From this screen you can select the
printer to which you want to print, designate a paper size and source, and choose the paper orientation. For
more information about printing, see “Setting up a printer” on page 57.

Note: Some menu options are available only for specific programs.

Preview. When you select Preview from the File menu, the Select a Parameter File screen appears. From this
screen you can select or create a new parameter file to use when previewing a report. Select a parameter file,
and click Select to preview.

Print. When you select Print from the File menu, the Select a Parameter File screen appears. From this screen
you can select or create a new parameter file to use when printing a report.

Export. When you select Export from the File menu, the Select a Parameter File screen appears. You can export
the selected information in a variety of formats.

Send as Mail. When you select Send as Mail from the File menu of a record, you can send information via
email.

Recently Accessed Records. When you select Recently Accessed Records on the File menu, a submenu
appears listing the records opened previous to the current record. Select a record from the submenu to open
it.

Close. When you select Close from the File menu of a record, the record closes and you may be prompted to
save.

Exit. When you select Exit from the File menu, you exit the shell. Open records are closed when you exit, but the
database remains open and you can reenter the program without logging in using your password.

Exit and Sign Out. When you select Exit and Sign Out from the File menu, all open records are closed and you
exit the database and close the program. You must reenter your password to log back into the program.

Edit Menu

The options on the Edit menu depend on the area of the program in which you are working. The following options
appear on various Edit menus throughout the program.

Change Password. When you select Change Password from the Edit menu, the Password screen appears. If
you have security rights, you can change your password from anywhere in the program. For more information
about changing passwords, see “Changing Passwords” on page 56.

Note: Deleted records cannot be recovered without restoring to a backup.

Undo. When you select Undo, the previous action is reversed. For example, you can restore deleted text;
however, you cannot undo a deleted record. The keyboard command for Undo is CTRL + z.

Cut. When you select Cut with text highlighted, the text is removed from the record and placed on the Windows
clipboard where you can paste elsewhere. The keyboard command for Cut is CTRL + X.

Copy. When you select Copy with text highlighted, the text is copied from the record and placed on the Windows
clipboard where you can paste elsewhere. The keyboard command for Copy is CTRL + C.

Paste. To paste previously cut or copied text into a selected field or grid, place your cursor in a field or grid and
select Paste. The keyboard command for Paste is CTRL + V.

Delete. You can use Delete to delete highlighted text. The keyboard command for Delete is the DELETE key.
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Insert Row. When you select Insert Row while the cursor is in an editable grid, a row is inserted above the
currently-selected row. Use this command to enter information in hierarchical order.

Delete Rows. When you choose Delete Rows while the cursor is in an editable grid, the selected row(s) are
deleted.

Select Row. When you choose Select Row while the cursor is in an editable grid, the row in which the cursor is
located is highlighted.

Select All Rows. When you choose Select All Rows while the cursor is in an editable grid, all rows are
highlighted. The keyboard command for Select All Rows is CTRL + A.

Export Grid. When you select Export Grid while the cursor is in a grid, information in the grid is exported to
another file location.

Export Grid to Excel. When you select Export Grid to Excel while the cursor is in a grid, the grid is exported to
Excel if you have Microsoft Excel installed.

Find. When you select Find while the cursor is in a box listing field name entries, the Find screen appears. You
can use Find to find a specific field in a grid containing numerous entries. By using the Find screen, you can
quickly find an entry instead of spending time scrolling through entries. For more information, see “Using
Find” on page 24. The keyboard command for Find is CTRL + F.

Annotate. When you select Annotate, the Annotate screen appears. You can then create an annotation for the
record, which can be useful as a reminder of an important situation or condition regarding that record. The
keyboard command for Annotate is CTRL + T.

View Menu

With the View menu you can determine your “view” of the screen. You can select to see the navigation bar, page
heading, navigation tabs, and status bar. Options on the View menu change when accessed from different areas
of the program. The following options appear on various View menus throughout the program.

Navigation bar. The navigation bar provides links to all areas of the program you are currently in and is located
on the left side of the shell by default. This bar contains links to all main areas of the program. When you click
a link, that area appears as a page in the shell. You can hide the navigation bar or move it to the top, bottom,
left, or right side of the shell. To move or hide the navigation bar, place your cursor over the navigation bar,
right-click your mouse, and select an alignment from the shortcut menu.

Page heading. You can hide or display the page heading that appears below the action bar. The page heading
shows you where you are in the program at all times. You can hide the page heading or move it to the top,
bottom, left, or right side of the shell. To move or hide the page heading, place your cursor over the page
heading, right-click your mouse, and select an alignment from the shortcut menu.

Navigation tabs. You can hide or display the navigation tabs that appear by default on the right side of certain
screens. You can hide the navigation tabs or move them to the top, bottom, left, or right side of the shell.

Toolbar. You can hide or view the toolbar.
Status bar. You can hide or view the status bar.

Columns. This menu item is enabled only when your cursor is in a grid with changeable columns. When you
select Columns, the Define Column Order screen appears so you can arrange the columns in the order you
want them to appear in the grid. In grids with changeable columns, you can also click and drag a column
header to move it.

Go Menu

The Go menu provides another way of navigating the program. For example, if you hide the navigation bar, you
can still access those shortcuts from the Go menu. You can also move Forward and Back, and quickly access
different areas of the program.
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Record Menu

The title of this menu changes according to the record type. For example, the title is Account if selected from an
account record, or Invoice from an invoice record. This menu contains common options, as well as options
specific to the record you have open. The following common options appear on various Record menus
throughout the program.

First. When you select First, the first record of that type in your database opens. Depending on the type of
record, “first” refers to records listed alphabetically or numerically.

Previous. When you select Previous, the record appearing alphabetically or numerically immediately before the
current record opens.

Next. When you select Next, the record appearing alphabetically or numerically immediately after the current
record opens.

Last. When you select Last, the record appearing last alphabetically or numerically opens.

Go to <Record Type>. When you select Go to <Record Type>, the corresponding <Record Type> screen
appears. Not all records have the Go to option.

Restore Default Description. When you select Restore Default Description, the program recalculates and
applies the default account description to the current account. This option is available only on account
records.

Duplicate Search. When you select Duplicate Search, the program searches for duplicate records within your
organization’s database.

Load Defaults from. When you select Load Defaults from, the Field default sets screen appears. From this
screen, you can apply saved default sets or create new ones to apply.

Favorites Menu

Select the Favorites menu to create links to items you use most often or want to access quickly. These links are
called favorites. You can designate any saved record (including accounts, queries, imports, and reports) as a
favorite. You can also create links to Web pages you access most frequently. You can place favorites on the
Favorites menu, the Home page of a program, or the navigation bar. You can create folders of favorites and
shortcut groups to organize the records and pages you use for a particular task.

The following selections appear on various Favorites menus throughout the program. For more information
about adding and organizing favorites, see “Using Favorites” on page 46.

Add to Favorites. When you select Add to Favorites from the Favorites menu of an open record, you add the
record to your favorites. From the New Favorites screen, you also determine where you want the favorite
located — on the Favorites menu, the Home page of the programs, or the navigation bar.

Note: Favorites placed on the navigation bar or Favorites menu can be accessed from any page in the program
and from most screens.

Organize Favorites. When you select Organize Favorites from the Favorites menu, the Organize Favorites
screen appears. On this screen, favorites are organized in folders. There are pre-established folders for the
Favorites menu, the Home page, and the navigation bar. Within each of the folders for these locations, you
can create additional folders; move favorites from one folder to another; and copy, edit, and delete favorites
and folders. You can also specify the order in which favorites appear in a folder.

Add Page to Favorites. When you designate a page as a favorite using Add Page to Favorites, you create a
direct link to that page from the Favorites menu, the Home page, or the navigation bar. Using these links can
make navigating through the program easier and more efficient.
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Tools Menu

From the Tools menu you can access and define options, create default settings, activate optional modules, and if
you have the optional module Financial Edge: VBA, you can customize the software using Visual Basic for
Applications. The following options appear on various Tools menus throughout the program.

Organize/Create Defaults. Select Organize/Create Defaults to access the Defaults screen where you can
create and organize defaults and default sets.

Options. Select Options to customize the look of screens and establish a wide variety of default values. Options
are user-specific.

Note: Visual Basic for Applications is an optional module you can use to customize Blackbaud software for your
organization’s needs. For more information about Financial Edge:VBA, contact our Sales Department at
solutions@blackbaud.com.

Visual Basic for Applications. Select Visual Basic for Applications to customize the program.
Run Macro. Select Run Macro to run macros created in VBA.

Unlock Add-on Modules. Select Unlock Add-on Modules to unlock any optional modules your organization
purchases. To unlock an optional module, you must enter the unique activation key that comes with the
module; then the module is ready to use.

Help Menu

The Help menu provides access to the different sources of information available to assist you in using the
program. Help includes user guides and help files, plus links to support resources on the Blackbaud website. From
the Help menu, you can also check to see the version of the software you are using. The following options appear
on the Help menu throughout the program.

Note: You must enter your user name and password to access Support resources on the Blackbaud website.

Help Topics. When you select Help Topics, the help file opens. For more information about the help file, see
“Finding Help” on page 151.

User Guides. When you select User Guides, a page appears with links to the user guides available for the
program in which you are currectly working. When you click a link on the page, the user guide opens in PDF
format in a browser window. You can save or print the guide. To search the guide for a specific word or phrase,
press CTRL+F to open the Find screen. Enter the word or phrase and click Find.

Knowledgebase. When you select Knowledgebase, the Blackbaud website opens to our Knowledgebase where
you can search for answers to your software questions.

Frequently Asked Questions. When you select Frequently Asked Questions, the Blackbaud website opens to
our FAQ Library where you can find answers to the most frequently asked questions about your software.

Online Support. When you select Online Support, the Blackbaud Support website opens where you can search
Knowledgebase, check the status of existing cases or find additional support resources.

Note: We have renamed the Case Central menu option to Online Support. If you have not installed the latest
patch, you will still see the Case Central option. When you select Case Central, the Blackbaud website opens
to Case Central where you can check on the status of existing cases.

About. When you select About <Program Name>, you can learn helpful information about the specific program
you are using, including the version number, serial number, and other registration information. Click System
Info for complete information about your system.


www.solutions@blackbaud.com
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Right-Click Shortcut Menus

Note: You can also access a right-click shortcut menu by pressing SHIFT + F10.

You can access commonly used commands by placing the cursor in a box or grid and right-clicking the mouse.
Available commands vary depending on where you are in the program. Common right-click commands include
Open, Find, Export, and Print.

o ]

> Delete. .

(4 Find...

E Ewport Scenario List Grid...
Ewport Scenario List Grid to Excel...

=} it

Columns. ..

Properties

Buttons

Buttons quickly perform functions, such as saving, without using the menu bar. Some buttons contain a down
arrow that provides access to additional options. For example, when you click the down arrow beside the Save
and Close button, the Save and New button becomes visible. Buttons are located on the toolbar and screens.
Some buttons are available only in certain areas of the program while others are found throughout the interface.
If you have the tooltips option set in Options, you can move your cursor over a toolbar button to view its function.

These are some common buttons found throughout the program:

£

Search for data to enter into a field

o

Increase or decrease numbers in a field

=

Edit a query design

5

Open a calculator for easy entry of
amounts in currency fields

Move selected item to frame on the
right

]

Access a list of values associated with
that field

-]

Browse the system to select the correct
path and file name

Search for account number segments

Open a calendar to help locate the
correct entry for date fields

Move all items to the frame on the right



Move selected item to frame on the Move all items to the frame on the left

left

Function Keys
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You can use function keys to help speed your data entry and access information. The status bar at the bottom of
a screen indicates when a function key is available.

F1 The F1 key opens to the help file. Press this key from any point in the
program to access context-sensitive help.

F2 The F2 key inserts the default value of a field into the current record.
A message on the status bar at the bottom of the screen indicates
default fields.

F3 In date fields, F3 inserts the current date.

F4 The F4 key displays the list of table entries in a drop-down field.

F5 The F5 key refreshes grids and the bank register. You can also press it
to add a timestamp to a notepad.

F7 The F7 key accesses table lookups. This key also accesses a calendar in
date fields and a calculator in currency fields.

Selection Boxes

Selection boxes are commonly used to select fields or records to include in a group.

To move an item from one box to another, select the item and click a single arrow button or double-click the
item. To move all the items from one box to another, click a double arrow button. The following selection box is
from a security user record in Administration.

Groupsz for Company Lowcountiy Preseryation S ociety' -

' Supervisor ightz % Selected group rights
Mot a member of; Member of:
[1ata Entry
Development
Executive

Accounting

;>>
4
«

Tree Views

Tree views are hierarchical lists used throughout our software. They differ from standard lists in that items in a
tree view contain branches represented by dotted lines. Tree views are usually found on the left side of the
screen. When you select an item or branch in a tree view, options for that item appear on the right.
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Some tree views automatically display all branches; for others you must click a plus sign to view the branches. The
following tree view appears in the Visual Chart Organizer in General Ledger.

&[T Liabiliy
B[l Met Azsets
(] Account Detall - Met Assets
&1 Income Statement
&Ll Revenue
- {Z] Account Detail - Revenue
& Expense
: (2] Account Detall - Expense
EI [T Gitt
(2] Account Detal - Gift
E-{I] Transfer
2] Account Detail - Transfer LI

Tables

Tables are fields that contain predefined entries. Selecting information from a table can make entering your data
quick and consistent. Instead of typing an entry manually, you can simply select the entry from a list.

In some cases, such as the State table, the entries are predefined. For most tables, however, you can define table
entries if you have security rights. You can add or edit table entries from some fields on records tabs. Tables and
table entries are discussed in detail in the Configuration Guide designated for each program. You can access table
entries using five methods.

|E| A down arrow next to a field indicates a table lookup is
available. Click the arrow to access a list of entries for the
field.
Arrow Keys Place the cursor in a field and press the up or down arrow key

on your keyboard to scroll through the entries.

Typing Typing an entry into a field is another way to access an entry.
If the entry you type does not exist in the table, the program
displays a message asking if you want to add the new table
entry. Click Yes to add the new entry.

F7 Pressing F7 also accesses tables. The message “Press F7 for
Table Lookup” appears on the status bar when a table is
available.

Field name Field names for fields with table values turn blue when you

move your mouse over the field name. Click the field name to
access the table.

» Editing table entries
If you have security rights, you can add, edit, and delete entries for tables.

Tip: For ease of data entry, mark Automatically complete table entries on the General Tab of the Options
screen. If this checkbox is marked, the program automatically completes the remaining part of a table entry
when you start typing it. For more information, see “General” on page 66.
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1. With the cursor in a field with a table, press F7. A screen similar to the following Cash Flow screen
appears.

Cash Flow [ x|

ﬁ Mew Table Entry = | Onan = Insert W Dalsiz = Pint

Dezcription I

Casgh Flows from Operating dctivities
Cazh Flows fram [nvesting Activities

Casgh Flows from Financing dotivities

él:ia:z:h and Cash Equivalents

Select I Cahicel |

On this screen you can click buttons on the action bar to add new entries, open and edit existing entries,
insert a new entry at a specified point in the list, or delete entries. You can also move entries up or down
in the list and print a list of table entries for your records.

2. Select the entry you want to edit and click Open to make your changes.

3. Click OK to save your changes and return to the field.
Filtering Criteria

Note: A filter is a requirement that records must meet to be included in a query, report, mailing, template, or
other grouping.

For many applications, you can filter the information included in transactions or reports. Filtering narrows
information to only that which you need. For example, to run an open invoice report and include only invoices
with a post status of Not yet posted, filter by Post Status on the Filters tab. Only invoices with a post status of Not
yet posted recorded in the Post Status field of the invoice record appear on the report. Invoices with a post status
other than those selected do not appear on the report. For information about filters for a specific report or
transaction, see the corresponding reports guide.

On the Filters tab, you can include selected filters, a range of filters, or filters from an output query. The following
procedures explain how to filter using these methods.

Selected Filters

When you filter using Selected filters, a screen with a grid or selection box appears depending on the type of
criteria you are filtering.

The following procedures describe how select filters on the grid and selection box screens. You can use these
same basic steps to filter any report or transaction in the program.
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» Filtering by selected criteria using a grid screen

Although this procedure describes how to filter an invoice report in Accounts Payable by vendor, the basic
process is the same when filtering by selected criteria in other areas.

1. From an invoice report, select the Filters tab.

lQ Mew Invoice History Report I
File Edit “iew Favontez Toolz Help
SRR el \
1: Gener, ] Format |
- Clear &l Filters
Filkers I Include I Selected Filkers
vendors all <Al vendors =
Invoices all <Al Invoices >
Banks all <Al Banks >
Wendor Attributes all <Al Wendor Attribubes =
Invoice Attributes all <Al Invoice Attributes =
< Back | Mest » | Cancel Print | Freview | Layout |

Note: The Selected <Filters> screen varies according to the filter you select.

2. Inthe Include column in the Vendors row, select “Selected”. The Selected Vendors screen appears.

On this screen, you can include selected vendors, a range of vendors, or a previously created query of
vendors. Depending on your selection, different fields appear.

Selected Yendors

& QOuery

vendar Mame | vendor ID I

Ok I Cancel
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Tip: If you know the vendors you want to use, you can enter them directly into the fields without having to
search. You can enter the first few letters of a vendor name and click TaB. If the name is unique, it appears

automatically. If the letters match several vendors, an Open screen appears so you can select the correct
vendor.

3. Mark Selected. Enter a vendor name in the Vendor Name column or click the binoculars to access the
Open screen to search for a vendor. For more information about the Open screen, see “Finding and
opening a record” on page 27. To select additional vendors, press and hold the CTrL key while clicking

each vendor to include. For a range, select the first vendor, press and hold the SHIFT key while choosing
the last vendor.

Selected Yendors

® Queny

Wendor Mamne | Wendor [0 I

Hard Drive Computers
Auko Express

Russellson Janitorial Service

Ok, I Cancel |

4. Click OK. You return to the Filters tab. The vendor name now appears in the Selected Filters column in the
Vendors row.

lQ Mew Invoice History Report I
File Edit “iew Favontez Toolz Help

e = el |

1: General 2 Filters |§: Formatl

- Clear &l Filters
Filkers I Include I Selected Filkers

vendars Selected orive Computers, Auto Ex son Janitorial S

Invoices all <Al Invoices >

Banks all <Al Banks >

Wendor Attributes all <Al Wendor Attribubes =

Invoice Attributes all <Al Invoice Attributes =

< Back | Mest » Cancel Print Freview Layout
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» Filtering by selected criteria using a selection box screen

Although this procedure describes how to filter an invoice report in Accounts Payable by bank, the basic
process is the same when filtering by selected criteria in other areas.

1. From an invoice report, select the Filters tab.

lQ Mew Invoice History Report I
File Edit “iew Favontez Toolz Help
SRR el \
1: General 1 3 Formatl
&% Open ' Clear All Filkers
Filkers I Include I Selected Filkers
vendors all <Al vendors =
Invoices all <Al Invoices >
Banks all <Al Banks >
Wendor Attributes all <Al Wendor Attribubes =
Invoice Attributes all <Al Invoice Attributes =
< Back | Mest » | Cancel Print | Freview | Layout |

Note: The Selected <Filters> screen varies according to the filter you select.

2. Inthe Include column in the Banks row, select “Selected”. The Selected Banks screen appears.

Selected Banks

]|
Find: |
niclude these banks:
[ I Description [ Dezcription
Operating  Dperating Account
Fayroll Fayroll Account

SBLAR Student Billing % Accounts Receivable

a1~ 8]

Ok, I Cancel




PROGRAM BAsics 17

3. Select the bank account to filter by and click the single right arrow button. The bank appears in the
Include these banks box.

Selected Banks

Description

SB L AR Stdent Biling & Accounts Receivable

2]~ ¥]~

Ok, I Cancel |

4. Click OK. You return to the Filters tab. The bank account name appears in the Selected Filters column in
the Banks row.

lQ Mew Aged Accounts Payable Report E I
File Edit “iew Favontez Toolz Help

e = el |

1: General 2 Filters |§: Formatl

Filkers I Include I Selected Filkers |
Invoices all <Al Invoices =
Wendors all <Al vendors =
Banks Selected ﬁl
Post Statuses all <All Post Statuses:=
Invoice Attributes all <Al Invoice Attributes =
Wendor Attributes all <Al Wendor Attribubes =
< Back | Mest » Cancel Print Freview Layout

Range of Criteria

For many filters, you can designate a range of criteria to include in a report. Creating a range is a quick way to
select multiple filters of the same type rather than selecting each filter individually.



18 CHAPTER

» Filtering criteria in a range

Although this procedure describes how to filter an account report in General Ledger by a range of accounts,
the basic process is the same when filtering by selected criteria in other areas.

1. From an account report, select the Filters tab.

lQ Mew General Ledger Report I
File Edit “iew Favontez Toolz Help
SRR el \

1: General 1 3 Formatl

&% Open ' Clear All Filkers

Filters | Include I Selected Filkers Iﬂ

Funds all <Al Funds >

Accounts All <Al Accounts >

Account Attribukes all <Al Account Attributes=

Account Codes all <Al Account Codes =

Projects all <all Projects =

Project Attributes all <All Project Aktribukes >

Classes all Al Classes=

Transaction Atkributes all <Al Transaction Atkributes

Categories all <Al Categories=

Journals all <Al Journals =

Mission(s) all <Al Mission(s) =

Spendable/Mon-Spendabl. .. Al <All SpendablefMon-5pendableds) >

Petformance(s) all <Al Performance(s) = LI

< Back | Mest » | Cancel | Print | Freview | Layout |

2. Inthe Include column for the Accounts filter, select “Selected”. The Selected Accounts screen appears.
Mark Range.

Selected Accounts I

® Huery

From Account I Drescription I To Account | Description I

Ok I Cancel |

Tip: If you know the accounts you want to use, you can enter these directly into the fields without having to
search.

4. Inthe From Account column, enter the first account in the range or click the binoculars to access the
Open screen to search for an account. For more information about the Open screen, see “Finding and
opening a record” on page 27.
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5. In the To Account column, enter the last account in the range or click the binoculars to search for it.

Selected Accounts I
O Hange @ Query
From Account | Description I To Account I Description
01-1000-00 Cperating Cash Account 01-1450-00 Interast Receivable
KN 2
Ok I Cancel |

Click OK. You return to the Filters tab. The selected range of accounts appears in the Selected Filters

column on the Accounts row.

File Edit “iew Favontez Toolz Help

F e = el |

lQ Mew General Ledger Report I

1: General 2 Filters I§: Formatl

&% Open ) Clear Al Filters
Filters | Include I Selected Filters Iﬂ
Funds all <Al Funds >
Accounts Selected [11-1000-00 to 01-1450-00 ﬁl
Account Attribukes all <Al Account Attributes=
Account Codes all <Al Account Codes =
Projects all <Al Projects=
Project Attributes all <All Project Aktributes >
Classes all <Al Classes=
Transaction Attributes All <Al Transaction Attributes =
Categories all <Al Categories>
Journals All <Al Journals =
Mission(s) all <Al Missionis) =
Spendable/Mon-Spendabl. .. Al <All Spendable/Mon-Spendableds) >
Performance(s) all <Al Performancels) LI
¢ Back | Mest » Cancel Print Freview | Layout |

Output Query of Filters

On the Filters tab, you can select to filter by records using a saved output query. You can also create a new query

to use again in another area of the program.
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» Filtering criteria using an output query

Although this procedure describes how to filter an account report in General Ledger using an output query of
accounts, the basic process is the same when filtering by selected criteria in other areas.

1. From an account report, select the Filters tab.

lQ Mew General Ledger Report I
File Edit “iew Favontez Toolz Help
SRR el \

1: General 1 3 Formatl

&% Open ' Clear All Filkers

Filters | Include I Selected Filkers Iﬂ

Funds all <Al Funds >

Accounts All <Al Accounts >

Account Attribukes all <Al Account Attributes=

Account Codes all <Al Account Codes =

Projects all <all Projects =

Project Attributes all <All Project Aktribukes >

Classes all Al Classes=

Transaction Atkributes all <Al Transaction Atkributes

Categories all <Al Categories=

Journals all <Al Journals =

Mission(s) all <Al Mission(s) =

Spendable/Mon-Spendabl. .. Al <All SpendablefMon-5pendableds) >

Petformance(s) all <Al Performance(s) = LI

< Back | Mest » | Cancel | Print | Freview | Layout |

2. Inthe Include column for the Projects filter, select “Selected”. The Selected Projects screen appears.
Mark Query.

Selected Projects I

O Query @ Mone
Query name:l ﬂl

Ok I Cancel |

Tip: If you know the name of the query you want to use, you can enter it directly into the field without having
to search.
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4. Inthe Query name field, enter a query name or click the binoculars to access the Open Query screen to
search for a saved query. For more information about the Open screen, see “Finding and opening a

record” on page 27.

Selected Projects

Include: @ A

Cuery name: IPrc-iect Listing

o]

Cancel |

5. Click OK. You return to the Filters tab. The selected range of accounts appears in the Selected Filters
column on the Accounts row.

l@ Mew General Ledger Report I
Eile Edit “iew Favortez Tools Help
e & -

1: General 2 Filters |§: Formatl

& Open ) Clear Al Filkers

Filters | Include I Selecked Filkers Iﬂ

Funds all <Al Funds =

Accounts Selected 01-1000-00 to 01-1450-00 ﬂ

Account Attributes All <Al Account Attributes:=

Account Codes &l <Al Account Codes =

Projects all <All Projects =

Project Attributes all <Al Project Aktribukes s

Classes All <Al Classes>

Transaction Atkributes &l <Al Transaction Atkributes:

Cakegories all <All Categories>

Journals &l <Al Journals =

Mission(s) all <Al Missionis) >

Spendablz/Mon-Spendabl. .. Al <Al Spendable/Mon-5pendable(s) >

Performance(s) all <All Performanceis) > LI

< Back | Mext = Cancel Print Freview | Layout |

Sorting Information

You can sort information in lists and grids throughout the interface. You can sort information efficiently on the
Columns screen and in a grid. The following procedures walk you through the different methods of sorting lists

and grids.
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Sorting Lists

You can use the sort screen to sort lists of items. For example, if you have security rights to add and edit table
entries, you can sort the order in which table entries appear. For lists with numerous entries, you may want to

sort the order alphabetically to help find particular entries quickly.

» Sorting a list

Sorting options vary for lists. Some lists are sorted by clicking a Sort button while others have a Sort option on

the action bar. For this procedure, we sort the entries in the State table.

1. From the navigation bar, select Configuration. The Configuration page appears.

2. Select Tables. The Tables page appears.
3. Inthe column on the left, select State.

## The Financial Edge

Configuration
General
Account Setup
Account Codes
Transactian
Codes

Funds

Fiscal Years
Tables
Attributes
Business Rules
Fields
Distributions
Inkerfund
International
Fee Schedules
Allocation Pools

File Edit Wiew Go Favoites Took Help
& Back & Foniward ] Community Services Inc. = General Ledger ™
Shorteuts q
Configuration » Tables
*H Home
Im‘r = Mew Table Entry ‘ DOpen ‘ Delete |jnsart ‘ Sort | g | Dowr
Tope: [<1 Tables =l Short Description Long Description | Status lil
Currency Type =] A A Active
Department “B Alberta Aclive
Endovirment M anager AE AE ACI!"'B
Grant Managsr A Bilaska Lclive
oumal AL Llabama Lclive
Lacation HP AP Active
Media Type &R Likarsas Active
Motepad Tupe A5 American Samoa Active
Fhone Type L Alizona Active
Froject Status BC British Columbia Active
Froject Types CA Califarnia Active
5 cenario D co Caolorado Active
Service CcT Connecticut Active
2 Canal Zone Active
S ulfix DC District of Columbia Active
Title DE Delaware Active
Transaction Codes 1 fL Florida ) AD'!“'E
Transaction Codss 2 Fhd Federated States of Micr...  Active
Transaction Codes 3 fjfca Georgia Active
T Em— Transaction Codes 4 E‘U 5“5’“_ iclf“’e
lonthly Reports : Al Chive
————t==m= | [Transaction Codes & =
Web Links —I 14 iz At LI
Bark Reconciliation Add new table | Delete tatle | ™ Display active entries only
Welcome to General Ledger |

4. Click Sort. The Sort Table Options screen appears.

Sort Table Options
— Sort Order

[ %]
 scening o]
_Corcd |

" Descending Cancel

— Sort By
i+ Description
" Short Description

5. Inthe Sort Order frame, mark Ascending to sort in alphabetical order, or mark Descending to sort in

reverse order from Z to A.

6. Inthe Sort By frame, mark Description to sort table entries by long descriptions, or mark Short

Description to sort by short descriptions.
7. Click OK to save your changes.
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Sorting Information in Grids

You can also sort the information in a grid. You can sort columns, such as Date added, Description, and Status, in
ascending or descending order. Columns vary, depending on the grid you have open.

» Sorting information in a grid

Note: Sorting information that appears under a grid heading can help you organize a list.

1. Inthe grid on the Journal Entry page, click the Date added column heading. The list sorts in ascending
order with the oldest date at the top.

The Financial Edge |_ (5] x
File Edit “iew Go Favoites Tools Help

4 Back & Fopward J Commmunity Services Inc. + General Ledger ~

Mew Regular Batch Open Delete Fost Print Egport Find...  Change Batch Status. ‘
Batch type: I Regular Batch j Batch status: I Open and posted batches j
Description Status Added by Date changed _*
2 Lewiz JE Posted Supervizar 0141042002 Supervisor 01/10/2002
3 Accounts Payable - 01/10/2002 Posted Supervisor 0111042002 Supervisor 011042002
4 Cash Management - 01/10/2002 Paosted Supervizor 0141042002 Supervisor 01/10/2002
5 Investments Posted Supervizar 01/11/2002  Supervisor 01/11/2002
E Accounts Payable - 01/11/2002 Posted Supervisor 0111142002 Supervisor 01/11/2002
7 Membership Dues Paosted Supervizor 01/15/2002  Supervisor 01/15/2002
8 Reverse of batch 7-Membership Dues Posted man 01642002 man 01/16/2002
3 Membership Dues Posted van 0A16/2002  van 011642002
10 Operation Cash Paosted wan 01A18/2002  wan 01/18/2002
" Membership Dues - 2002 Posted man 01642002 man 01/16/2002
12 Development - 01/16/2002 Posted van 0A16/2002  van 011642002
13 Accounts Payable - 01/17/2002 Paosted Supervizor 01A7/2002  Supervisor 01172002
14 BE-2 Posted Supervizar 01/25/2002  Supervisor 01/25/2002
15 BE-3 Posted Supervisor 01/25/2002  Supervisor 01/25/2002
18 BB-4 Paosted Supervizor 01/25/2002  Supervisor 01/25/2002
| Monthly Reperts | |, 565 Posted Sweriser  OU/27/2002 Supewiser /272002 |
‘weh Links
Bark Reconciiation || ™ Only show my batches

‘Welcome to General Ledger |

2. Click Date Added again and the order reverses to descending order, with the oldest date at the bottom.

File Edit “iew Go Favoites Tools Help

4 Back & Fopward J Commmunity Services Inc. + General Ledger ~

Mew Regular Batch Open Delete Fost Print Egport Find...  Change Batch Status. ‘
Batch type: I Regular Batch j Batch status: I Open and posted batches j
Description Status Added by Date changed _*
) Payrall - 02,/19/2002 Posted Supervizar 02/19/2002  Supervisor 02/19/2002
32 Student Billing - 02/19/2002 Posted Supervisor 02/19/2002  Supervisor 02/19/2002
2B Studert Billing - 02/18/2002 Paosted Supervizor 02/18/2002  Supervisor 02/18/2002
27 Student Billing - 02/18/2002 Posted Supervizar 02/18/2002  Supervisor 02/18/2002
28 Student Billing - 02/18/2002 Posted Supervisor 021842002 Supervisor 021842002
23 Studert Billing - 02/18/2002 Paosted Supervizor 02/18/2002  Supervisor 02/18/2002
25 Project Allocation JE 02/01 Posted Supervizar 02/14/2002  Supervisor 02/14/2002
23 Overhead Allocation Posted Supervisor 0241142002 Supervisor 03/22/2002
22 Accounts Payable - 01/28/2002 Paosted Supervizor 01/28/2002  Supervisor 01/28/2002
17 BE-5 Posted Supervizar 01/27/2002  Supervisor 01/27/2002
18 Operation Cash Posted Supervisor 01/27/2002  Supervisor 01/27/2002
13 BB33 Paosted Supervizor 01/27/2002  Supervisor 01/27/2002
20 BE-E Posted Supervizar 01/27/2002  Supervisor 01/27/2002
21 BE-F Posted Supervisor 01/27/2002  Supervisor 01/27/2002
14 BB-2 Paosted Supervizor 01/25/2002  Supervisor 01/25/2002
| Monthly Reperts | | 863 Posted Swperiser  OU/2S/2002 Supewiser  OI/2S2002
‘weh Links
Bark Reconciiation || ™ Only show my batches

‘Welcome to General Ledger |

3. Click any other heading to reverse the sort order of the grid. When you click the heading, an arrow
appears showing the direction in which the information is sorted.
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Sorting Columns on a Screen

You can sort and hide columns on a screen to include or exclude specific columns of information. This is especially
helpful for hiding columns your organization does not use.

» Sorting and hiding columns on a screen

Although this procedure describes how to sort and hide columns on the Journal Entry page in General Ledger,
the basic process is the same in other areas.

1. From the Journal Entry page of General Ledger, right-click in the batch grid and select Columns from the
shortcut menu. The Columns screen appears.

Columns

ze theze fields to indicate which columnz should display in the selected grid.

Columns: Dizplay these columns:
Batch # :|
Date posted Drescription
Deleted by Status ll
Added by
[rate added

> |Date deleted

Last changed by
< | Date changed

f#h Find... |
Feset to System Defaultsl Ok I Cancel |

2. Inthe Columns box, select a column name and click the right arrow to move it into the Display these
columns box. Repeat this step for each column types you want to display.

3. To sort the order of the columns, select a column and click the up and down arrow buttons.
4. To return to the original default settings, click Reset to System Defaults.
5. Once you complete sorting the columns, click OK to return to the previous main screen.

Using Find

The Find button is available in many areas of the program to help you locate specific fields or items from a list in a
box or grid. It prevents you from having to scroll through lists with many entries that are not visible at the same

time in the box or grid.

» Finding a field
1. On the action bar of a screen with a grid or box, click Find. The Find screen appears.

Find ]|

Fec: R <

Find what: |

Match: I.-'l'-.n_l,l part of field j [T Match case

== | EaIen ere |
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From the Field drop-down list, select the field you want to find.

In the Find what field, enter the name of the entry you want to find. If you are unsure of the spelling, you
can use the wildcard character (*) for part of the entry.

4. Inthe Match field, select what your entry in the Find what field should match: “Any part of field”, “Whole
field”, or “Start of field”.

If you want the search to match upper or lower case in the field name, mark Match case.
When you click Find First, the first matching field is highlighted in the box or grid.

To find additional entries that meet your criteria, click Find Next.

To exit the Find screen, click Close.

Searching for Records

P N o w

To find and open a record, you can use the Open screen. On the Open screen, you search for a record based on
criteria you define. You can use it to search for a particular record or group of records.

The interface provides multiple ways to access the Open screen depending on your location in the program. You
can select File, Open on various screens, click the Open button on the toolbar, or select a link to open a specific
record type. For example, on the Accounts page select Open an Account and the Open screen appears ready to
search for and open an account record.

A |
Fitud: I.&ccnunt j Search using queny: |<Default> ﬁlgg

;_lr;lpier'l _?i Add a Mew Account Optiohz

Find Accounts that meet these criteria; M| E=act match only
Account: Iﬁ""""-"" ‘wWaorking Capital: I j
Dezcription: I j Cash Flow: I j

Status: IAC“VE j Class: I j
Categany: I j Last modified by: I j

Contra: I j Last modified an: Iany time j

Cartrok I =]

| Hide Filters | Clear Filtersl Previous Filtersl Filters are not applied IWI [IpEr | Cancel |

Open Screen Buttons
The various Open screens contain certain common buttons:

Show/Hide Filters. When you click Hide Filters, the filter fields are hidden so you can view more search results.
You can click Show Filters to view the filter fields again.

Clear Filters. When you click Clear Filters, the fields are cleared of any previous search entries so you can begin
a new search.
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Note: The Previous Filters button does not appear if you select either to load or refresh the results
automatically in miscellaneous search options.

Previous Filters. When you click Previous Filters, you can access a previously entered set of filtering

characteristics. This saves you from repeatedly entering the same filters each time you need to search for
similar records.

Find Now. When you click Find Now, the program searches for all records that meet your selected criteria.
Those records list in the results grid.

Cancel. When you click Cancel, the Open screen closes and you return to the previous main screen.

» Defining miscellaneous search options for records
To make searching easier on the Open screen, you can set time-saving options on the Miscellaneous Search
Options screen.

Note: You can also access the Open screen by selecting the Open a <Record> link or by selecting File, Open
from any record page.

1. From an open record, select File, Open. The Open screen appears.

Open
Find: IAccount j Search using querny: |<Default>
= |z A Add 2 New

Optionz )

Find Accounts that meet these criteria: M| Exact match only
Account: I""-""""-"" ‘working Capital: I j
Deseription: I >|  CashFlow: | =l

Status: IAC[i\.-e j Class: I j
Cateqany: I j Last modified by: I j

Contra: I j Last modified on; Iany lime j

Control: I j

. Hide Filters | Clear Fillersl Previous Filtersl Filters are not applied ,WI [Ipen | Cancel |

Press Shift F7 for Diepartment segment search
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2. On the action bar, click Options. The Miscellaneous Search Options screen appears.

Miscellaneous Search Options I
When opening the zearch window. .. -

™ Load the search results window automatically
' Click "Find Mow" to load the search results window

After changing the zearch critenia... -
" Refresh the search results window autamatically
@ Click "Find Mow'" ta refresh the search results window

If only one record found. ..
™ Load the record autamatically
% Digplay the record in the search results window

The output figlds and sort arder of the search resulks are
determined by the query you are Lzing.

Festore Default Account Query |

Default zearch field: |Account j

Cancel |

3. Mark an option for opening the search results window. To load a search results window automatically
when you access the Open screen, mark Load the search results window automatically. To manually load
results using the Find Now button, mark Click “Find Now” to load the search results window.

4. Mark an option for refreshing the search results after you change sort criteria. To refresh search results
automatically when you access the Open screen, mark Refresh the search results window automatically.
To manually refresh the results using the Find Now button, mark Click “Find Now” to refresh the search
results window.

5. Mark an option for what to do if only one record is found in the search. To open the record automatically,
mark Load the record automatically. To display the record in the search results window as usual, mark
Display the record in the search results window.

6. To restore the default query in the Search using query field on the Open screen, click Restore Default
<Record Type> Query. The default query is the record type only.

7. To select a different default search field, in the Default search field, click the down arrow and select a
field from the list. This field is contains the cursor when you access the Open screen.

8. Once you complete entering your options, click OK. You return to the Open screen.
» Finding and opening a record

Note: You can also access the Open screen by selecting the Open a <Record> link or by selecting File, Open
from any record page.

1. From an open record, select File, Open. The Open screen appears.
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For this example, we selected File, Open from an account record. The Find field defaults to the type of
record from which you accessed the Open screen. In this example, “Account” is the default entry.

Eoeer =
Find: I,&ccgunt j Search uzing query: |<Default> ﬂ'gﬂ

= |Dpzn A Add 2 New Account

Optionz

2 i | Exact match anly

Account: ﬁ-"""“-"" Working Capital: I j
Description: I ﬂ Cazh Flow: I j

Status: IActive j Class: I j
Categary: I j Last modifisd by: | j

Coritra; I j Last modified o |an_.,. time j

Canbral: I =l
l Hide Filters | Clear Filtersl Previous Filtersl Filters are not applied Find Mow I [Hpen | Cancel |

2. Inthe Search using query field, you can click the binoculars to select a query to use for the search or click

the magnifying glass to create a new query. You can select the query to use by default on the
Miscellaneous Search Options screen.

Note: We recommend that you search by only one or two of the most helpful criteria types because results

appearing in the grid must match all criteria you enter. Adding too many criteria in the filter fields can actually
prevent you from finding a record.

3. Enter criteria in the filter fields to help narrow your search. The criteria fields change depending on the

record type selected. You can enter a value in all fields or no fields, depending on how you want to filter
your search.

In text fields, such as Description, you can click the down arrow to access your recent entries in the field.
You can also use a wildcard character operator in place of a specific character or a series of characters the
data must possess to be selected. Wildcards are particularly useful when you are not sure of the spelling
of a name or you suspect something is spelled incorrectly. If you mark Exact match only, the search finds
only records matching whole words you enter. You cannot use wildcards if you mark Exact match only.

¢ Use the question mark to replace a single character. The search finds every possible spelling of the
word, substituting one letter wherever you have placed a question mark. For example, if you want to
locate records with a description such as “Smith” or “Smyth Trust”, but cannot remember the correct
spelling, you can use a criteria description like “Sm?th Trust”.

Note: You can use more than one question mark in a wildcard search, and you can combine wildcard

characters in a search. For example, you can use a description like “Sm?th*” to find records that include
“Smith” or “Smyth” followed by a series of characters.

¢ Use the asterisk to replace a series of characters. For example, you can enter a criteria description like
“Smith*” to locate all records that are like “Smith” followed by a string of characters, such as “Trust”.
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¢ Use brackets to find a range of values or several specific values. For example, you can use a criteria
description beginning with [S-Z] to locate all records with descriptions beginning with any letter in the
range S through Z. When you place commas between values within the brackets, the query finds only
data with the specific values listed. For example, if you select a criteria description beginning with
[A,C,F], the query finds only records with descriptions beginning with an A, C, or F.

4. Click Find Now. If the search criteria you enter matches a record in the database, it appears in the grid on
the Open screen. If you entered the first few letters or characters in the criteria fields, or used general
criteria that apply to several records, more than one record may appear in the grid.

Note: To clear search criteria so you can change the scope of your search, click Clear Filters.

5. All records matching the selected criteria appear in the search results grid. In the grid, you can open a
record by double-clicking the record or by selecting it and clicking Open.

» Finding and opening a record using the Search field

Tip: To save time when searching for a specific record, you can use the Search for a <Record> by <ID> field.

If you know all or part of the record number or ID of a record you want to open, you can use the Search field.
This field is located on the record page of each record type. This feature saves time because you can open a
specific record directly from the record page without using the Open Screen.

1. From the record page, enter all or part of either the record ID or record number in the Search for a
<Record> by <ID> field.

Whether you should enter a record ID or record number depends on the record type for which you are
searching. Depending on the record type, in the Search for a <Record> by <ID> field, you enter a record
number, a record ID, or the ID or name.

#% The Financial Edge

File Edit “iew Go Favortes Tool: Help

4 Back  ® Forivarcl ] Carmrnunity Services Inc, * Accounts Payable ™

Shorteut: a
s i Records * Vendors

T RemE :I Records
What do you want to do? Products
wendors
m Add 2 New Vendor Invoices

- Recurring
E Open a Yendor M= J
- Credit Memos
\‘r/ Edit options for vendors Purchase Orders
: Receipts

Search for a Vendor by vendor name

Access a Recently used vendor

14 - Amatao Business Systems

0087 - Amato Business Systems

23 - Hard Drive Computers

85 - Bill Johnson Automobile Sales Inc,
39 - Bakker & Associates

Monthly Reparts
Weh Links -]

Welcome to Accounts Payable Dane
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2. Press ENTER on the keyboard or click the binoculars. The program locates the record and the <Record
Name> screen appears.

@ 55 - Twin Bridges Printing !E

File Edit View ‘endor Favortes Tools Help
E]SaveandCIosev| = Xl@ §| M 4 » M |% @|E||

Mates | Histary of Changes I Media I Actionz
Wendar I Achivity | Recuring I Purchase Orders | Addiesses I EFT Bank Information I Distribution | Attributes

?- |

Yendor name:

Vendor ID: 55 Address: 1010 E ast Bay Street ;I
I 4' Charleston, 5C 23401
Status: I;ﬁ.ctive j r

Customer number: I

Caontact: | IHeather Crossover

Tax D number. | —_ |
‘ozition: [~ Piint?
Terms: I |
Contact Type | Contact Mumber |
I Creditlimi. | | [Business (800 465-8996
Payment method: I[:heck j |
Payment options: IUne payment for all invoices j User 1D: I
Bank account: I B LE |
™ 1099 vendaor? @ /058 Distrbution,... |
| | Active |

If the program is unable to locate the record based on the information entered, a message appears asking
if you want to search for the record.

3. Click Yes. The Open screen appears. From this screen you can enter filters to help narrow your search. For
more information, see “Finding and opening a record” on page 27.

Saving Records

Our programs offer a variety of ways to save records.

¢ To save a record as you work — Select File, Save, click the Save button on the toolbar, or press CTRL + S on the
keyboard.

¢ To save and close the current record, and open a new record — Select File, Save and New or press CTRL + E on
the keyboard. You can also click the down arrow beside the Save and Close button and select Save and New.

¢ To save and close a record, and return to the main screen for that record type — Select File, Save and Close.
You can also click Save and Close on the toolbar or press CTRL + L on the keyboard.

Deleting Records

Warning: Deleting permanently removes records from your database. There is no undo for deleted records.

When you delete a record, you completely remove it from your database. To delete an open record, select File,
Delete or click the Delete button on the toolbar.
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Making Records Inactive

As an alternative to deleting a record, you can make some records inactive if you have security rights. Inactive
records do not appear in searches or queries and cannot be associated with other records; however, unlike
deleted records, they remain in your database for historic purposes.

» Making a record inactive

Note: Making records inactive is a good alternative to deleting them. Inactive records cannot be associated
with other records.

1. Locate and open a record you want to make inactive.
2. On the main record page, in the Status or Active/Inactive field, select Inactive.

{{) Ashley Smith _ (O] x|
File Edit M“iew Client Favortes Tool: Help
ESaveandClosev|n||ﬁ§|N L H|E| |?' |
Statements | History of Changes I Recuring | Achvity
Client 1 | Cliant 2 | Diefaults | Addreszes | Adtributes | Hotes | Media | Actions | Fielationships | Payers
Client M ame: | I.&shle_l,l Smith
Client 10 |1 4 Country: |United States j
Status: W\ =] | Addess | [7EPaksst ]
R ( *_ H
Service Providers E.nho.l.d o City: |Springfield
) AT I ;
Gender: IFema|ej S5M: | Shate: Wi ~| ‘iginia
Birth date: |05/091965 Age |35 ZIP: |44543
Religior: I j Contact Type | Cohtact Murnber
E thiicity: I j ||
Uger |D: I
PIN: |
|F'ress F7 far table lookup 4

3. To change the status to Inactive, save the record.

Searching for Duplicate Records

Note: We recommend you set business rules in Configuration to automatically check for duplicate records. For
more information about business rules, see the Configuration Guide for the program.

For certain record types you can establish business rules in Configuration to specify duplicate criteria and check
for duplicate records automatically. We recommend you establish these business rules before entering any
records to help maintain the integrity of your data. For more information about business rules and defining
duplicate criteria, see the Configuration Guide for the corresponding program.

In Administration, you can also search for duplicate records by running duplicate reports. You specify duplicate
criteria, run a duplicate record report, and can also create an output query of duplicate records. For more
information, see the Administration Basics chapter in the Administration Guide for the corresponding program.
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You can search for duplicates for these record types:

General Ledger Projects, if you have the optional module Projects and
Grants

Accounts Payable | Vendors, Invoices, and Credit Memos
You can also run a utility to merge duplicate vendor

records.
Accounts Clients, Charges, Credits, Invoices, Payments, and
Receivable Refunds You can also run a utility to merge duplicate

client records.

Cash Receipts Payments
Fixed Assets Assets
Student Billing Students, Individuals, Organizations, Charges, Credits,

Advance Deposits, Financial Aid, Billing Schedules,
Payments and Refunds

Admissions Office | Applicants, Faculty/Staff, Individuals, Organizations, and
Rooms

Registrar’s Office Students, Faculty/Staff, Individuals, Organizations,
Courses, and Rooms

While we recommend that you set the business rule to automatically check for duplicate records when saving a
new record, you can also search for duplicate records directly from an open record. The duplicate search is based
on the duplicate criteria you established in business rules in Configuration.

» Searching for duplicate records from a record

This procedure describes how to search for duplicate invoices from an invoice record in Accounts Payable.
The steps are essentially the same for each record type that includes a duplicate search.

1. From an open invoice record, select Invoice, Duplicate Search from the menu bar. The program searches
for duplicates.

2. If no duplicates are found, a confirmation message appears stating no duplicate records were found. Click
oK.
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If duplicate records are found, the Duplicate Search Results screen appears.

Duplicate Search Results I

The system found the following invoice matching the duplicate criteria specified in Configuration.

Duplicate Invoices

Invoice 3

ok [ view ]

3. To view a record found as a duplicate, select the record and click View. The records opens.

4. To close the Duplicate Search Results screen, click OK.

Adding Attributes to Records

Note: Attributes are defined in Configuration for each record type. For more information about defining
attributes, see the Configuration Guide for each product.

You can use attributes to add detail to records. When you use attributes, you can group records for reports,
queries, and mailings. For more information about using attributes, see the Records Guide for each product.

» Adding an attribute to a record

This procedure walks you through adding a table type attribute to an applicant record in Admissions Office.
You can use this procedure as a model for adding attributes to other types of records.

Warning: You cannot delete certain items, such as attributes or table entries, if they are in use on a record.



34 CHAPTER

1. From an open applicant record, select the Attributes tab.

) Bentley James Smith =

File Edit “iew Applicant Favortes Tool: Help
E]Saveandﬁlosev|u||3§|" 1 b N|W@®|D| |?v |

Bioll Bio 2 I Applications I Addiesses I AddresseesS alutations | Relationships | Checklist I Financial &id I Education I Testsl

Medical | Actions | Activities Altributes | MNotes | Media
o <Al Categories: - - Uo Dogn -
Attribute Type I D escription I Short D escription I Date I Required I Comments I
r

| v
2. Inthe Attribute Type column, select the attribute to add.
3. In the Description column, select the value of the attribute
4. In the Date column, select the date the attribute was added.
5. In the Comments column, you can enter additional comments.
S[=] B3

) Bentley James Smith
File Edit “iew Applicant Favortes Tool: Help

E]Saveandﬁlosev|u||3§|" Y "|W@®|D|

Bioll Bio 2 I Applications I Addiesses I AddresseesS alutations | Relationships | Checklist I Financial &id I Education I Testsl

Medical | Actions | Activities Altributes | MNotes | Media

-2 <Al Categories> - - Uo Dogn -
Atribute Type I Description I Short D escription I Date I Required I Commnents
Estra-curricular act... Yarsity Soccer 06/03/2004 - Ben lettered in soccer last pear,

6. To save the record, click Save and Close.
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Adding Notes to Records

You can use notes to include useful information and messages with your records. For example, you can enter
account and project notes on the Notes tab of account and project records.

» Adding a note to a record
1. From an open record, select the Notes tab.

2. Click New Note on the action bar. The New note screen appears. The Date field defaults to the current
date; however, you can change the date.

New note for 01-11000-00 H|

File Edit Motes Fommat Help

saveandClose~| | |2 @[ W ¢ » |2 2~

[MS Sans Seri Zfn B r uls==i=

Date: [EEETE Tile: |

e | j Authar: |Supewisor j
Description: |

|Press F3 fr today's date, F7 for calendar

3. Inthe Title field, enter a title for this note.
4. In the Type field, select the type of note you are entering.

Note: Note types are defined as part of the Notepad Type table in Configuration. For more information about
note types, see the Configuration Guide for the program.
5. Inthe Author field, select your user name.

6. Inthe Description field, enter a description of the note, for example, “Contact information”. The
description is visible on the Notes tab of the record and is helpful if your note is long and detailed.

7. Inthe notes box, enter any information you want to include with the record, for example, contact
information for an organization or bank related to the account.

8. Click Save and Close to save your note and close the record.

Using Actions

The Actions tab tracks any tasks or activities you complete for a record. For example, on an asset record, you can
include actions for scheduled maintenance, cleaning, or moving an asset. If you have the appropriate security
rights, you can add, edit, and delete actions from this tab.
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Actions are helpful because you can assign an action to another person, and the program reminds him or her
when the action is due. You can also assign actions to yourself. For example, if you must call an auto service
center to schedule annual maintenance for a vehicle, you can assign the phone call as an action. When it is time
to make the call, the program reminds you by adding an action reminder to the Home page of each program.

» Adding actions to a record

This procedure walks you through adding an action to an asset record in Fixed Assets. You can use this
procedure as a model for adding actions to other types of records.

1. From an open record, select the Actions tab.

&' A-Multimedia E quipment CTo=] I
File Edit “iew Aszset Favortes Tools Help
E]Saveandclosevux“ﬁv%v H 4 » N|2|E|| 2. |

ﬁenerall Distrilgutionl Frojected erreciationl Activity  Actions |I__ocati0n| Attribgtesl Medial Hotesl Histary of Ehangesl

<all Action Types> = I<AII Action Statusy = I<AII Assighess> = I

Completed? I Action Date/ | Action Type I Statuz I Pricrity I Description I Asgsighed to I

| | 2

2. Click New Action to create a new action. The New Action screen appears on the Actions tab.

# Mew Action for 4 %]
Ele Edit “iew Action Help
ESaveandClosev|u X|H 4 » u|g"|?- |
Action IAttribgtesl

Aszset number; |4 gl 10: 4

Al s I j ™ Autc-Femind b

Send reminder to; ISupe[\fiso[ j
Action date: I Time:l
Set reminder for I‘I IDayS vl beforehand

Status: I j

Priority: INormaI j [~ Caompleted on I

Agzzigned to: I j

D escription: =

3. The Asset number field defaults to the assigned number for that asset. The asset ID appears to the right
of the field.

4. In the Action type field, select type of action. Action types are defined on the Tables tab of Configuration.
5. In the Action date and Time fields, enter a date and time for the action to be completed.
6.

In the Status field, select an action status. Action statuses are defined on the Tables tab of Configuration.
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11.

12.

13.

14.
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In the Priority field, select “High”, “Normal”, or “Low”.
In the Assigned to field, select the person responsible for completing the action.

To send the user a reminder, mark Auto-Remind. When you mark Auto-Remind, the other options in the
frame become active.

In the Send reminder to field, select the user to be reminded.

In the Set reminder for [ ] beforehand field, specify how many days, weeks, or months before the action
date you want to send the reminder.

When the action is complete, you can mark Completed on, and today’s date automatically appears in the
field.

In the Description field, add notes to describe the action.

i New Action for 4 I
File Edit Yiew Action Help
E]Saveandtlose-|u Xl ;. [ [ 2 N|Q‘ ? - |
Action IAttribgtesI

Aggat number: |4 8] 10: 4

; " -Remind 3%

Action type: IMaintenance j A il £

Send reminder to: Isupewisor =]

Action date: [03/19/2004 Timez 12:00 FM

Set reminder for I‘I I Days - l beforehand

Status: INot started j
Priority: INormaI j ™ Completed on I
Agzzigned to: I Liza j

Descrption: |Fouting oil change and bune-up

Ll

|F'ress F7 ta zoom |

Click Save and Close. You return to the Actions tab. The new action appears in the grid.

» Viewing action reminders

Action reminders are for informational purposes only. You cannot add or edit data on the Action Reminders
screen.

Note: You can also view action reminders assigned to you on the Home page of each program.

1.

2.

From the shell menu bar, select View, Action Reminders. The Action Reminders screen appears.

% Action Reminders for Supervisor | x| I

Due Date I Syzhem I Type I Status I Description I
| |09/01/2003  Admissions Offices... Mema Femird s, Rivers to turn in h..
= 101672003 Admissions Offices...  Phone call Pending Schedule a conference with M. ..
= 102072003 Admigsions Offices...  Phone call Completed Give Jenny a call and find out 1...

Cloze |

To open an action in the grid, select the action and click Open Action. The action record appears.
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To return to the Action Reminders screen, click Save and Close.

3. To close the Action Reminders screen, click Close.

» Printing action reminders
1. From the shell, select View, Action Reminders. The Action Reminders screen appears.

&% Action Reminders for Supervisor I

A Export to Print
Due Date I Supztem Tupe Status Description I
= 03/01/2003  Admissions Offices...  Memo Remind Mrs. Rivers to tumin h...
= 101622003 Admigsions Offices...  Phone call Pending Schedule a conference with b, ..
= 102072003 Admizsions Offices... Phone call Coampleted Give Jenmy a call and find out ...

Cloge |

2. To print the action reminders, click Print. The Print Grid Options screen appears.

Print Grid Options ]

General | Sample Output |

Header: |

Footer: I

Faper orientation: ILIse printer default j

™ Display row grid lines
™ Display column grid lines
™ lgnore grid color settings
W Mumber pages

™ Size columns ta fit page

Frrirt I Cancel |

[ | Total Pages: 1 | Portrait A

3. To select the format of the action reminders printout, complete the Print Grid Options screen. For more
information about printing grid options, see “Editing print grid options” on page 58.

To print the action reminders and return to the Action Reminders screen, click Print.

5. To close the Action Reminders screen, click Close.
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1. From the shell, select View, Action Reminders. The Action Reminders screen appears.

&4 Action Reminders for Supervisor

Cloze |

Due Date I Syzhem I Type I Status I Description I
| |09/01/2003  Admissions Offices... Mema Femird s, Rivers to turn in h..
= 101672003 Admissions Offices...  Phone call Pending Schedule a conference with M. ..
= 102072003 Admigsions Offices...  Phone call Completed Give Jenny a call and find out 1...

2. To export the action reminders, click Export to Excel. A processing screen appears. When processing is
completed, Excel opens with the exported action reminders.

Eile Edit Yiew Insert Format Tools Data Window Help Aciobat

£ Microsoft Excel - BE1_1.xls HEE

=18l x|

DEHE S8 2

| M5 Sars seii . 10 -|B I U

%%,

=

+a0 00
0 40

022 | =|
|

A | B € | 0 [ E [ F T G [ H ]

Due Date System  Type Status Descriptio Company

09/01,/200% Admissior Memo Fermind kW Comrunity Services Inc
10/16/200% Admissior Phone cal Pending  Schedule Community Services Inc.
1042042002 Admissior Phone cal Completed Give Jenn Community Services Inc.

e ] o o

=)

)

3. In Excel, you can edit, save, or print the action reminders.

Adding Media to Records

On the Media tab you can store media objects about a record. You can create new media objects or browse to
files with previously created objects. Media objects can include items such as newspaper clippings, letters,

graphs, pictures, and video clips.

» Adding a new media object to a record

Note: When you add new media, you access applications outside of the program to create the new media

object. These objects are saved in the database.
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From an open record, select the Media tab.

&' 191-Bell Atlantic Key Telephone [ =] =]
File Edit Wiew Asset Favortes Tools Help
ESaveandEIosevlu X||3. §|N 4 N|@MoveAsset|2|D|| ? - |

ﬁenerall Distril_:utionl Frojected Depreciationl Activit_lgl Actiongl |__0c:ati0n| Attibutes  Media I N0t9§| Histaory of Changesl
@ Newbedia = |Opan 20

Pl

VEEENRTEES <Al Media Typess -/

Type \_l Date | Authar |

Description |

2. On the action bar, click New Media. The Insert Object screen appears.

Ingert Object I

oo
& Create New R
ctorBer Class Cancel |
™ Create from Fil Adobe Acrobat Document
EREHEMEE s dobe® Table 3.0

BELoad Control
Bitmap Image .
Calendar Control 8.0 I Display &s lcon

CODEwW inampControl Clazz LI

Rezult

. Ingerts a new ActionByr Class object into your
document.

3. To create a new media object, mark Create New.
4,

In the Object Type box, select a media object. The object types that appear depend on the applications
you have installed.

Note: To display the media object as an icon, mark Display as Icon.

5. Click OK. The New Media screen for the selected record appears.

6. Inthe Date field, enter the date you add the media object.

Note: Options in the Types field are defined on the Tables tab in Configuration. You can add new types “on the
fly”.

7.

In the Type field, select a media type. You define media types in Configuration.
8.

In the Description and Title fields, enter a description and name for the media object. In the Author field,
select your user name.

Note: If you marked Display as Icon on the Insert Object screen, the object icon appears in the bottom frame.
If you did not, a blank box appears in the frame.
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9. Double-click the icon or box. The application used to create the media object opens. For example, to

create a worksheet, Microsoft Excel opens.

‘i New Media for Bell Atlantic K.ey Telephone H=] E3
Edit “iew Insett Format Toolz Data Acrobat Help

ESaveandElosev|u Xl“ 14 b ll| ?- ‘
Date: IDEH 72002 Authar: IS uperyisor j
Type: Iworksheet j Tithe: ILocations of phones

Deseription: | jsts locations and extensions for each phone ;I

|[» [#1] Sheet1 141

AR

10. Create the media object.

11. Click Save and Close. You return to the Media tab, and the media information appears in the grid.

» Adding a media object to a record from a file

Note: When you create media from a file, you browse to media objects in saved files. If a media object is no
longer valid or current, you can access the object and delete it from the Media tab of the record.

1. From an open record, select the Media tab.
2. Click New Media. The Insert Object screen appears.

Insert Object I

Cancel |

@ Create Mew

Adobe Acrobat Document
Adobe® Table 2.0
BELoad Control

Bitmap Image .
Calendar Contral 8.0 I™ Dizplay Az lcon

CODEwW inampControl Clazz LI

= Create fram File

Result
Ingerts a new ActionByr Class object into your

document.

Tip: Mark Link so when you make changes to the graphic, those changes automatically appear on the Media

tab.
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3. Mark Create from File to add a media object from a file you previously created and saved. Click Browse to
search for the file.

Ingert Object H I

0K, |
 Create N
IR IR File: Faint Shop Pro 6 Image Cancel |

&' Create from File IE:\M_I,I PicturesiMikon_280_camera.gif

Browse...

™ Display s lcon

Result

Inzertz a picture of the file contents inta your

_'@ document. The picture will be linked to the file 20

that changes ta the file will be reflected in pour
document.

Warning: If the program cannot find an application, source file, or item, make sure the application is properly
installed and that it was not deleted, moved or renamed.

4. Click OK. The New Media screen for the selected record appears with the selected media object.

‘! Mew Media for Nikon 280 camera =] E3
File Edit “iew Meda Help

ESaveandElosev|n )(| H 4 » N|| o ‘

Date: IDEH 72002 Athor: I j

e | Bl e ]

Description: ;I
[~

|F'ress F3 for today's date, F7 for calendar

5. In the Date, Type, Title, and Description fields, enter information about the media object.

Note: You define media types in Configuration. You can also add new types “on the fly”.
6. Inthe Author field, select your user name.

7. Click Save and Close to save the media object and return to the Media tab.

Adding Annotations to Records

If you want to be reminded of an important situation or condition regarding a particular record, you can create an
annotation for the record.
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» Annotating a record

Note: Each record can have only one annotation.

1. From an open record, select Edit, Annotate or click the Annotate button on the toolbar. The Annotate
screen appears.

Annotate

Current Annotation:

Save
Cancel

Delate. .

LCopy

i [Pl

Paste

¥ Dizplay annotation autamatically

2. In the Current Annotation box, enter the information you want attached to the record.
3. For the annotation to pop up when you access the record, mark Display annotation automatically.
4. Once you complete the annotation, click Save to return to the record.

Using Default Sets

Note: When you mark the Automatically load field defaults checkbox on the Field default sets screen, the
default set is loaded to only the open record. The default set does not load automatically to records added
after the current record.

Creating default sets is an optional task you can use to speed data entry. A default set can contain entries for
almost every field in a record. If you repeatedly enter the same values in numerous record fields, you can create a
default set with these values and use it to save time during data entry. You can load an entire default set at one
time to an open record when you mark the Automatically load field defaults checkbox on the Field default sets
screen. If you prefer to load defaults into only selected fields, you can use the F2 key to load defaults into only
selected fields. In addition, if you press SHIFT + F2, you can load default sets into multiple fields for an open
record.

You can always manually change any field on a record after entering a default set. You can also load default sets
into existing records. If a field in the record already contains a value, the default does not replace it, but default
values from the set are entered in fields that do not contain data. However, after you load the default set, if you
press F2 on your keyboard while the cursor is in a field for which you defined a default, the default entry does
overwrite the existing entry.

You can create a default set from the Tools menu or from the new record screen, following essentially the same
steps. Step-by-step procedures for creating default sets from the Tools menu and loading a default set from an
open record are included in this section.

» Creating a record default set from the Tools menu

Tip: You can press F2 to load default values into individual fields in an open record. Press SHIFT + F2 to load
default set values into multiple fields in an open record.



44 CHAPTER

1. From the menu bar of the program shell, select Tools, Organize/Create Defaults. The Defaults screen

appears.
Defaults I
Create defaults for: Saved default sets:
e
[pen

Delate, . |

LCloze |

[ Shaove only rmy default ssts

2. In the Create default for box, select the record type and click New. The New Default Set screen appears.

Mew Default Set
File Edit “iew Default Tool: Help
| Save and Close - | = | W4 » H|?- |
M ame: I
Purchase Order Defaults
- Attributes -
Field Mame Defaulk Value
Purchase ordet number
Type
Order date
Expiration date
FOB
Terms
Buver
Department
Confirm bo
Attention
Comments
ship via
| I

3. Inthe Name field, enter a descriptive name to help identify this record default set.
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4. Inthe <Record> Defaults grid, enter a value in the corresponding field for each field default you want to
include in this default set. Available fields vary according to record type.

Mew Default Set

File Edit ‘iew Default Toolz Help

d Save and Close =

.i-‘ |N<vri

¥

Mame: I

B-Purchase Order Defaults

- Attributes

Purchage Order Defaults

Field Mame

Defaulk valus

Purchase order number

Type Regular
Order date

Expiration date

FOB

Terms

Buver Tom Johnson
Department

Confirm ko

Attention

Comments

ship via UPs

5. Select Save and New to save the record default set and open a new one, or select Save and Close to save
and exit the New Default Set screen.

» Loading default sets

When adding information to records, you can save time by loading default sets rather than entering the values
manually each time. Once default values are entered into fields, they can be deleted or overwritten at any

time.

1. From an open record, select <Record>, Load Defaults from. The Field default sets screen appears.

Field default sets

™ Only ghowe my default sets

[ Autoratically load fisld defaults

Open |
Delete... |

2. To view only the default sets that you created, mark the Only show my default sets checkbox.

Note: When you mark the Automatically load field defaults checkbox on the Field default sets screen, the
default set is loaded to only the open record. The default set does not load automatically to records added

after the current record.
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3. In the Saved default sets box, select the default set to load.

4. To automatically load field defaults to the open record, mark the Automatically load field defaults
checkbox.

5. Click OK. If you marked Automatically load field defaults, the default set loads onto the record.

If you did not mark Automatically load field defaults, you can place the cursor in a field and press F2 to
load a single default value from the set. Or you can press SHIFT + F2 to load all the values from the default
set onto the record.

Using Favorites

Tip: You can designate records and processes you use most frequently as favorites and create shortcuts to
their locations. Favorites can be placed on a Home page, the Favorites menu, or the navigation bar.

Using the functions on the Favorites menu, you can designate the processes and saved records you use most
frequently as favorites and create shortcuts to their locations. This is especially useful if you use functions in
different programs to complete a single task. For example, during a routine Accounts Payable reconciliation
process, you may print reports from both Accounts Payable and General Ledger, such as a General Ledger
Report, an Open Invoice Report, and an Aged Accounts Payable Report. Rather than exiting Accounts Payable to
open General Ledger and create the General Ledger Report, you can create a favorites folder with direct links to
those reports. You can place this folder of shortcuts on the General Ledger or Accounts Payable Home page, the
Favorites menu, or in a group on the navigation bar.

Using the Options Home tab, you can add links to a Home page for creating or opening items. These links are the
same as those found on the pages of each record type. For example, the Add a New Account and Open an
Account links are both found on the Accounts page. When you can add these same links to the General Ledger
Home page, you can create a new account or open an existing account directly from the Home page without
having to open Records. For more information about adding links to the Home page, see “Home” on page 67.

You have additional options for organizing favorites on the navigation bar. You can create a “group” to organize
favorites and folders of favorites with similar characteristics. When you click on a group bar, all favorites and
folders of favorites contained in that group appear. You can create up to four favorites groups on the navigation
bar. For more information, see “Adding a favorites group to the navigation bar” on page 50.

» Designating a record as a favorite

Warning: You can designate records and processes as favorites, even if you do not have security rights to
those features. However, you cannot access and use any favorites for which you do not have the appropriate
security rights.

1. From the menu bar of an open record, select Favorites, Add to favorites. The New Favorite screen
appears.

The program assigns a name to the favorite based on the record type and ID. You can rename the favorite
and edit the information in the Description field.

Edit Favorite - 37 - AlphaGraphics |
I arme: |3? - AlphaGraphics

Ok, I
Description: Cancel |

Move to: _JFavorites Menu j Mew folder

Iterns in this folder will be available from the FE Shell
'Fawarnites’ menu
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2. Inthe Create in field, select a folder to store the favorite. The frame below the Create in field displays a
description of the selected folder’s location.

Click New folder to create a new folder for the new favorite.

Note: To designate a page as a favorite, follow this same procedure, except select Favorites, Add page to
Favorites.

3. Click OK to save the favorite.

» Designating a Web page as a favorite

You can create favorites that serve as direct links to specified Web pages. You can place these links at any
favorites location. This procedure describes how to add a link to the Blackbaud Knowledgebase to your

homepage in Accounts Payable. The steps are essentially the same for each program.

Note: The Show favorites option must be marked on the Home Page Options tab to make selected favorites
available from the Home page. For more information about favorites options, see the Options chapter of this

guide.
1. Right-click anywhere on the desktop of your computer. From the menu that appears, select New,
Shortcut. The Create Shortcut screen appears.

2. Inthe Command line field, enter the address for the Web page for which you want to create the favorite
or click Browse to search for the address.

Create Shortcut E I

Type the lozation and name of the item pou want to create
a shorkeut to. Or, search for the item by clicking Browse,

LCommand line:
Ikbaud.c:Dm.n"esuppDrt.n"esupporh"consumen’esuppnlt.asp?

Browse. .. |

< Back I Ment » I Cancel

3. Click Next. The Select a Title for the Program screen appears.
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4. Inthe Select a name for the shortcut field, enter a name for the shortcut. For example, “Shortcut to
Blackbaud Knowledgebase”.

Create Shortcut E I

Type the lozation and name of the item pou want to create
a shorbcut to, Or, search for the item by clicking Browse,

LCommand line:
Ikbaud.c:0m.n"esupp0rt.n"esupporh"consumen’esuppnrl.asp?

Browse... |

¢ Eark I Hest » I Cancel |

5. Click Finish. The Select a Title for the Program screen closes and a shortcut icon for the Web page appears
on your desktop.
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6. Open the program to the Home page. For this example, we open Accounts Payable. Click the Restore
button in the upper right corner of the screen to reduce the size of the screen. You can now access both

the Home page and the desktop.

Wiew Bo Favortes Tools Help

4 Back % Forward ] Cormunity Services Inc. * Accounts Payahble =

. Home
|
Accounts Payable Favorites

#4 Cpen vendor

Action Reminders
» Follow Up action due 02/15/2002, Contact vendor about issuing a new credit
mema,
"y Follow Up action due 02/18,/2002, Call David about expense report,

O nanl = - Record Update action due 03/01,/2002, Monthly Service Fee has been
increased by 5%, update recurring invoice in order to reflect change.

IMonthly Reports
‘Weh Links Generate Recurring [nvoices
Bank Recondiliation

at ‘Welcnme to Accounts Payable

7. Click and drag the shortcut icon to the Home page. The Web page appears in the shell. Click the Maximize
button to expand the screen to its full size.

8. To designate this page as a favorite, from the Accounts Payable menu bar, select Favorites, Add page to
favorites. The New Favorite screen appears. The program assigns a name to the favorite based on the
record type and ID. You can use the default name and description or enter your own.

=

M arne: |G|:u to Blackbaud - Knowledgebaze

Degoription; {Shortcut bo Knowledgebaze Tapee]

Create in: Mew folder

LS

Iternz in thiz folder will dizplay on the Accounts Papable
horme page

9. Inthe Create in field, select the program where the favorite should appear. In this example, we select
“Accounts Payable”.

10. Click OK to save the favorite.
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11. On the navigation bar, click Home. The Accounts Payable Home page appears with the new link to the
Web page.

#% The Financial Edge

File Edit Yiew Go Favortes Tooks Help

4 Back % Forwand I Carmrmunity Services Inc, * Accounts Payable ™

Home

-—

Accounts Payable Favorites
B8 Open vendor
@ o 1o Blackbaud - Krniowledgebase
Shorbcut to Knowledgebase

Shorteuts

Action Reminders
“4 Follow Up action due 02/15/2002, Contact vendar about issuing a new credit mema.
“% Fallow Up action due 02/18/2002, Call David about expense report,

1, Record Update action due 03/01/2002, Monthly Service Fee has been increased by 5%, update
¥ recurring invoice in order to reflect change.

(Generate Recurring Inveices

Monthly Reports
Web Links
Bank Reconciliation LI

‘Welcome to Accounts Papable |

» Adding a favorites group to the navigation bar

For this example, we create a group for bank reconciliation processes and reports. You can use this procedure
as a model for adding other types of favorites groups to the navigation bar.

1. From the menu bar, select Favorites, Organize Favorites. The Organize Favorites screen appears.

Organize Favorites =]
-13 B Copy Edit 4 : 1

M |Favorites Menul
[C]Home Pages
C1General Ledger
CJAccounts Payable
1 Common
CJAccounts Receivable
1 Fixed Assets
(] Cash Receipts
[C1Mavigation Bar
1 Shortcuts
L Monthly Reports
[Cweb Links

Beset | oK Cancel
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2. Select the Navigation Bar folder and click New Folder. The New Folder screen appears.

New Folder =|
I arme: | 0K I
Dregcription; Capirecl |
Create ;| Mavigation Bar ﬂ

[terms in this folder will be available from the FE Shell
r avigation Bar

3. In the Name field, enter “Bank Reconciliation”.
4. In the Description field, enter “Links to reconciliation processes and associated reports”.
5. In the Create in field, select “Navigation Bar”.

Mew Falder

Mame: IBank Feconciliation Ok, I

Dezcription: |Links to recanciliation processes and associated reports Bl |

Createinc | jMavigation Bar j

[terns in this folder will be available from the FE Shell
t avigation Bar

6. Click OK. You return to the Organize Favorites screen and the Bank Reconciliation folder appears below
the Navigation Bar folder.

Organize Favorites x|

T Favorites Menu
C]Home Pages
] General Ledger
CJAccounts Payable
3 Common
CJAccounts Receivable
3 Fixed Assets
Z)Cash Receipts
(C]Mavigation Bar

3 Shortcuts

) Monthly Reports

[ )'web Links

B E ol Beconciliationd

Beset | ] 4 I Cancel
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7. Click OK to close the Organize Favorites screen. The Bank Reconciliation group now appears on the
navigation bar.

N Home

Accounts Payable Favorites
# Open vendaor

Action Reminders
“% Follow Up artion due 02/15/2002, Contact vendor about issuing a new credit memn.
‘v Fallow Up action due 02/18/2002, Call David about exp
_ Record Update action due 03/01/2002, Monthly Service s been increased by 5%, update
recurring invoice in order to reflect change.

(Generate Recurring Inveices Wﬁ\

Bank Recondliation I

8. Select Reports. The Reports page appears.

#% The Financial Edge D S
File Edit iew Go Favortes Took Help

& Back & Fonward ] Community Services Inc. = Accounts Payable ™

Shartcuts
= reieas | Reports » Bank Account Reports
Web Links New ‘ Dpen | [elete Reports

Bank Recondiliation Bank Account
] ;] Bank Profile Report Reparts

Bank Reconciliation Report -
Bank Fegister Report Mame | Description | Date Created | Created By ‘ Dthers May Mc | Invoice Reparts

Purchase Order
Reports

Wendor Reports

IS I

[~ Only show my reports

ﬂ The Bank Profile Report lists summary bank account information,

Welcome to Accounts Payable |
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9. Select Bank Account Reports. The Bank Account Reports page appears.

#%4 The Financial Edge

File Edit Wiew Go Favaites Tool: Help
4 Back % Forwvand ] Blackbaud Sample School © Accounts Payable -

k@ Reports+ Bank Account Reports

Hew |Dpen ‘Qelete... |Repurts
" Bank
T Bankprofle K=
Bank Reconciliation Report Reports
Bank Register i . 0 Tnwoice
Sample 0 Su Reports
Purchase

Order
Repotts

Vendor
Reports

Shortcuts

KIS ol

[~ Only show my reparts

ﬂ The Bank Profile Report lists summary bank account information,

Bank Reconciliation ‘

Welcome to Accounts Payable |

Note: To designate a record as a favorite, follow this same procedure, except select Favorites, Add to
Favorites from the record screen.

10. From the menu bar, select Favorites, Add Page to Favorites. The New Favorite screen appears. The
program assigns a name to the favorite based on the record type and ID. You can use this name and
description or rename the favorite and edit the Description field.

11. Inthe Create in field, select “Bank Reconciliation”.

Hame: IGD to [AP] Reports Bank Account Reports

Create in:

Ok I
Dezcription: |Link to page or document Tt |

Lirk.z to reconciliation proceszes and azsociated reports

12. Click OK to save and close the New Favorite screen. You return to the Bank Account Reports page.
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13. From the navigation bar, click the Bank Reconciliation group bar. The Go to (AP) Reports-Bank Account
Reports folder appears in the group.

#% The Financial Edge

Eile Edit ¥iew Go Favoites Tools Help
4 Back % Forwand I Blackbaud Sample School © Accounts Payvable ~

1@ Reports - Bank Account Reports

Shortcuts
Bank Reconciliation

Hew |Ugsn ‘Qelste... |Rapnrts
2 2nk Profile 2 Bank
B Bank Profile __ Bank Profile Account
Bank Reconciliation Report Reports
Bank Register Mame Description D ate Created Created By Others May Modify Iraice
Sarnple I 5 o Reports

Purchase
Order
Reports

“endor
Repotts

KIS |

[~ Only show my reports

n The Bank Profile Report lists summary bank account information,

Welcome to Accounts Papable |

14. You can continue adding additional favorites to this group by repeating steps 8 through 12.

» Organizing favorites
1. From the menu bar, select Favorites, Organize Favorites. The Organize Favorites screen appears.

Organize Favorites [x]

[F avoiites Menul
[C1Home Pages
] General Ledger
ClAccounts Payable
1 Common
[CJAccounts Receivable
(C1Fixed Assets
(] Cash Receipts
[C1Mavigation Bar
3 Shortcuts
[ Monthly Reports
[C]'web Links

Reset | 0k | Cancel |

Favorites Menu, Home Pages, and Navigation Bar are default favorites folders. Favorites found in each
folder appear directly below that folder.

The Home Pages and the Navigation Bar folders have additional folders listed below them. For example,
the Home Pages folder contains additional default folders for each program. Favorites found in the
General Ledger folder are located on the General Ledger Home page. To view the contents of a folder,
click the plus sign to the left of the folder.
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2. To create a new folder, click New Folder. The New Folder screen appears.

Mew Folder E I

t ame: IFUIder Mame Ok, I

Deszcription: |Description of Folder Cancel

Create i | Favorites Menu j

Iterns in thiz folder will be available from the FE Shell
Fawarites' menu

In the Name field, enter a name for the folder.
In the Description field, enter a short description of the contents of the folder.
In the Create in field, select the folder location. For example, Favorites Menu.

o v kW

Click OK. You return to the Organize Favorites screen and the new folder appears below the Favorites
Menu folder.
» Copying favorites or folders of favorites

1. To copy a favorite or a folder of favorites, select the favorite or folder you want to copy and click Copy. The
Edit Favorite/Folder screen appears for the selected favorite.

Edit Favarite - Copy of Journal Entry x| I

M amne; IEDp_I,J of Journal Entry

0K I
Description: Cancel |

Maove to: _|Favontes Menu ﬂ Mew falder

[terns in this folder will be available from the FE Shell
‘Favorites' menu

2. Name the copy, enter a description, and select the location for the new favorite.

3. Click OK. You return to the Organize Favorites Screen, and the new folder appears below the specified
location.

» Editing favorites

Note: From the Organize Favorites screen, you can move favorites or folders of favorites from one location to
another. Simply select the favorite or folder you want to move and click the up and down arrows.
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1. To edit a favorite, select the favorite you want to edit and click Edit. The Edit Favorite/Folder screen
appears for the selected favorite.

Edit Favarite - Inwoice 58754 for ADT Security Systems I

M arne: |Invu:uice B8R for A0 T Security Syztems

0K I
Degcnption; {Open a record Cancel |

b ove b _jaccounts Papable j Mew folder

Itemz in thiz folder vall dizplay on the Accounts Papable
home page

2. Make any changes to the name, description, or location for the favorite.
3. Click OK. You return to the Organize Favorites Screen, and the edited favorite appears below the specified
location.
» Deleting favorites

1. To delete a favorite, select the favorite you want to delete and click Delete. This deletes only the favorite
bookmark, not the actual record. For example, if you designate an account record as a favorite, deleting
that favorite does not delete the record.

2. To delete all user-defined favorites and folders, click Reset. A message appears asking if you are sure you
want to reset the folder structure.

3. Toreset the folder structure, click Yes. Click No to cancel and return to the Organize Favorites screen.
4. Click OK to save your changes.

Changing Passwords

If you have security rights, you can change your password from any page in the program. We recommend you
change your password periodically to maintain the integrity of your security system. If you do not have security
rights to change your password, a user with supervisor rights can change it for you. For more information about
changing passwords for users, see the Security chapter of the Administration Guide.

» Changing your password
1. From menu bar on any page, select Edit, Change Password. The Change Password screen appears.

i Change Password [ x|
Oid password:l 0] I

Mew password: I Cancel |
Canfirm new pa&&word:l

Note: For privacy, only asterisks appear when you make entries on the Change Password screen.

2. Inthe Old password field, enter your old password.
3. In the New password field, enter your new password.

4. In the Confirm new password field, reenter your new password. Your entry here must exactly match the
entry in the New password field.

5. Click OK to save the new password.
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Printing Information

In each program, there are multiple ways to print the information contained in your database. For example, you
can easily print grids and reports while working in any program.

Anytime you see a grid, you can print the data in the grid by right-clicking and selecting Print from the menu.
Using the Print Grid Options screen, you can select the format of the printout.

You can print reports without opening Reports. For example, if you are working in Accounts Receivable with a
client record, to print a Client Profile Report, you can click Print on the action bar. Using the Select a Parameter
File screen, you can select an existing report parameter file or create a new one.

Before you can print from the program, you need to set up a printer, which you accomplish on the Print Setup
screen. You may already be familiar with this screen because it is common to most Windows programs. Use the
Print Setup screen to designate a path to your printer and a paper size, source, and orientation.

» Setting up a printer
1. From the File menu on the shell, select File, Print Setup. The Print Setup screen appears.

r— Printer
Mame: WWMTERMTSHEWND OCHPAK-PCL Properties |
Status: Feady
Type: HF Lazerlet 4000 PCL 5e
where: 10.23.0.100:PR1

Camment; 10.23.0.100

— Paper Orientation

Size: ILEttEI j + Paortrait

Saource: IAutnmaticalIy Select I " Landscape

Metwork | 0K, I Cancel |

2. Inthe Name field, select the name of your printer. Click Properties to view page setup and advanced
properties established for the printer.

3. Inthe Paper frame, select the size and source of the paper you use.

Warning: Some reports automatically select a paper orientation and override the default setting.

4. In the Orientation frame, mark an option to determine if you want to print in portrait or landscape
format.

Click Network if you want to connect with a network printer to which you have not already set a path.
6. Click OK to save your selections.
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» Editing print grid options

While this procedure demonstrates editing the print grid options when printing the Actions tab of a student
record in Registrar’s Office, you can use it as a reference when printing other grids because the process is
similar.

1. From an open student record, select the Actions tab.

) Jason Ronald Stannard =l

File Edit “iew Student Favortes Toolks Help
ESaveandElosev| u||ﬁ §| H 4 » H |6'0" ] ®|E||

Bioll Bio 2 I Enrollmentsl Addresses I AddresseesﬁSalutationsl Flelationshipsl Financial Aid I Egucationl Tests I Medica_ll
Actianz | Activities I Attributes I Maotes I Media I Conduct I Courses I Grades IAttendanceI Schedule I

?- |

<All Action Types> = I<AII Action Statusesy = I<Acti0ns for and Aszigned tox = I

Completed? I Start D ate I Action for I Actioh Type I Action Status I Pricrity I Aggigned bo I
[l 06/21/2004 Jazon Ronald ... E-mail Pending Mormal D, Alicia Ruth A,
- 05/18/2004 Jazon Ronald ... E-mail Pending Mormal Mz Marcy Drake
- 1041142004 Jason Ronald ... E-mail Pending Mommal — Dr. Alicia Ruth A,
- 038/15/2004 Jason Ronald ... Memo Pending Mormal — Mrs. Elizabeth G ...

2. With your cursor in the grid, right-click and select Print. The Print Grid Options Screen appears.

General | Sample Output |

Header: I

Foater: I

Paper orientation: ILIse printer default j

[ Display row grid lines
™ Display column grid lines
™ lgnore grid color settings
v Mumber pages

™ Size columns to fit page

Erint I Cancel

| | Total Pages: 1 | Fartrait i

3. To print a header, in the Header field, enter the text to appear.
To print a footer, in the Footer field, enter the text to appear.

5. To select a print orientation, in the Paper orientation field, select “Use printer default”, “Best fit”,
“Portrait”, or “Landscape”.

¢ If you select “Use printer default”, the grid prints in the orientation defined on the Print Setup screen.

¢ If you select “Best fit”, the program prints the grid in landscape or portrait depending on which
orientation best fits the grid.

¢ “If you select “Landscape”, the program overrides the default orientation and prints in landscape.
¢ If you select “Portrait”, the program overrides the default orientation and prints in portrait.

To print the row and column grid lines, mark Display row grid lines and Display column grid lines.
To print in grayscale, mark Ignore grid color settings.

To number the pages on the printout, mark Number pages.

W N

For the program to automatically size the columns to fit the page, mark Size columns to fit page.
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10. To preview the printout, select the Sample Output tab.

General Sample Output |

Frrirt I Cancel

[ | Total Pages: 1 | Portrait i

11. To print the report and return to the student record, click Print.
» Selecting a parameter file to print a report

Note: To open a parameter file, select the file in the grid and click Open.

1. From an open record, click Print. The Select a Parameter File screen appears.

Select a Parameter File E I

Select a parameter file to uze for Client Profile Report

File Mame | Created On Select
) ) e
Cancel
Acct. Summary Rpt. Supervisor 120342003 E
Bio. Details Rpk. Supervisor 12/03/2003

‘] Add New
{« | Open

i

B Find...

™ Only show my parameter files

2. To print the report using an existing parameter file, select the file from the grid and click Select. A
processing screen appears and the report prints.
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» Adding new report parameter files
1. To create a new parameter file, click Add New. The report parameter screen appears.

Mew Chent Profile Report I

File Edit “iew Favortes Tool: Help
== RN el R |

1. General |g: Filtersl 3 Folmatl

Show these repart sections: Show these details:
¥ idddress Information i | W 55N -
W Default Payers [+ Birthdate
¥ Statement Recipients [+ Ethriicity
[T Account Summary [V Gender
¥ Actions v Religion
¥ Attributes ¥ Credit Limit
W Media W UszerlD
v Maotes ¥ FIN
[V History of Changes [V CFD& Mumber ;I

[~ Show ending balance as of -

Az of date: IT':'da-"' vl 12/03/2003
Show year-to-date information a: IThis figcal year vl 07140142003 ko 1243142003

[~ Create an output query of clients

Report arientation: I Portrait & I

< Bach | MNest » | Catcel | Print | Freview | Layout |

2. Create the report parameter file. For more information about creating report, see the Reports Guide for
the program in which you are working.

3. Click Save. The Save Report as screen appears.

Save Report as I

Repart name: I

Description:

[V Others can run this report
™ Others can modify this repart

Egave | Cancel |

Enter a name and description for the report parameter file.
To the file and return to the parameter file screen, click Save.

6. To return to the Select a Parameter file screen, select File, Close. The new parameter file appears in the
grid.

Select a Parameter File E I

Select a parameter file to uze for Client Profile Report

File Mame | [lescription | Created By | Created On | Select |
Profile Fipt 3/15/03 Supew?sor 12/03/2003 @ Cancel |
Acct. Summary Bpt. Supervisor 1240372003
Bio. Details Rpt. Supervisor 12032003

Client Profile Repart Supervisor 12/03/2003

{1 Open |
B4 Find.. |

™ Only show my parameter files
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7. To print the report with the new parameter file, select it in the grid, and click Select. A processing screen
appears and the report prints.

Blackbaud Administration Console

Microsoft recently released the Windows Vista operating system. This operating system has a number of new
features not present in earlier versions of Windows. One of these new features is the result of Microsoft’s
emphasis on security: User Account Control (UAC). Due to Windows Vista’s enhanced security features, a user
that is part of the Administrators group no longer holds all of the administrative privileges necessary to complete
the following tasks:

Install Queue Service
Register DB
Synchronize Integration Data

Unlock additional modules

Register Plugins

Install Aatrix

When you select one of these tasks from the program, the UAC Elevation Prompt displays. Depending upon the
task you are performing, the Blackbaud Administration Console may also open to help you complete the task.

3 Install Queue Servics  Intearation
(1" Register DB Synchronize your EE and RE data.

Senchronize Integration D ata
= Unlock additional modules
£ Register Plugins

Integration
Exit
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Note: In Security, a supervisor can define user options for each user or can give each user rights to set his or
her own user options in Options. For more information about security, see the Security chapter of the
Administration Guide.

With Options, you can customize the look of screens and establish a wide variety of default values. Select the
settings that best suit your personal needs, whether you want to open records directly from the Home page or
change the color of text appearing in certain grids. The program stores your options in the database, so any
workstation you enter with your password uses your settings. Other users are unaffected by your settings in
Options.

Generally, options specify defaults that help increase the ease and speed of data entry. If you decide you do not
want to use a pre-set default while creating a record, you can usually override the default on the actual record
screen.

Accessing Options

Note: Visit our website at www.blackbaud.com for the latest documentation.

To access the Options screen, select Tools, Options from the menu bar. On the Options screen, select the tab for
the type of options you want to set.

To apply the selected options without exiting the Options screen, click Apply. To apply the settings and exit the
Options screen, click OK. To clear all tab settings so you can set new ones, click Reset to System Defaults.

Note: If you click Reset to System Defaults, the program clears all tab settings, including all favorites.

If you have supervisor rights, when creating a new user in Security, you can easily copy the user options defined
for an existing user to the new user. For more information about security for users, see the Security chapter of
the Administration Guide.

General

Note: Field names and screens may differ based on products you have installed.
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On the General tab, you set personal preferences for all products.

#% Options

General |ﬂome| Becordsl _D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl

Q V'ou can use these options to zet personal preferences that occur system wide.

Start The Education Edge in: IAdmissions Office j

Start on this page: IHome j

Mizcellaneous:
5] Save Messages
[ Show save message when a record is saved
(5 Data Entry
[V Automatically complete table entries
(5 Display
W Show taoltips
¥ Show icons in navigation bar
[ Show gradient background on navigation bar
[ Show background page graphics

Reset Al aming Messages |

Reset to System Defaults | 0K I Cancel | Apply |

Start in. Select the program to open first when you log into the program.

Start on this page. Select the page in the program that appears when you log into the program. For example,
you can specify the Reports page to appear.

Miscellaneous. In this box, mark the options for saving messages, data entry, and the display.
¢ To receive confirmation each time you save a record, mark Show save message when a record is saved.

¢ If you want the program to automatically fill in text as you type the first few characters in a field containing
table entry values, mark Automatically complete table entries.

¢ To view the name of a toolbar button as you move your cursor over it, mark Show tooltips.

¢ To see the pictograms of each shortcut in the navigation bar, mark Show icons in Navigation Bar. To view
only text in the navigation bar, unmark this option.

¢ To use your Windows color settings as the background on the navigation bar, mark Show gradient
background on Navigation Bar.

¢ To view the graphics appearing as watermarks on many pages, mark Show background page graphics. To
view only a white background, unmark this option.

Reset All Warning Messages. As you work in the program, you can turn off warning messages. To turn on all
warning messages so they appear again, click Reset All Warning Messages.

Home

Note: Some options are available only if you have optional modules installed.
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On the Home tab, you select commonly used functions to appear on the Home page as favorites. For example, if
you frequently create new invoices, mark Create a new invoice in the Favorites Options box. You can also
designate current actions to appear on the Home page as reminders.

&% Optiong [ [ x]

General

Eecordsl _D_ueryl E:-cpoltl Heporﬁsl gdministrationl Color | Erintingl File Locationsl

|Et| 1 Home Page Options
W E E
[ Show actions

Favorites Options
(=) Functions for creating new items - ﬂFind... |

(5] General Ledger ;
[T Create & new account E;%aozliz |
[T Create & new account code

[T Create a new project
[T Create a new fund
[T Create a new budget scenario
[T Create a new chart template
(7] Accounts Payable
[T Create a new product
[T Create a new vendar
[ Create a new invoice
[T Create a mew recuring irvoice
[T Create a new credit memo
[T Create a mew purchase order
[T Create a mew receipt
(5] Fived Asszets
[T Create a new asset =

HesettoSysteerfaultsl (u]. I Caticel | Apply |

Note: You must mark Show favorites to activate the function checkboxes and the Find button.

Show favorites. To display favorites on the Home page, mark Show favorites. Then mark checkboxes for the
functions you want to appear on the Home page. To locate functions in the list to include as a favorite, click
Find. To edit and organize the list of favorites, click Organize Favorites.

Show actions. To show actions with a current due date on the Home page, mark Show actions. The action
reminder appears according to the auto-remind time set on the Actions tab on the record.

General Ledger Records Options

The options you define on the Records tab of the Options screen in General Ledger affect records, the visual chart
organizer, and other areas of the program.
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For General options on the Records tab, select a default character place holder for account numbers that have
not yet been designated.

f% Options

General | Home
P

_D_ueryl Expoltl Hepor;sl Qdministrationl Calor | Erintingl File Locationsl

You cat uze these optiohs o zet personal preferences that ocour systen wide.

EE

Account

befyoount &chivit
Project

i-Project Schivity
izLial Chart Organizer
Jaurnal Emtry

Post Options
Batch Reports
Budget Management

Account

|<Caret>

=

General Options

*r'ou can choose how to enter and dizplay General Ledger for
windows account numbers throughout the spstem.

| Sample Format

| GL Account Mumber:

S e PP

For Account options on the Records tab, select the tab to appear first when you open an account record. For

example, if you generally open account records to view activity, select Activity as the default tab.

fi% Options ==

General | Home

ecordsl _D_uer_l,JI Expoltl Flepor;sl édministrationl Calor | Erintingl File Locationsl

o R
“IZ 2 r'ou can uze these options bo set personal preferences that occur spstem wide.,

General

L-Anzaunt A ckivibg
Project

Project dctivity
Wizual Chart Organizer
Jaurnal Emtry

iPronesseg

Account Tab Options

Drefault tab:

IAccount

Account Activity

E

Note: To readjust column width in a grid, move the cursor over the right end of the column header and drag
the divider to the left or right.
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For Account Activity options on the Records tab, select default values to appear on the Activity tab of account
records. For example, you can set defaults for display format, activity type, and fiscal years.

fita Dptions

ﬁenelall Hom 7 uer_l,JI EHpoltI Heporﬁsl Qdministrationl Caolor | Erintingl File Locationsl

=
"]Z “ou can uze these options to set personal preferences that occur system wide.

General o g .
i ccount - Account Activity Options
":"'”-'t Sctivity Preference | Setting
- Project Activity Default display Format Actual/Budget
jﬁsual ICEa{t Drganizer Favorable/Unfavorable or Yariance default Favorablef{Unfavorable)
ournal Entry
i-Processes Defaulk fiscal vear 1 Last Fiscal vear
S'"PDSt Options Defaulk fiscal vear 2 This fiscal vear
+Batch Reports .
Budget M anagement Default budget scenario oa
Default activity bype Actual
Default balance display Met Change
How do wou want to refresh the activity tab? Aukomatically
Howe do wou wank bo display transaction details For nor. ., Display details
Howe do wou want bo display bransaction details For co...  Summarize by date
what do yvou want to show when selecting a line item ... Source Document

Default display format. To define the format in which activity automatically appears on account records, select
Actual/Budget, Comparative, or Debit/Credit. You can change this setting on the Activity tab if you need to
view a different display format.

Note: Favorable/ Unfavorable displays the difference between actual and budget amounts. For example, if
the actual amount of a revenue or gift account is over budget, this is favorable. An expense or transfer account
over budget is unfavorable. Variance displays the budget amount minus actual amount.

Favorable/Unfavorable or Variance default. To define a default for the way budget versus actual amounts
appear, select Favorable/(Unfavorable) or Variance.

Default fiscal year 1. To define the default for the first fiscal year, you can select Last fiscal year, This fiscal year,
or Next fiscal year. It appears on the Activity tab in a date format.

Default fiscal year 2. To define the default for the second fiscal year, you can select Last fiscal year, This fiscal
year, or Next fiscal year. It appears on the Activity tab in a date format. The Default fiscal year 2 is used if you
are viewing a Comparative format.

Default budget scenario. If you have the optional module Budget Management, select a default budget
scenario ID.

Default activity type. Select Actual, Encumbrance, or Both as the default amount to appear on account activity.
If you select Both, the total of the Actual and Encumbrance amounts appears.

Default balance display. To define the default balance display, select Net Change or Ending Balance.

How do you want to refresh the activity tab? If you select Automatically, the Activity tab immediately
refreshes grids with any changes to Format, Dates, Budget Scenario, or Net Change/End Balance entries. If
you select On demand, you must click Calculate to refresh the grids with new entries.

How do you want to display transaction details for normal accounts? You can select to show details
or to summarize by date.

How do you want to display transaction details for control accounts? You can select to show details
or to summarize by date.

What do you want to show when selecting a line item on the transaction details form? Select to
show debit/credit information or to open the source document.
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Project

Note: Project appears as a selection in the tree view only if you have the optional module Projects and Grants.

For Project options on the Records tab, select the tab to appear first when you open a project record.

Qenerall Home Records |_D_uery| Exporll Flepor;sl &dministrationl Calor | Erintingl Eilz Locationsl

P
Illi 2 'Wou cah use these optiohs bo set personal preferences that accur spstem wide.

General T o
Account F'rl:l]ec.t Tab Options

-Ancount Ackivity Default tab:

iProject Activity I Projects j
*Project Budget

isual Chart Organizer

Jaurnal Entry

+Processes

Project Activity

Note: Project Activity appears as a selection in the tree view only if you have the optional module Projects and
Grants.

For Project Activity options on the Records tab, select default values to appear on the Activity tab of project
records. For example, you can set defaults for display format, activity type, and fiscal years.

x|
General | Home HRecords | Quem I Export I Reports I Admiriztration I Caolor | Frinting I File Locations I
=
|l|i: ou can uze these options to set personal preferences that occur system wide.
General P S Fr
fccount N Project Activity Options
“Account Activity Preferance | Setting
Project
Default display Format Balance Sheet and Income State. ..
“-Project Budget Favorable/Urfavorable or Yariance default Favorablef{Unfavarable)
“Wizual Chart Organizer
Journal Entry Default fiscal year This fiscal year
5'"P'°CESS"~_S Display budgets for balance sheet accounts Ves
iPost Options i
L-Batch Reports Default budget scenaria
Elllldg'?t_ M argagement Default activiey bype actual
¥ t
Grzﬁimn anagemen How do wou want to refresh the activity tab? Automatically
“-Grant Activity Howe do wou wank to display transaction details? Display details

Default display format. To define the default for the display format, you can select Balance Sheet and Income
Statement or Income Statement only.

Note: Favorable/ Unfavorable displays the difference between actual and budget amounts. For example, if
the actual amount of a revenue or gift account is over budget, this is favorable. An expense or transfer account
over budget is unfavorable. Variance displays the budget amount minus actual amount.

Favorable/Unfavorable or Variance default. To define the default for the way project activity appears, you
can select Favorable/(Unfavorable) or Variance.

Default fiscal year. To define the default for the fiscal year, you can select Last fiscal year, This fiscal year, or
Next fiscal year. This fiscal year refers to the current fiscal year.
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Display budgets for balance sheet accounts. To define whether to display the budgets for balance sheet
accounts, you can select Yes or No. If you select Yes, an additional column for Budget appears in the Balance
Sheet grid on the Activity tab. If you select No, the Balance Sheet grid contains columns only for Category and
Actual.

Default budget scenario. If you have the optional module Budget Management, you can select a default
budget scenario ID.

Default activity type. To define default activity type, you can select Actual, Encumbrance, or Both.

How to you want to refresh the activity tab? To define the method for refreshing the activity tab, you can
select Automatically or On demand. If you select Automatically, the Activity tab immediately refreshes grids
with any changes to Format, Dates, Budget Scenario, or Net Change/End Balance entries. If you select On
demand, you must click Calculate for the system to refresh the grids with new entries.

How do you want to display transaction details? To define how the system displays transactions, you can
select Summarize by date or Display details.

Project Budget

Note: Project Budget appears as a selection in the tree view only if you have the optional module Projects and
Grants.

For Project Budget options on the Records tab, select default values to appear on the Budget tab of project
records. For example, you can set defaults for display format, activity type, and fiscal years.
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A ccount Project Budget Options
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Project Preference | Setting I
i Project Activib Default scenario
. Defaulk Fiscal year
‘izual Chart Organizer b
Journal Entry Enter budgets using? Armourk
~Processes Yalidate row by row? Yes
i~Post Dptions
B atch Reports

Budget Management
Allocation b anagement
Grants

- Grant Activit

Default scenario. To set a scenario for automatic use each time you create a new budget, select a scenario ID.
When you create a new budget, you can change the scenario ID manually.

Default fiscal year. To set a fiscal year for automatic use each time you create a new budget, select Last fiscal
year, This fiscal year, or Next fiscal year. This fiscal year refers to the current fiscal year.

Enter budgets using? To define the default format when entering budgets, select Amount or Percent.

Validate row by row? Specify for the program to validate data entry row by row when the information is
entered or only when saving.
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Visual Chart Organizer

For Visual Chart Organizer options on the Records tab, select default values to indicate the appearance of the
chart template when it is opened, which chart template is used in reports, whether to synchronize formatting of
the lines in a chart template, and whether warnings should appear when you delete header/total lines.

f% Options
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FAocount Activity Preference I Setting
Project
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Budget Management

Synchronize chart template formatting by default. When you select Yes, the program ensures that
formatting selections, such as the font, are the same for each line in a level. Formatting comes from the first
line of each type and level in the header.

Note: You can override defaults on each chart template.

Default chart template. You can select a chart template as the default template used when reporting. You can
override this default on the General tab of each report.

Display a warning if header/total items with detail lines are deleted. This is a safety feature to ensure
detail lines are not deleted without confirmation when you delete a header/total. To receive a warning each
time you delete a header/total, select Yes.

Default to this view when opening existing chart templates. Select Account View or Design View as the
default format when you open a chart template. In the Account View, the information is organized by account
category. In the Design View, the chart template is organized by balance sheet accounts and income
statement accounts and shows leveling within categories. This option can be manually changed after you
open the template.
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Journal Entry

For Journal Entry options, you can specify preferences, such as whether to maximize the batch screen
automatically when opened, which tab should appear first when you open a batch, whether to display
transaction and batch details, and how to enter default information in new batches.

f% Options
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Maximize batch screen when opening. To have a batch open automatically to the full size of your screen,

select Yes. To have a batch open in a smaller window where you can still view open screens behind it, select
No.

Display transaction details. To show transaction details on a batch, select Yes. If you select No, the
Distribution, Attributes, and Notes tabs at the bottom of the batch do not appear.

Display this tab by default. To indicate which tab appears first when you open a batch, select Distribution,
Attributes, or Notes. These tabs appear at the bottom of a batch to show transaction detail.

Note: You can also select to show or hide batch details on the batch screen.

Display batch details. If you want batch details to automatically appear each time you open a batch, select
Yes. Batch details include the Default set field, Batch Notes text box, Automatically create balancing
interfund entries checkbox, and Create bank adjustments when posting to a bank’s cash account checkbox.

Display first row of batch as default row. To set default information in the first row of a batch, select Yes.
You can easily use these defaults in subsequent batch rows. If you do not want to use default information,
select No.

Enter batch defaults. If you want default information to appear in fields automatically when you select a new
row, select by row when placing cursor in row. If you want to specify when to enter default information on a
field-by-field basis, select by field with the F2 key.

Note: You can change the defaults on a specific batch at any time.

Load this default set on all batches. To specify a default set containing transaction information, click the
binoculars and select a set. If you do not have a defined set, click New on the Field default sets screen to
create a set. For more information about default sets, see the Program Basics chapter.
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Journal Entry Processes

For Journal Entry Processes options, you can specify when to validate data entry, whether to display confirmation
messages before posting, whether to display a success message after post validation, whether to automatically
create balancing interfund entries, and whether to create bank adjustments when posting to a bank’s cash
account.
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Project
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m Display successfuliunsuccessful message after post validation Ves
E'"PDSt Options Automatically create balancing interfund entries Ves
+Batch Reports : : :
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Validate data entry. Specify for the program to validate data entry row by row when the information is entered
or only when saving the batch.

Ask ‘Are you sure?’ before proceeding with post. If you want the program to display a confirmation
message before posting, select Yes.

Display successful/unsuccessful message after post validation. If you want the program to display a
message confirming post validation, select Yes.

Automatically create balancing interfund entries. If you want the program to automatically create
balancing interfund entries, select Yes. You can change this option on the batch screen when batch detail is
showing.

Create bank adjustments when posting to a bank’s cash account. If you want to create bank
adjustments when posting to a bank’s cash account, select Yes. You can change this option on the batch
screen when batch detail is showing.

Journal Entry Post

Note: Every default Journal Entry Post option can be manually changed when posting from Administration.
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For Journal Entry Post Options, you can designate the default post option when posting from Administration, the
default parameters to use when generating a posting report, the default setting when printing or previewing the
posting report, and which printer to use. Setting post options is helpful if you post from Journal Entry. Although
you can set specific post options on the General Ledger Post screen in Administration, the only place to set post
options when posting from Journal Entry is in Options.
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Use these default options when posting from Administration. Select the default posting option:
Validate and Post or Validate only.

Confirm validation after each batch. If you want the program to confirm validation results after each batch
when posting multiple batches, mark the checkbox.

Note: Using the default Post Report parameters can save you time when you post.

Use these default options when posting from Administration or Journal Entry. If you select Use the
default Post Report parameters, the program’s default parameters are used. If you select Always ask for a
parameter file, each time you post, you receive a message asking which parameter file to use for the report. If
you select Always use this parameter file, you must select a parameter file or create a new parameter file to
be used.

Note: You can print a report from the Preview screen.

Post printing options. You can view or print a post report after posting. Select to preview the post report or to
automatically print the post report. Select the default printer for printing the report.

Print control report on. To print a control report including each batch that was posted, its success status,
description, number of transactions, and total debits and credits, mark Print control report on and select the
printer.
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Journal Entry Batch Reports

For the Journal Entry Batch Reports option, you can select to use the batch report in detail or summary when
printing from Journal Entry. Also, you can select the default report parameters.

f% Options
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Budget Management

When previewing or printing a Batch Report from Journal Entry. Select whether to use the batch
report in detail or summary.

Note: When you select Always use this parameter file, the Select a Parameter File screen appears for you to
make the default parameter file selection.

Report parameter options. If you select Use the default report parameters, the program'’s default parameters
are used. This can save you time when printing a batch report. If you select Always ask for a parameter file,
each time you print a batch report from Journal Entry, you receive a message asking which parameter file to
use for the report. If you select Always use this parameter file, you must select a parameter file or create a
new parameter file to be used.

Budget Management

If you have the optional module Budget Management, you can define default options for budgets. For example,
you can set a default scenario, a default fiscal year, and a default project ID.
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Default scenario. To set a scenario for automatic use each time you create a new budget, select a scenario ID.
When you create a new budget, you can change the scenario ID manually.

Default fiscal year. To set a fiscal year for automatic use each time you create a new budget, select Last fiscal
year, This fiscal year, or Next fiscal year. This fiscal year refers to the current fiscal year.

Default view. If you have the optional module Projects and Grants, you can set the default view that appears
when the budget entry grid opens. Select Budget, Account, or Project.
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Note: You can change the default settings at any time.

Enter budgets using? To define the default format when entering budgets, select Amount or Percent.

Validate row by row? Specify for the program to validate data entry row by row when the information is
entered or only when saving the batch.

Default project ID. If you have the optional module Projects and Grants, you can select a default project ID to
appear when you open a project budget.

Grant

Note: Grant appears as a selection in the tree view only if you have the optional module Projects and Grants.

For Grant options on the Records tab, select the tab to appear first when you open a grant record.
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Post Options
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Budget Management
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Grant Activity

Note: Grant Activity appears as a selection in the tree view only if you have the optional module Projects and
Grants.

For Grant Activity options on the Records tab, select default values to appear on the Activity tab of grant records.
For example, you can set defaults for display format, activity type, and fiscal years.

|

ﬁenerall Home HRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl

e
T ‘Yol can use these options to set perzonal preferences that occur system wide.
General - ginsi Aoy
ccourt - Grant Activity Options
Acoount Activity Preference Setting
Something Else
& Something Else Activity Default display Format Projects and Transaction Codes =..,
--Something Else Budget Diefaulk activiky bype ackual
izual Chart Organizer
Joumnal Entry Diefault fiscal year This fiscal year
Processes
i~ Post Options
Batch Reports

Budget Management
Allocation Management




OPTIONS 79

Default display format. To define the default for the display format, you can select Projects and Transaction
Codes Separately or Projects and Transaction Codes Combined.

Default activity type. To define default activity type, you can select Actual, Encumbrance, or Both.

Default fiscal year. To define the default for the fiscal year, you can select Last fiscal year, This fiscal year, or
Next fiscal year. This fiscal year refers to the current fiscal year.

Accounts Payable Records Options

Note: You must have the optional module Purchase Orders installed to use purchase orders and receipts.

The settings you define on the Records tab of the Options screen in Accounts Payable affect vendor, invoice,
credit memo, purchase order, and receipt records. For example, you can designate how activity appears on
records, and you can set defaults to make data entry quicker and more consistent.

General

For General options on the Records tab, designate how you want to select the vendor when creating
transactions. If you select Vendor name, you must enter or find the vendor’s name each time you create an
invoice, credit memo, or other transaction. If you select Vendor ID, you must enter or find the Vendor ID each
time.
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=Wendor Summary
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Vendor

Note: If you have the optional module Purchase Orders, additional items appear from which you can select the
default tab.

For Vendor options on the Records tab, select the tab to appear first when you open a vendor record.
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Vendor Activity

For Vendor Activity options on the Records tab, designate if you want the program to show deleted transactions
and select default dates of vendor activity to show.

f% Options

Qenerall Hame ;. _D_ueryl Exporll Flepor;sl &dministrationl Calor | Erintingl Eile Locationsl

P
“]Z 2 'fou cah use these optiohs bo set personhal preferences that accur spstem wide.

Vendor Yendor Activity Options
B et

R/ endor Activity [~ Show deleted transactions

=endor Summary it

|rwvaice Default dates for wendor activity: |A|| Dates j
| rwvoice Activity

Recurring Inwvaice

=

Show deleted transactions. To view deleted, posted transactions on the vendor Activity tab, mark the
checkbox. You cannot view deleted transactions that were never posted.

Default dates for vendor activity. Select the date period of activity you want to appear in the grid on the
vendor Activity tab. This setting is just a default and can easily be changed on individual vendor records.

Vendor Summary

For Vendor Summary options on the Records tab, select default date values to use when you view summary
vendor information. To view a vendor summary, click Summary on the action bar of the vendor Activity tab.
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Note: Although you set defaults in Options, you can manually change the selections on the Summary screen.

Default dates for 1099 activity. On the Summary screen when 1099 is selected, the years you select in the
Year 1 and Year 2 fields appear next to each other, providing a comparison of 1099 vendor activity over two
years.

Default fiscal periods for vendor activity. The fiscal periods and years you select appear on the Summary
screen when Activity is selected on the action bar and Fiscal Periods is selected in the Display field.
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Default fiscal year for vendor activity. The fiscal years you select appear on the Summary screen when
Activity is selected on the action bar and Fiscal Years is selected in the Display field.

Default calendar year for vendor activity. The calendar years you select appear on the Summary screen
when Activity is selected on the action bar and Calendar Years is selected in the Display field.

Default dates for vendor activity. The date ranges you specify appear on the Summary screen when Activity
is selected on the action bar and Specific Dates is selected in the Display field.

Invoice

For Invoice options on the Records tab, select the tab to appear first when you open an invoice record.
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Invoice Activity

For Invoice Activity options on the Records tab, select default values for invoices. For example, you can set
default invoice dates and post information.
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Default invoice date. For the invoice date of a new invoice to automatically default to the current date, select
Today. If you select <Blank>, the date must be entered on the Invoice tab of each new invoice.

Note: Terms are defined in Configuration and set on each vendor record.

Default invoice due date. You can select to use the invoice date or the current date as the invoice due date. If
you select <Blank>, the due date must be entered on the Invoice tab of each new invoice. If you have payment
terms set for the vendor, you can select Based on terms and the due date appears on the invoice record as
soon as you select a vendor.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.
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Default post date. Set the default post date to be the current date or the invoice date, or select <Blank> to
require the post date to be entered manually on each new invoice.

Default reversal post date. Set the default reversal post date to be the current date or the invoice date, or
select <Blank> to require the date to be entered manually when you delete an unpaid, posted invoice.

Recurring Invoice

For Recurring Invoice options on the Records tab, select the tab to appear first when you open a recurring invoice
record.
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Credit Memo

For Credit Memo options on the Records tab, select the tab to appear first when you open a credit memo record.
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Credit Memo Activity

For Credit Memo Activity options on the Records tab, select default values for credit memos. For example, you
can set default credit memo dates and post information.
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Default credit memo date. For the credit memo date of a new credit memo to automatically default to the
current date, select Today. If you select <Blank>, the date must be entered on the Credit Memo tab of each
new credit memo.

Default application post date. You can select Credit Memo post date, Credit Memo date, or System date.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. Set the default post date to be the current date or the credit memo date, or select <Blank>
to require the post date to be entered manually on each new credit memo.

Default reversal post date. Set the default reversal post date to be the current date or the credit memo date,
or select <Blank> to require the date to be entered manually when you delete an unapplied, posted credit
memo.

Purchase Order

For Purchase Order options on the Records tab, select the tab to appear first when you open a purchase order
record. You must have the optional module Purchase Orders to create purchase orders.
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Purchase Order Activity

For Purchase Order Activity options on the Records tab, select a default order date and whether to be notified if a
blanket purchase order exists for a product. You must have the optional module Purchase Orders to use purchase
orders.
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Note: The message that a blanket purchase order exists for a product appears after you select the Product ID
on a new line item.

Prompt if blanket purchase order exists for a product. Mark the checkbox to be informed when a
blanket purchase order exists for a product you are adding to a purchase order. This prevents you from
creating an unnecessary purchase order and enables you to apply the blanket purchase order on the spot.

Default order date. To set the default order date to the current date, select Today. To require the date to be
entered manually each time, select <Blank>.

Line Item

For Line Item options on the Records tab, you can set a default post status, post date, and reversal post date. You
must have the optional module Purchase Orders to create line items and set line item options.
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Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. To set the default post date to the current date, select Today. To require the post date to be
entered manually on each new line item, select <Blank>.
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Default reversal post date. You can set the default reversal post date to the current date or the line item post
date. To require the date to be entered manually when you delete a posted line item, select <Blank>.

Receipt

Note: You must have the optional module Purchase Orders to use receipts.

For Receipt options on the Records tab, select a default reversal post date and whether to be asked to create an
invoice for uninvoiced items.

f% Options

_D_ueryl Expoltl Heporﬁsl Qdministrationl Calor | Erintingl File Locationsl

General | Home

=
T You can use these optiohs to set personal preferences that ocour spstenm wide.

General - —
' endor Rec.e|pt Options

Fyendor Activity [~ Prompt to create invoice for unirvoiced items
=endaor Surmary
Invoice Default reversal post date: IToday j

= rwvoice Activity
Recurring Invoice
Credit Memo

b Credit Memao Activity
Purchase Order

bPurchasze Order Activity
Line Item

Payment
i =]

Prompt to create invoice for uninvoiced items. Since a purchase order and receipt can be created for
items that have not been invoiced, you can mark this checkbox to receive a warning message before closing a
receipt. The program then gives you the option of creating an invoice on the spot for any uninvoiced items or
continuing without creating an invoice.

Default reversal post date. You can set the default reversal post date to the current date or the receipt post
date.

Payment

For Payment options on the Records tab, specify a default date for voiding a payment, a default reversal post
date, and whether or not you want to be warned when recording a one-time check without printing.

&% Options ===

_D_ueryl Expoltl Heporﬁsl Qdministrationl Caolor | Erintingl File Locationsl

General | Home

=
"]Z “ou can uze these options to eet personal preferences that occur system wide.

General ) —
"\ erdar Pavn‘uent Dptions

Hyendor Activity [~ ‘w'am when recording a ane-time check without printing
E"-\a’_enclor Summary

Ipvaice - Default vaoid on date: IToday j
| rvoice Activity

Recurming Invoice Default reversal post date:

Credit Memo > ' ITdeJ j

i-Credit Memao dctivity
Purchase Order

i-Purchasze Order Activity
Line Item

Heceist
E T

Warn when recording a one-time check without printing. For the program to warn you when you record
a one-time check without printing it, mark the checkbox.
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Default void on date. To set a default for the payment void date, you can select Today or Payment post date. To
require the date to be entered manually when you void a payment, select <Blank>.

Note: The Void date and Reversal post date fields appear on the Void payment screen.

Default reversal post date. To set a default reversal post date, you can select Today or Payment post date. To
require the date to be entered manually when you void a payment, select <Blank>.

Create Payment

For Create Payment options on the Records tab, you can overwrite one-time check formatting options, select to
view payment summary information before creating payments, and select Pre-payment report parameters.

fi% Options

Eenerall Home | _D_uer_l,JI Expoltl Flepor;sl édministrationl Calor | Erintingl File Locationsl

o
“JZ 2 'r'ou can uze these options bo set personal preferences that occur spstem wide.,

ordar Create Payment Options

g---\;‘endor Activity [ Ovenwite one-time check farmatting options with computer check
Ir;;:iigdm Surnmary IV Vigw payment summary information before creating payments
Se|hwoice Activity When previewing or printing a Pre-payment Report
Recurming lrwoice from Create Payments:
Credit Mema
b-Credit Mema dctivity IUse the default Cash Disbursement parameters
Purchase Order
L-Purchase Order Activity I
Lire [tem
Receipt

F'_aEment

2Ll

Overwrite one-time check formatting options with computer check. To use the computer check’s
formatting options when paying a one-time check, mark the checkbox.

View payment summary information before creating payments. To read and verify payment summary
information before creating payments, mark the checkbox.

When previewing or printing a Pre-payment Report from Create Payments. To use the program’s
default parameters, select Use the default Cash Disbursement parameters. To set specific report parameters,
select Always use this parameter file, then select a previously created parameter file or create a new
parameter file to be used.

Accounts Receivable Records Options

The settings you define on the Records tab of the Options screen in Accounts Receivable affect product and
billing items, clients, charges, credits, invoices, returns, refunds, deposits, and payments. For example, you can
set defaults to make data entry quicker and more consistent.
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General

For General options on the Records tab, you can select general default data entry options for transactions.

## Options I |

General | Home

_D_ueryl EHport' Heporﬁs' &dministlationl Color | Erintingl Eil= Locationsl

= (==
|| ~ou can use these optionz bo set personal preferences that ocour systenm wide.
General

| pplicatiors: General Options

i~Charge/Line ltem Show these fields when entering new invoices, charges, and credits:
= Payrment/ Cradit

Product and Billing ltem ¥ CI!ent Hame
Client [¥! Clierit I = |
i Client Activity W Individual SshOrganizakion CFOG #
= Client Surmary
Charge - i
Crodi Uge thiz categom for news tranzachions: I j
Invoice
Invoicg Line Itgl‘n Show theze fields when entering new Accountz Receivable receipts:
E:tcul:::mg Irvvoice [V Statement Reference Mumber - |
Fieturn Line Item I Cliert Hame - |
Refund ¥ Client 1D
Deposit W Individual SshOrganizakion CFOG #
Payment

Enter trade dizcounts using © Percentage ¢ Amount

Show these fields when entering new invoices, charges, and credits. Mark checkboxes for the client
fields to appear. You can use the up and down arrows to change the order in which the fields appear.

Use this category for new transactions. Select a default category to use for new transactions.

Show these fields when entering new Accounts Receivable receipts. Mark checkboxes for the fields
to appear. You can use the up and down arrows to change the order in which the fields appear.

Enter trade discounts using. Mark Amount or Percentage to select how to enter trade discounts on records.
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Charge/Line Item

With the Charge/Line Item Options, you select the appearance of the applications screen accessed through
charges and line items.

# Dptions P |

ﬁenerall Home HRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl

s
"lk.« © Vou can use these optiong bo zet personal preferences that occur system wide.

General
Applications

Charge/Line Item Options

-Charge/Line [bem et ; ]
anta"ed ! W Show ewvery other application row using this colar ||:| Cuztom Color - I @I
F'r_oduct and Billing Item
C_"Bnt, - Show thiz menu option by default when the application screen is first
i Client Activity — -
“Client Summary ISeIect Additional Payments or Credits j
Charge
Credit Showe columns in this order on the applications screen:

Invaice
Invoice Line ltem
Fecurring lrnvaice
Returm

Return Line Iterm gBSC”DtIDH 7

Refund e |

Deposit CistributedTo > |
p Available

Payment

Apply. . Amount

Restore Default Column Order |

Show every other application row using this color [ ]. Mark this box to alternate colors of rows on the
application screen. Select a color from the submenu or click on the palette icon to define your own color.

Show this menu option by default when the application screen is first opened. Select the menu
option that you would like to appear on the application screen for charges and line items. Other options are
available from the applications screen by clicking the down arrow next to your selection.

Show columns in this order on the applications screen. Select an item use the up and down arrow
buttons to move column in the order you want them to appear on the applications screen.

Restore Default Column Order. Click this button to restore the column order to system defaults.
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Payment/Credit

With the Payment/Credit Options, you select the appearance of the applications screen accessed through
payments and credits.

# Dptions P |

ﬁenerall Home HRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl
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Payment,/ Credit Options

wmentyLredit W Show ewvery other application row using this colar ||:| Cuztom Color - | @l
F'r_o uct and Billing [tem
Client .. Shows thiz menu option by default when the application zcreen iz first
i Client Activity —
“Client Summary I Select Additional Charges j
Ehar_ge
Credit Show columns in thiz order on the applications screen;

Invaice
Invoice Line ltem
Fecurring lrnvaice
Returm

Return Line ltern gescrlptlon - |

Refund Hiner

Do DiistributedTo b |
Eposl Available

Payment

Apply. . Amount

Restore Default Column Order |

Show every other application row using this color [ ]. Mark this box to alternate colors of rows on the
application screen. Select a color from the submenu or click on the palette icon to define your own color.

Show this menu option by default when the application screen is first opened. Select the menu
option that you would like to appear on the application screen for charges and line items. Other options are
available from the applications screen by clicking the down arrow next to your selection.

Show columns in this order on the applications screen. Select an item use the up and down arrow
buttons to move column in the order you want them to appear on the applications screen.

Restore Default Column Order. Click this button to restore the column order to system defaults.

Product and Billing Item

For Product and Billing Item options on the Records tab, select the type you add most frequently as the default:
Flat Rate Item, Per Usage Item, Finance Charge ltem, Sales Tax Item, Refund Item, or Product. For example, select
Refund Item. On the Products and Billing Items page in Records, New Refund Item appears on the action bar. You
can click the down arrow beside New Refund Item to access the new screens for the other types.

## Options I |

ﬁenerall Home HRecords |_D_uery| EHport' Heporﬁs' &dministlationl Color | Erintingl Eil= Locationsl

==
M ©You can uze these options bo zet perzonal preferences that acour system wide.

Product and Billing Item Options

i~Charge/Line ltem

£ Payment/Credi Diefault billing item type: | Flat B ate [bem j
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Client

For Client options on the Records tab, select the tab to appear first when you open a client record.

## Options I |

ﬁenerall Home HRecords |_D_uery| EHport' Heporﬁs' &dministlationl Color | Erintingl Eil= Locationsl

e
M ©You cah uze these options bo zet perzonal preferences that acour system wide.

A pplications Client Options

i~Charge/Line ltem
= Payrment/ Cradit
Product and Biling Item

Dizplay this tab when a recard iz opened: IEIient 1 j

i Client Activity
= Client Summary

Display this tab when arecord is opened. Select the tab to appear first when you open a client record:
Client 1, Client 2, Defaults, Addresses, Activity, Attributes, Media, Notes, Actions, Statements, Relationships,
Payers or History.

Client Activity

For Client Activity options on the Records tab, you can select to include deleted transactions and set display
options for the Activity tab of client records.

= Options - I

ﬁenerall Home Records |Query| Exportl Hepolﬁsl gdministlationl Color I Erintingl File Locationsl

ol
|‘Lb: ~ Y'ou can use these options to get personal preferences that ocour system wide.

General

Applications
iCharge/Line lkem
P apment/Credit

Client Activity Options

[T Show deleted and voided tranzaction:

EI['DstAd and Billing ltem [~ Show balance as of | Last statement date j
en
)t Show I.-’-‘«ctivit_l,l by tranzaction date j
Ehacll_ge Sort: IThe ozt recent activity bo the bop of the grid j
redit
Invaice W Show <Distributeds transactiong on moliple rows
Inwaice Line Ibem
Recuring Invoice [~ Show irvoicedreturn line bern detail
Return

EeEurn_Line Item
Show deleted transactions. To view deleted, posted transactions on the client Activity tab, mark the
checkbox. You cannot view deleted transactions that were never posted.

Show balance as of. Select to show the balance on the Activity tab by last statement date, last calendar year,
last fiscal year, last fiscal period, or the current date.

Show. Select to show activity by transaction date or to show payments/credits with their associated charges.
Sort. Select to show the most recent or the oldest activity at the top of the grid.

Show <Distributed> transactions on multiple rows. To default the Show “<Distributed> transactions on
multiple rows checkbox on clients’ Activity tab to be marked, mark this box. You can unmark the box on the
Activity tab.

Show invoice/return line item detail. To default the Show invoice/return line item detail checkbox on
clients’ Activity tab to be marked, mark this box. You can unmark the box on the Activity tab.
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Client Summary

For Client Summary options on the Records tab, set display options for viewing summary client information. To
view a client summary, from a client record, click Summary on the action bar of the client Activity tab.

EEEammmeee - mmnl

ﬁenerall Home HRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl

=
M © Vou can use these optiong bo zet personal preferences that occur system wide.

General " , : Ay

o ppieations Client Summary Options
i~Charge/Line ltem Diefault summary view: | General summan bt
= Payment/Credit I Y J

Product and Billing ltem

Cliert Default dates for the General Summary

g Shaow: Calendaryearsj Tear 1: I(BIank) j
Credit ‘fear 2 |<Elank> "I
Invaice i
Invaice Line Itam Default dates for the Aging Summary

Recurring lrvoice :
Retum 9 Age tranzactions as of; |<Blank> vl

Return Line ltern
Hefunc_l

Default summary view. Select the default summary view: General summary, Recent activity, Aging summary,
or Lifetime statistics. You can change the view on the Summary screen.

Default dates for the General Summary. Select to show dates by calendar years, fiscal years, or fiscal
periods. These are default dates, you can change this on the Summary screen.

Default dates for the Aging Summary. For the Aging Summary, you can select for the current or previous

date to automatically default in the Age transactions as of field, or select <Blank> to require the date to be
entered manually.

Charge

For Charge options on the Records tab, you can select the default tab and set data entry defaults.

#%: Dptions [ (O] I
Qenerall Home Records I_El_ueryl Exportl Flepor;sl gdminislralionl Calor | Erintingl Fil= Localionsl
g
"wl« [ W'ou can uge these options o zet personal preferences that ocour spstem wide,
pplications Charge Options
i Charge/Line ltem ! : ; ; -
- Payment/Credit Dizplay thiz tab when a record iz opened: ITransacnon j
Praduct and Billing Iter 3
Client Data entry options
= Client Activity :
Cliant Soromar Default charge date: ITDda_',' j
M, Default post status:
Crodi p INotyet posted j
Invoice Default post date: -
Invoice_ Line Ite_rn 5 IEharge date J
Recuring Invoice Default reversal post date: Icharge piorst datke j
Return
Retum Line ltem Diefault print status: INgt Yet Printed j
Refund
Peposit

Display this tab when arecord is opened. Select the tab to appear first when you open a charge record:
Transaction, GL Distribution, Payments/Credits, or Attributes/Notes.

Default charge date. For the transaction date of a new charge to automatically default to the current date,
select Today. If you select <Blank>, the date must be entered on the Transaction tab of each new charge.
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Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, charge date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new charge record, select
<Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the charge post
date. To require the date to be entered manually when you delete a charge, select <Blank>.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.

Credit

For Credit options on the Records tab, you can select the default tab and set data entry defaults.

## Options I |

ﬁenerall Home HRecords |_D_uery| EHport' Heporﬁs' &dministlationl Color | Erintingl Eil= Locationsl
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M ©You can uze these options bo zet perzonal preferences that acour system wide.

General — —
Aprieations
i Charge/Line |tem
Payrnents Credit
Product and Billing ltem
Client
i Client Activity
= Client Surmmary

Chafﬁe Default post status: I Mot yet posted

Invaice Default post date: Il:redil date
Invoice Line ltem

Fecurring Irvoice Default reversal post date: Ic[edi[ post date
Returm
Fretun Line [tem Default print status: INc-tYet Frirted
Refund
Deposit

Dizplay this tab when a recard iz opened: ITransactiDn j

Data entry options

Default credit date: Inga_l,l

LefLefLef Lef L

Display this tab when arecord is opened. Select the tab to appear first when you open a credit record:
Transaction, GL Distribution, Applied To, or Attributes/Notes.

Default credit date. For the transaction date of a new credit to automatically default to the current date, select
Today. If you select <Blank>, the date must be entered on the Transaction tab of each new credit.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, credit date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new credit record, select
<Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the credit post
date. To require the date to be entered manually when you delete a credit, select <Blank>.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.
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Invoice

For Invoice options on the Records tab, you can select the default tab and set data entry defaults.

&% Opkions !E[ E
General | Home Huery | Export | Reports | Ldministration | Color | FErinting | File: Locations |
e
M ©You cah uze these optiohs bo zet perzonal preferences that acour system wide.
General Invoice Dptions
A pplications:
i~ Charge/Line ltem ! i i i -
- Payment/Credi Display this tab when a record is opened: ||n\.lg|ce j
Product and Billing Item B
Cliert Data entry options
i Client Activity B :
L Client Surnmary Default invoice date: Ingay j
Charge Default ordered-on date: i
Cradit . IInvolce date j
|nvoice s | —
Iv v Default invoice due date:; IBase o ifvoice date j
Recuring lrvoice Default print status: I Mat et Printed j
Returm
Returm Line ltem
Rafnd

Display this tab when a record is opened. Select the tab to appear first when you open an invoice record:
Invoice, Line Items, Payments/Credits, or Attributes/Notes.

Default invoice date. For the invoice date of a new invoice to automatically default to the current date, select
Today. If you select <Blank>, the date must be entered on the Invoice tab of each new invoice.

Default ordered-on date. You can set the default order date to the current date or the invoice date. If you
select <Blank>, the date must be entered in the Ordered on field on the Invoice tab of each new invoice.

Default invoice due date. You can set the default due date to be based on the invoice date or the ordered-on
date. To require the invoice due date to be entered manually on each new invoice, select <Blank>.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.
Invoice Line Item

For Invoice Line Item options on the Records tab, you can select the default tab and set data entry defaults.

#% Dptions [ (O] I

Qenerall Home Records I_El_ueryl Exportl Flepor;sl gdminislralionl Calor | Erintingl Fil= Localionsl
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"wl« [ Vou can uze these options bo set personal preferences that occur system wide,

General Invoice Line Item Options

Applications

Charge/Line ltem ! : ; i

b Payment/Credi Dizplay this tab when a record is opened: | Line Iem j
Praduct and Billing Iter 3

Cliert Data entry options

i Client Activity o :

" Client Surnmary Default line itermn date: ITDda_l,l j

Charge Default post status:

Credit ] . INotyet posted j

Invaic Default post date: ine i
Invaice Line ltem i ILlne iem date j

Recurring Invoice Default reversal pozt date: ILine itern post date j

Return

Returm Line ltem

Refund

Display this tab when arecord is opened. Select the tab to appear first when you open an invoice line item
record: Line Item, GL Distribution, Payments/Credits, or Notes.
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Default line item date. For the transaction date of a new invoice line item to automatically default to the
current date, select Today. If you select <Blank>, the date must be entered on the Line Item tab of each new
line item.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, line item date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new invoice line item record,
select <Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the line item post
date. To require the date to be entered manually when you delete an invoice line item, select <Blank>.

Recurring Invoice

For Recurring Invoice options on the Records tab, select the tab to appear first when you open a recurring invoice
record.

s Options . I

Qenerall Home Records I_El_ueryl Exportl Flepor;sl gdminislralionl Calor | Erintingl Fil= Localionsl
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General
Applications )

Recurring Invoice Options

Dizplay this tab when a record is opened: | R ecuring lnvoice j

Invoice
Invaice Line Item

Return

For Return options on the Records tab, you can select the default tab and set data entry defaults.

s Options . I
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s pplications Return Options

- Charge/Line [tem
= Papment/Credit
Product and Billing ltem

Digplay this tab when a record is opened: IHEtum j

Data entry options

Client

i Client Activity ;

£ Client Summary Default retumn date: ITDda_'r' ﬂ
Charge Default returned-on date:
Credt - IHeturn date j
Invoice Default print status: INDt Vet Printed ﬂ

Invoice Line lterm

Recurring lrvoice
Display this tab when a record is opened. Select the tab to appear first when you open a return record:
Return, Line Items, or Attributes/Notes.
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Default return date. For the return date to default to the current date, select Today. If you select <Blank>, the
date must be entered on the Return tab of each new return.

Default returned-on date. You can set the default returned-on date to the current date or the return date. If
you select <Blank>, the date must be entered in the Returned on field on the Return tab of each new return.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.

Return Line ltem

For Return Line Item options on the Records tab, you can select the default tab and set data entry defaults.

## Options I |
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General Return Line Item DOptions
[Applications

i ChargeLine ltem
= Payrment/ Cradit
Product and Billing ltem

Dizplay this tab when a recard iz opened: ILine Item j

Data entry options

Client

i Client Activit :

e Sumrn_:ry Default post status: INgt yet posted j
Charge Default post date: ine i
Cred_it p G ILlne item date j
Invaice Default reversal post date: ILine itern post date j

Invoice Line ltem
Frecuring lnvaice
Returm

Refund

Display this tab when a record is opened. Select the tab to appear first when you open a return line item
record: Line ltem, GL Distribution, Applied To, or Attributes/Notes.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, line item date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new return line item record,
select <Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the line item post
date. To require the date to be entered manually when you delete a return line item, select <Blank>.
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Refund

For Refund options on the Records tab, you can select the default tab and set data entry defaults.
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A pplications Refund Options

i~Charge/Line ltem

= Payrment/ Cradit
Product and Billing ltem
Client

i Client Activity

= Client Surmary
Charge
Credit
Inveice Default post date: | Transaction date
Invoice Line ltem
Frecuring lnvaice
Returm
Fieturn Line ltem

Dizplay this tab when a recard iz opened: IHefund j

Data entry options

Default refund date: Inga_l,l

Default post status: INot vet posted

Lef Lef Lo

Deposit

Display this tab when a record is opened. Select the tab to appear first when you open a refund record:
Refund, GL Distribution, Payments/Credits, or Attributes/Notes.

Default refund date. For the refund date to default to the current date, select Today. If you select <Blank>, the
date must be entered on the Refund tab of each new refund.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, transaction date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new refund record, select
<Blank>.

Deposit

For Deposit options on the Records tab, you can select a default bank and set data entry defaults.

f% Options
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pplications Deposit Options

iCharge/Line ltem

iPayment/Credit Llge thiz bank by default when adding new deposits: I - I ﬁl
Product and Billing Ibem Data entry oplions
Clignt ¥ op

iClient Activity
#Client Surnmary
Charge
Credit
Irvnice B
e e e Default post stabus: INot vet posted
Recuming lrvoice Default post date: IDeposil date
Return
Return Line tem
R efund

Default deposit date: I Today

Default depozit entry date: I Depozit date

L L Led el

Payment
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Use this bank by default when adding new deposits. Select the bank you use most frequently for new
deposits.

Default deposit date. For the deposit date to default to the current date, select Today. If you select <Blank>,
the date must be entered manually.

Default deposit entry date. You can set the default deposit entry date to the current date or the deposit date.
If you select <Blank>, the date must be entered manually.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, deposit date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new deposit record, select
<Blank>.

Payment

For Payment options on the Records tab, you can set the default values for payment records.

&5 Options P |
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i pplications Payment Options

i~Charge/Line Item Diefault payment date; I Today j

P ayment/Credit
F'r_oduct and Billing ltem Default print status: IDD Mat Print
Client

iClignt Activity

= Client Surmmary
Charge
Credit
Invoice
Inwaice Line ltem
Recuring Invoice
Return
Return Line [tem
Refund

Deiosit

Default payment date. Select the default payment date for new payments. If you select <Blank>, the date must
be entered manually.

Default print status. Select the default print status for new payments.

Cash Receipts Records Options

The settings you define on the Records tab of the Options screen in Cash Receipts affect deposits and payments.
For example, you can set defaults to make data entry quicker and more consistent.
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Deposit

For Deposit options on the Records tab, you can select a default bank and set data entry defaults.

% Options

Qenerall Home | _El_ueryl E:-cporll Flepor;sl gdminislrationl Calor | Erintingl File Localionsl

o [
IJ'“; 2 ou can uze these options to zet personal preferences that occur spstem wide.

Pamen
Ise this bank by default when adding new depasits: I jﬁl
Data entry options
Default deposit date: I Today j
Default deposit entry date: I Deposit date j
Default post status: INot_n,uet posted ﬂ
Drefault post date: IDepUsil date j

Use this bank by default when adding new deposits. Select the bank you use most frequently for new
deposits.

Default deposit date. For the deposit date to default to the current date, select Today. If you select <Blank>,
the date must be entered manually.

Default deposit entry date. You can set the default deposit entry date to the current date or the deposit date.
If you select <Blank>, the date must be entered manually.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, deposit date, or the last date of the

current fiscal period. To require the post date to be entered manually on each new deposit record, select
<Blank>.

Payment

For Payment options on the Records tab, you can set the default values for payment records.

= Options - I

ﬁenerall Home Records |Query| Exportl Hepolﬁsl gdministlationl Color I Erintingl File Locationsl

=
|‘Lb: ~Y'ou can use these options to get personal preferences that ocour system wide.

Deposit Payment Options
Default payment date: ITDda-"' j
Default print status: IDo Mat Print j

Default payment date. Select the default payment date for new payments. If you select <Blank>, the date must
be entered manually.

Default print status. Select the default print status for new payments.
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Fixed Assets Records Options

The settings you define on the Records tab of the Options screen in Fixed Assets affect asset and transaction
records. For example, you can designate the Asset Wizard as the primary entry method when creating new
assets, and you can set default dates for asset and transaction activity.

General

For General options on the Records tab, you can choose to enter assets through the Asset Wizard by default,
select the type of asset identifier to use when creating transactions, and set the text for the asset record title bar.
Also, you can add new fields to appear in the title bar.

fi% Options

| _D_ueryl E:-cpoltl F!epor;sl édministrationl Calor | Erintingl File Locationsl
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Azzet General Options

i---»‘-‘-«sset_»\‘-"u:tivity ¥ Use the Asset Wizard as the default entry method when creating a new asset
Tranzaction
Transaction Activity When creating transactions, select azset by entering: I.&sset Nurmber j

Display these fields in the title bar for each asset:

Field Mame I Length | Fields |
Aszzet Numnber 4
: <Hyphen: 1 Restore Defaults |

I Azzet Description =]

1256541-HP Laseret =

Note: The Asset Wizard enables you to add more than one asset at a time. If you want to add very detailed
information, you may want to add assets using the normal asset record.

Use Asset Wizard as default entry method when creating new assets. If you mark this checkbox, Add
a New Asset using the Asset Wizard is the first selection on the Assets page in Records. Also, when you click
New on the Asset List, the Wizard automatically appears. You access the Asset List by clicking View All Assets
on the Assets page in Records.

When creating transactions, select asset by entering [ ]. If you select Asset Number, you must enter or
find the asset number each time you create a transaction. If you select Asset ID, you must enter or find the
asset ID each time you create a transaction.

Display these fields in the title bar for each asset. This grid enables you to control the information
appearing in the title bar of the asset record. It can be helpful if you typically have several asset records open
at one time.

Fields. Click this button to define extra fields that you want to use in the title bar of an asset record. Any fields
you add on the fly on the Define Asset Titlebar Fields screen appear exactly as they are typed. In the Field
Name column, click in the next available row and enter the text you want to appear on the Asset title bar.
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When you are finished defining new field names, click OK. You can then select the new field(s) from the
drop-down list in the grid under General Options.

&% Define Asset Title Bar Fields

Enter below any extra user-defined fields to include as part
of the azzet title bar.

Field Name | oK. |
|| <5pace:
|| <Hyphen: Cancel |

[

Note: When you click Reset to System Defaults, you lose all of your own settings in the grid and they cannot be
restored.

Reset to System Defaults. Click this button to return to the original program defaults. When you click Reset
to System Defaults, you lose all of your own settings in the grid and they cannot be restored.

Asset

For Asset options on the Records tab, you can set the tab that appears first when you open an asset record and
specify how to add new descriptions.

f% Options

Qenelall Home ; _D_ueryl Expoltl Hepor;sl Qdministrationl Calor | Erintingl File Locationsl

o e
“]Z You cat uze these optiohs o zet personal preferences that ocour systen wide.

[General Asset Dptions

“episaet Achivity Default Tab:
Transaction
L Transaction Activity I General j

Aszet description table: IAutomaticaIly add new descriptions j

Default Tab. Select the tab to appear first when you open an asset record.

Note: To prevent duplicate descriptions from being added that have a different spelling or word usage, you
may want to select Do not add new descriptions or Ask before adding new descriptions.

Asset description table. Asset descriptions are normally defined on the Tables tab of Configuration. If you
want to be able to add new asset descriptions on the fly while in an asset record, you can select for the
program to ask for your confirmation first or to automatically add new descriptions. If you do not want to
allow new descriptions to be added from an asset record, select Do not add new descriptions.
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Asset Activity

For Asset Activity options, specify the date period of activity to show on the Activity tab and whether to show
deleted transactions.

f% Options

General | Home

_D_ueryl Expoltl Hepor;sl Qdministrationl Calor | Erintingl File Locations

P
“IE 2'Wou cah use these optiohs bo set personhal preferences that accur spstem wide.

Asset Activity Options

™ Show deleted tranzactions
Tranzaction

i-Transaction Activity Default dates for aszet activity: |41 dates j

Show deleted transactions. To view deleted, posted transactions on the asset Activity tab, mark the
checkbox. You cannot view deleted transactions that were never posted.

Default date for asset activity. Select the date period of activity to appear in the grid on the asset Activity
tab. This setting is just a default and can easily be changed within individual asset records.

Transaction

For Transaction options, select the tab to appear first when you open a transaction record.

fita Dptions

General | Home

|_D_uery| Expoltl Heporﬁsl Qdministrationl Color | Erintingl File Locationsl

=
“IE “ou can uze these options to set personal preferences that occur system wide.

General Transaction Options
Asset
- fsek Actkivit Default Tab:

“-Transaction Activity I General j
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Transaction Activity

For Transaction Activity options on the Records tab, select default values to appear on the Activity tab of
transactions. For example, you can set default transaction dates and post information.

f% Options

General | Haome ;.

uer_l,.ll Expoltl Heporﬁsl Qdministrationl Calor | Erintingl Eile Locationsl

e e
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Default reversal post date: Inga}.

E::eet[al Transaction Activity Options
Fsset Activi Default transaction date: |<Blank> j
Trangaction
] Default tranzaction type: |<Blank> j
Default post status: INot vet posted j
Default post date: |<Blank> j
[

Default transaction date. You can select to set the default to a specific transaction date, such as Today, Period

end date, or Period start date. If you select <Blank>, the date must be entered on the General tab of each new
transaction.

Default transaction type. If you are entering many transactions with the same transaction type, you can save
time by selecting a default. This setting can easily be changed within individual transaction records.
Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. Set a specific default post date or select <Blank> to require the post date to be entered
manually on each new transaction.

Default reversal post date. Set a specific default reversal post date or select <Blank> to require the date to be
entered manually when you delete a posted transaction.



OpPTIONS 10

Student Billing Records Options

The settings you define on the Records tab of the Options screen in Student Billing affect students, individuals,
organizations, product and billing items, charges, credits, automatic payments, financial aid, advance deposits,
refunds, deposits, and payments. For example, you can set defaults to make data entry quicker and more
consistent.

General

For General options on the Records tab, you can select general default data entry options for transactions.

ﬁenerall Home' Fast _D_ueryl Exportl F!epc-r;s' adminiﬂrationl Calar | Erintingl Filz Lc-catic-nsl

e —
"wl« [ Vou can uze these options bo set personal preferences that occur system wide.

ppiicalions General Options

i Charge/&dvance Depos | Show these fields when entering new charges, invoices, and credits:

= Payment/Credit
Praduct and Billing Iter [¥ Record Name :l
Shudent [+ Record ID - |
Individual [V Individual 55M/Organization CFDM #
Qrganization
Activity B P
Activity Summary Uze thiz categom for tew transactions: I j
Automatic Payments
Charge Show these fields when entering new Student Biling receipts:
a\?gillt:e [+ Rrecaord Mame - |
Invoice Line ltem [+ Record ID - |
Freturn ) [#! Individual S5} Organization CFD& #
Ristum Line ltem [ Statement Reference Number
Refund
Deposit
Pa}lljment Erter special discounts using % Percentage © Amount
Advance Deposit
Financial Aid
Billing Schedule
Address

[~ Show account balance with scheduled activity for students, individualz, and organizations

Rezet to Spztem Defaults | 0K I Cancel | Lpply |

Show these fields when entering new charges, invoices, and credits. Mark checkboxes for the record
fields to appear in the name grid on charge, invoices, and credit records. You can use the up and down arrows
to change the order in which the fields appear.

Use this category for new transactions. Select a default category to use for new transactions.

Show these fields when entering new Student Billing receipts. Mark checkboxes for the fields to
appear in the name grid on payment records. You can use the up and down arrows to change the order in
which the fields appear.

Enter special discounts using. Mark Amount or Percentage to select how to enter trade discounts on
records.

Show account balance with scheduled activity for students, individuals and organizations. Mark
this option to include the Balance with scheduled activity field in the status bar for student, individual, and
organization records.
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Charge/Advance Deposit Item

With the Charge/Advance Deposit Item Options, you select the appearance of the applications screen accessed
through charges and advance deposit items.

|

ﬁenerall Home HRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl

e
"lk.« You can uze these optiong bo zet personal preferences that occur system wide.

Charge/ Advance Deposit Item Options

W Show ewvery other application row using this colar ||:| Cuztom Color j@]

Product and Billing ltem
Student Show thiz menu option by default when the application zcreen is first opened:

Individual — -
Organization ISeIect Additional Payments or Credits j
Activity
Activity Summary Show columns in thiz order on the applications screen;
Autarnatic Payments
Charge

Credit

Refund

Deposit

Payment

Advatice Deposit
Financial Aid

Billing Schedule

Applied Amount

Restore Default Column Order |

Reset to System Defaults | 0K I Cancel | Apply |

Show every other application row using this color [ ]. Mark this box to alternate colors of rows on the
application screen. Select a color from the submenu or click on the palette icon to define your own color.

Show this menu option by default when the application screen is first opened. Select the menu
option that you would like to appear on the application screen for charges and line items. Other options are
available from the applications screen by clicking the down arrow next to your selection.

Show columns in this order on the applications screen. Select an item use the up and down arrow
buttons to move column in the order you want them to appear on the applications screen.

Restore Default Column Order. Click this button to restore the column order to system defaults.
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Payment/Credit

With the Payment/Credit Options, you select the appearance of the applications screen accessed through
payments and credits.

|

ﬁenerall Home HRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl
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General

Applications

e/ddvance Depog
iHaurment/Credit
Product and Billing ltem
Fté‘,d'?d”t | Show thiz menu option by default when the application screen is first opened:
S;;Lg:tion I Select Additional Charges j
Activity
Activity Summary Show colurnng in thiz order on the applications screen:
Autarnatic Payments
Charge

Credit

Refund

Deposit

Payment

Advatice Deposit
Financial Aid

Billing Schedule

Payment,/ Credit Options

W Show ewvery other application row using this colar ||:| Cuztom Color j@]

Applied Amount

Restore Default Column Order |

Reset to System Defaults | 0K I Cancel | Apply |

Show every other application row using this color [ ]. Mark this box to alternate colors of rows on the
application screen. Select a color from the submenu or click on the palette icon to define your own color.

Show this menu option by default when the application screen is first opened. Select the menu
option that you would like to appear on the application screen for payments and credits. Other options are
available from the applications screen by clicking the down arrow next to your selection.

Show columns in this order on the applications screen. Select an item use the up and down arrow
buttons to move column in the order you want them to appear on the applications screen.

Restore Default Column Order. Click this button to restore the column order to system defaults.
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Product and Billing Item

For Product and Billing Item options on the Records tab, select the billing item type you add most frequently as
the default. For example, select Flat Rate Item. On the Products and Billing Items page in Records, New Flat Rate
Item appears on the action bar. You can click the down arrow beside New Flat Rate Item to access the new
screens for the other types.

Options |

ﬁenerall Home Records I_U_ueryl Export' F!epc-r;s' adminiﬂrationl Calar | Erintingl Filz Lo-:aticml
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General

Applications

- Charge/tdvance Depos
Payrnent/ Credit
‘Praduct ahd Billing [term
Student

Individual

Organization

Activity

[T T - ppe——

Product and Billing Item Options

Default billing item type: I Flat R ate [tem ﬂ

Student

For Student options on the Records tab, you can select the tab to display when a student record is opened, the
tabs to check for data, the appearance of the name on the record, and default tab filters.

|

General I Home

_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl
ey
"lk.« You can uze these optiong bo zet personal preferences that occur system wide.

Gieneral Student Options
Applications

gz;ﬁ:;ﬂgr:;fe Uepos | Display this tab when a record is opened: IBiD 1 j

Product and Billing Item :
ETE R | Tile b display: | Ful Name =]

Individual

Organization

Act@v@ly .

ict""t}' tsU”P“ma'-'r' X Check these tabs for data:

EE;;;': 1" Fayments Statements . =]
Credit EFT Bank Information

Refund Automatic: Papments

Deposit efault 5cheduls

Payment Hi 1 of Changes

Advance Deposit A =

Financial Aid .

Billing Schedule Default set to use: | Student address j

™ Autamatically load when creating new records

Display this tab when a record is opened. Select the tab to appear first when you open a student record.

Title bar display. Select the appearance of student names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Student Billing.
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Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new student records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new student record. If you do not mark Automatically load when creating new records, you can

place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.

Individual

For Individual options on the Records tab, you can select the tab to display when an individual record is opened,
the tabs to check for data, and the appearance of the name on the record.

Options |

ﬁenerall Home BRecords I_U_ueryl Export' F!epc-r;s' adminiﬂrationl Calar | Erintingl Filz Lo-:aticml
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"wl« Y'ou can uze these options to set personal preferences that occur system wide.
General Individual Options
Applications
i-Charge/&dvance Depos | Display this tab when a record s opened: IEio 1 j

P ayment/Credit
Praduct and Billing Iter

Student Title bar dizplay: IFuII fame j
ndrvicual

Organization

Activity .

ictlwty Surpnmar_l,l Check theze tabs for data;

CEE:;;: he Peyments Attributes ;I
Credit MNates

Refund b edia

Deposit .

Payment

Advance Deposit

Financial Aid :

Biling Schedule Default set bo uze: j

= Gutormatical laad wher cresting new reconds

Display this tab when a record is opened. Select the tab to appear first when you open an organization
record.

Title bar display. Select the appearance of individual names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Student Billing.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new individual records.
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If you mark Automatically load when creating new records, the default values are added automatically when
you open a new individual record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.

Organization

For Organization options on the Records tab, you can select the tab to display when an organization record is
opened and the tabs to check for data.

N |

ﬁenerall Home BRecords |_D_uery| EHport' Heporﬁs' &dministlationl Color | Erintingl Eil= Locationsl

e
M You can uze these options ba zet perzonal preferences that ocour system wide.

sopiea
il atiors Organization Options

ggjﬁ:;ﬂg:’:;?e Depos | Displap this tab when a record is opened: IBio 1 j

Product and Billing ltem :
Student Check these tabs for data:

Individual Attributes ;I
= W] ot

Achivity Aot_es

Auctivity Surmmarny Chons

Automatic Payments MEd'a _

Charge Hi of Changes

Credit :

Refund

Deposit Diefault st to use: j

Payment . :

Advarice Deposit ™| Avtomatizaliload when creating new reconds

Financial Aid

Billing Schedule

Display this tab when a record is opened. Select the tab to appear first when you open an organization
record.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new organization records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new organization record. If you do not mark Automatically load when creating new records, you
can place the cursor in a field and press F2 to load a single default value from the set. Or you can press

SHIFT + F2 to load all the values from the default set.
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Activity

For Activity options on the Records tab, you can select to include deleted transactions and set display options for
the Activity tab of student records.

|

ﬁenerall ﬂomel Fast BRecords I_D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl

s
M “Vou zan uze these optiong to zet personal preferences that occur system wide.

sk
ipplications Activity Options

~Charge/tdvance Depos | [ Show deleted and voided transactions

= Payment/Credit

g[oguct and Billing [tem [~ Show balance as of ILast statement date j
udenl
Individual Showe | Activity by ranzaction date i
Organization I J
v St IThe ozt recent activity to the top of the grid j
Activity Summal_l,l
.éﬁtomatlc Payrnents [~ Shaow <Digtibuted: tranzactionz on multiple rows
arge . .
Credit [~ Show all availsble payments and credits far payer(s)

Invoice

Invaice Line Item
Returm

Fovee 1

[~ Show ireeoice/reture line ibern detai

Show deleted and voided transactions. To view deleted and voided, posted transactions on the student
Activity tab, mark the checkbox. You cannot view deleted transactions that were never posted.

Show balance as of. Select to show the balance on the Activity tab by last statement date, last calendar year,
last fiscal year, last fiscal period, or the current date. This date is a default and can be changed on the Activity
tab.

Show. Select to show activity by transaction date or to show payments/credits with their associated charges.
Sort. Select to show the most recent or the oldest activity at the top of the grid.

Show <Distributed> transactions on multiple rows. Mark this option to mark the Show <Distributed>
transactions on multiple rows checkbox on students’ Activity tab by default. Marking this option displays
each line item of distributed transactions on a separate row in the grid. You can unmark the box on the
Activity tab.

Show all available payments and credits for payer(s). Mark this option to mark Show all available
payments and credits for payer(s) checkbox on students’ Activity tab by default. Marking this option displays
all payments and credits, including those for other payers. You can unmark the box on the Activity tab.

Show invoice/return line item detail. Mark this option to mark the Show invoice/return line item detail
checkbox on students’ Activity tab by default. Marking this option displays individual invoice line items and
return line items as entries on the Activity tab. If you do not mark this option, the invoices and returns display
as entries. You can unmark the box on the Activity tab.
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Activity Summary

For Activity Summary options on the Records tab, set display options for viewing summary activity information.
To view a student activity summary, from a student record, click Summary on the action bar of the student
Activity tab.

|
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General g , . : 3
pploations Activity Summary Options
- Charge/ddvance Depos | Default summary view: |General J— =l

= Payment/Credit
Praduct and Billing Item
Student
Individual
Organization
Activi
4, S rrmary
Autarnatic Payments
Charge

g:fﬂl;d Age tranzachions as of; |<Blank> vl

Deposit

Payment
Advance Deposit
Finarncial Aid

Default dates for the General Summary

Showy: Calendaryearsj YBaf13|<EIank> j

‘fear Z; |<Elank> 'I

Default dates for the Aging Summary

Default summary view. Select the default summary view: General summary, Recent activity, Aging summary,
Lifetime statistics, or Fin. Aid/Adv. Deposit summary. You can change the view on the Summary screen.

Default dates for the General Summary. Select to show dates by calendar years, fiscal years, or fiscal
periods. These are default dates, you can change this on the Summary screen.

Default dates for the Aging Summary. For the Aging Summary, you can select for the current or previous
date to automatically default in the Age transactions as of field, or select <Blank> to require the date to be
entered manually.

Automatic Payments

If you have the EFT optional module installed, for Automatic Payments options on the Records tab, you can select
the default EFT transaction setting for the Automatic Payments tab of student, individual, and organization
records.

Options |

ﬁenerall Home Records I_U_ueryl Export' F!epc-r;s' adminiﬂrationl Calar | Erintingl Filz Lo-:aticml
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General

Applications
- Charge/ddvance Depos
= Payment/Credit

Praduct and Billing Iter

Student

Individual

Qrganization

Activity

Automatic Payments Options

Default EFT transaction setting: IDD rot create EFT transactions j
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Charge

For Charge options on the Records tab, you can select the default tab and set data entry defaults.

N |
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A pplications Charge Options

i Charge/ddvance Depos | ) : -

5---F'a_l,ln$enh"[ﬁredit P Digplay this tab when a record is opened: ITransacth j
Product and Billing ltem -
Student Data entry options
Individual .
Diganization Defaulk charge date: IToday j
Activity Default post status:
Activity Summar_l,l P : INClt yet posted j
Automatic Payments Default post date: IEharge date j
Credit Default reversal post date: | Charge post date =
Refund I g J
Deposit Default print status: I Mot et Printed j
Payment
Advatice Deposit
Financial Aid Default zet bo Lze: hd
Billing Sechedule : I J

™| Eutarnaticall laad whet crestinn new recards

Display this tab when arecord is opened. Select the tab to appear first when you open a charge record:
Transaction, GL Distribution, Payments/Credits, or Attributes/Notes.

Default charge date. For the transaction date of a new charge to automatically default to the current date,
select Today. If you select <Blank>, the date must be entered on the Transaction tab of each new charge.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, charge date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new charge record, select
<Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the charge post
date. To require the date to be entered manually when you delete a charge, select <Blank>.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.
Default set to use [ ]. In this field, select a default set to use for new charge records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new charge record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.
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Credit

For Credit options on the Records tab, you can select the default tab and set data entry defaults.
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Display this tab when a record is opened. Select the tab to appear first when you open a credit record:
Transaction, GL Distribution, Applied To, or Attributes/Notes.

Default credit date. For the transaction date of a new credit to automatically default to the current date, select
Today. If you select <Blank>, the date must be entered on the Transaction tab of each new credit.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, credit date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new credit record, select
<Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the credit post
date. To require the date to be entered manually when you delete a credit, select <Blank>.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.
Default set to use [ ]. In this field, select a default set to use for new credit records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new credit record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.
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Invoice

For Invoice options on the Records tab, you can select the default tab and set data entry defaults.
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Display this tab when a record is opened. Select the tab to appear first when you open an invoice record:
Invoice, Line Items, Payments/Credits, or Attributes/Notes.

Default invoice date. For the invoice date of a new invoice to automatically default to the current date, select
Today. If you select <Blank>, the date must be entered on the Invoice tab of each new invoice.

Default invoice due date. Use this option to select the default invoice date. If you select Base on invoice date,
the default due date is determined by the terms selected on the invoice. If you select <Blank>, the date must
be entered on the Invoice tab of each new invoice.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.

Invoice Line Item

For Invoice Line Item options on the Records tab, you can select the default tab and set data entry defaults.
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Display this tab when arecord is opened. Select the tab to appear first when you open an invoice line item
record: Line Item, GL Distribution, Payments/Credits, or Notes.

Default line item date. For the transaction date of a new invoice line item to automatically default to the
current date, select Today. If you select <Blank>, the date must be entered on the Line Item tab of each new
line item.
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Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, line item date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new invoice line item record,
select <Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the line item post
date. To require the date to be entered manually when you delete an invoice line item, select <Blank>.

Return

For Return options on the Records tab, you can select the default tab and set data entry defaults.
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Display this tab when a record is opened. Select the tab to appear first when you open a return record:
Return, Line Items, or Attributes/Notes.

Default return date. For the return date to default to the current date, select Today. If you select <Blank>, the
date must be entered on the Return tab of each new return.

Default print status. You can set the default print status to Do Not Print or Not Yet Printed.

Return Line Item

For Return Line Item options on the Records tab, you can select the default tab and set data entry defaults.
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Display this tab when arecord is opened. Select the tab to appear first when you open a return line item
record: Line ltem, GL Distribution, Applied To, or Attributes/Notes.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, line item date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new return line item record,
select <Blank>.

Default reversal post date. You can set the default reversal post date to the current date or the line item post
date. To require the date to be entered manually when you delete a return line item, select <Blank>.

Refund

For Refund options on the Records tab, you can select the default tab and set data entry defaults.
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Display this tab when a record is opened. Select the tab to appear first when you open a refund record:
Refund, GL Distribution, Payments/Credits, or Attributes/Notes.

Default refund date. For the refund date to default to the current date, select Today. If you select <Blank>, the
date must be entered on the Refund tab of each new refund.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, transaction date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new refund record, select
<Blank>.

Default set to use [ ]. In this field, select a default set to use for new refund records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new refund record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.
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Deposit
For Deposit options on the Records tab, you can select a default bank and set data entry defaults.
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Use this bank by default when adding new deposits. Select the bank you use most frequently for new
deposits.

Default deposit date. For the deposit date to default to the current date, select Today. If you select <Blank>,
the date must be entered manually.

Default deposit entry date. You can set the default deposit entry date to the current date or the deposit date.
If you select <Blank>, the date must be entered manually.

Note: If a business rule is set to exclude Do not post, the only available post status is Not yet posted.

Default post status. You can set the default post status to Not yet posted or Do not post.

Default post date. You can set the default post date to the current date, deposit date, or the last date of the
current fiscal period. To require the post date to be entered manually on each new deposit record, select
<Blank>.

Payment

For Payment options on the Records tab, you can set the default values for payment records.
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Default payment date. Select the default payment date for new payments. If you select <Blank>, the date must
be entered manually.
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Default print status. Select the default print status for new payments.

Advance Deposit

For Advance Deposit options on the Records tab, you can select the tab to display when an advance deposit
record is opened and the default transaction date to use for advance deposit transactions.
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Display this tab when a record is opened. Select the tab to appear first when you open an advance deposit
record: Transaction, GL Distribution, Payments/Credits, Apply To, Attributes/Notes, or Schedule.

Default transaction date. You can select to set the default to today’s date or select <Blank> so the date must
be entered on the General tab of each new transaction.

Default set to use [ ]. In this field, select a default set to use for new advance deposit records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new advance deposit record. If you do not mark Automatically load when creating new records,
you can place the cursor in a field and press F2 to load a single default value from the set. Or you can press
SHIFT + F2 to load all the values from the default set.

Financial Aid

For Financial Aid options on the Records tab, you can select the tab to display when a financial aid record is
opened and the default transaction date to use for financial aid transactions.
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Display this tab when a record is opened. Select the tab to appear first when you open a financial aid
record: Financial Aid, GL Distribution, Payments/Credits, Apply To, Attributes/Notes, or Schedule.

Default transaction date. You can select to set the default to today’s date or select <Blank> so the date must
be entered on the General tab of each new transaction.

Default set to use [ ]. In this field, select a default set to use for new financial aid records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new financial aid record. If you do not mark Automatically load when creating new records, you
can place the cursor in a field and press F2 to load a single default value from the set. Or you can press

SHIFT + F2 to load all the values from the default set.

Billing Schedule

For Billing Schedule options on the Records tab, you can select the tab to display when a billing schedule is
opened and the default transaction date to use for billing schedules.
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Display this tab when a record is opened. Select the tab to appear first when you open a billing schedule:
Billing Schedule, GL Distribution, Payers, Schedule, or Attributes/Notes.

Default transaction date. You can select to set the default to today’s date or select <Blank> so the date must
be entered on the General tab of each new transaction.

Default set to use [ ]. In this field, select a default set to use for new billing schedule records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new billing schedule record. If you do not mark Automatically load when creating new records,
you can place the cursor in a field and press F2 to load a single default value from the set. Or you can press
SHIFT + F2 to load all the values from the default set.
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Address

For Address options on the Records tab, you can select the default address type to use.
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General Address Options

Default address type. Select the address type to use by default for records.

Admissions Office Records Options

The settings you define on the Records tab of the Options screen in Admissions Office affect applicants,
faculty/staff, individuals, organizations, rooms, and academic years. For example, you can designate how names
appear on records and the first tab that appears when a record is opened.

Applicant

For Applicant options on the Records tab, you can select the tab to display when an applicant record is opened,
the tabs to check for data, and the appearance of the name on the record.
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Display this tab when arecord is opened. Select the tab to appear first when you open an applicant
record.

Title bar display. Select the appearance of applicant names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
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¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ |f you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Admissions Office.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the

name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new applicant records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new applicant record. If you do not mark Automatically load when creating new records, you can

place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.

Faculty/Staff

For Faculty/Staff options on the Records tab, you can select the tab to display when a faculty/staff record is
opened, the tabs to check for data, and the appearance of the name on the record.
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Display this tab when a record is opened. Select the tab to appear first when you open a faculty/staff
record.

Warn if attempting to assign an advisor to a student already assigned to an advisor. Mark this
checkbox to receive a warning if you attempt to assign an advisor to a student who already has one. When the

message appears, you can replace the current advisor or cancel adding the student. If you do not mark this
box, the current advisor is replaced without a warning message.

Title bar display. Select the appearance of faculty/staff names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.

¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.
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¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Admissions Office.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new faculty/staff records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new faculty/staff record. If you do not mark Automatically load when creating new records, you
can place the cursor in a field and press F2 to load a single default value from the set. Or you can press

SHIFT + F2 to load all the values from the default set.

Individual

For Individual options on the Records tab, you can select the tab to display when an individual record is opened,
the tabs to check for data, and the appearance of the name on the record.
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Display this tab when a record is opened. Select the tab to appear first when you open an individual
record.

Title bar display. Select the appearance of individual names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Admissions Office.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. You can mark the checkboxes for the tabs you want checked for data. If data is
present, the name of the tab is colored based on your selection on the Color tab in Options. For more
information about color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new individual records.
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If you mark Automatically load when creating new records, the default values are added automatically when
you open a new individual record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.

Organization

For Organization options on the Records tab, you can select the tab to display when an organization record is
opened and the tabs to check for data.
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Display this tab when a record is opened. Select the tab to appear first when you open an organization
record.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new organization records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new organization record. If you do not mark Automatically load when creating new records, you
can place the cursor in a field and press F2 to load a single default value from the set. Or you can press

SHIFT + F2 to load all the values from the default set.



OPTIONS 12

Room

For Room options on the Records tab, you can select the tab to display when a room record is opened and the
tabs to check for data.
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Display this tab when arecord is opened. Select the tab to appear first when you open a room record.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new room records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new room record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.

Academic Year

For Academic Year options on the Records tab, you can select the number of past and future academic years to
appear in lists.
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Applicant . . - A
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Show future Academic Years. Specify the number of future academic years to show in lists. The current
academic year always appears.
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Show past Academic Years. Specify the number of past academic years to show in lists. The current
academic year always appears.

Address

For Address options on the Records tab, you can select the default address type to use.
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Facully/Stalt Address Options

Individal Default address type:
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Room
Academic Year

Default address type. Select the address type to use by default for records.

Registrar’s Office Records Options

The settings you define on the Records tab of the Options screen in Registrar’s Office affect students,
faculty/staff, individuals, organizations, courses, rooms, academic years, grades, attendance, and scheduling. For
example, you can designate how names appear on records and the first tab to appear when a record is opened.

Student

For Student options on the Records tab, you can select the tab to display when a student record is opened, the
tabs to check for data, the appearance of the name on the record, and default tab filters.

Display this tab when a record is opened. Select the tab to appear first when you open a student record.

Title bar display. Select the appearance of student names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Registrar’s Office.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default tab filters. Select the default filters for the Activities, Conduct, Courses, Schedule, Grades, and
Attendance tabs on student records. You can change the filters at any time when viewing the student record.
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Default grades view. Select the grades view that appears when you select the Grades tab on a student record.
Default set to use [ ]. In this field, select a default set to use for new student records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new student record. If you do not mark Automatically load when creating new records, you can

place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.

Faculty/Staff

For Faculty/Staff options on the Records tab, you can select the tab to display when a faculty/staff records is
opened, the tabs to check for data, and the appearance of the name on the record.
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Display this tab when a record is opened. Select the tab to appear first when you open a faculty/staff
record.

Warn if attempting to assign an advisor to a student already assigned to an advisor. Mark this
checkbox to receive a warning if you attempt to assign an advisor to a student who already has one. When the
message appears, you can replace the current advisor or cancel adding the student. If you do not mark this
box, the current advisor is replaced without a warning message.

Title bar display. Select the appearance of faculty/staff names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Registrar’s Office.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new faculty/staff records.
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If you mark Automatically load when creating new records, the default values are added automatically when
you open a new faculty/staff record. If you do not mark Automatically load when creating new records, you
can place the cursor in a field and press F2 to load a single default value from the set. Or you can press

SHIFT + F2 to load all the values from the default set.

Individual

For Individual options on the Records tab, you can select the tab to display when an individual record is opened,
the tabs to check for data, and the appearance of the name on the record.
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Display this tab when a record is opened. Select the tab to appear first when you open an organization
record.

Title bar display. Select the appearance of individual names on the title bar of records and in the Recently
Accessed Records list.

¢ If you select Full Name, the title bar displays the name as defined on the record.
¢ If you select From Record, select Primary Addressee or Primary Salutation as the field to use.

¢ If you select From Addressee Table, select the addressee/salutation to use. Addressee/Salutations are
defined in Configuration. For more information, see the Configuration Guide for Registrar’s Office.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new individual records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new individual record. If you do not mark Automatically load when creating new records, you can

place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.
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Organization

For Organization options on the Records tab, you can select the tab to display when an organization record is
opened and the tabs to check for data.
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Display this tab when a record is opened. Select the tab to appear first when you open an organization
record.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the

name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new organization records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new organization record. If you do not mark Automatically load when creating new records, you
can place the cursor in a field and press F2 to load a single default value from the set. Or you can press

SHIFT + F2 to load all the values from the default set.
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Room

For Room options on the Records tab, you can select the tab to display when a room record is opened and the
tabs to check for data.
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Display this tab when arecord is opened. Select the tab to appear first when you open a room record.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about
color options, see “Color Options” on page 146.

Default set to use [ ]. In this field, select a default set to use for new room records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new room record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2
to load all the values from the default set.
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For Course options on the Records tab, you can select the tab to display when a course record is opened, the tabs

to check for data, the appearance of the name on the record, and default tab filters.

Student
Faculty/Staff
Individual
Organization
Room

orge Limit
= Courge Grading
Academic ear
Scheduling
Attendance
Grades

Address
Residence Life
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Display this tab when a record is opened. Select the tab to appear first when you open a course record.

Note: If you mark options in the Check these tabs for data box, opening a record is noticeably slower.

Check these tabs for data. Mark the checkboxes for the tabs you want checked for data. If data is present, the
name of the tab is colored based on your selection on the Color tab in Options. For more information about

color options, see “Color Options” on page 146.

Title bar display. Select the appearance of the items in the title bar and Recently Accessed Records lists. In the

Field Name column, select the field from the course record and in the Length column, enter the number of
characters for the field.

Default tab filters. Select the academic year to filter for the Students and Classes tabs. You can change the filter

at any time when viewing the tab.

Default set to use [ ]. In this field, select a default set to use for new course records.

If you mark Automatically load when creating new records, the default values are added automatically when
you open a new course record. If you do not mark Automatically load when creating new records, you can
place the cursor in a field and press F2 to load a single default value from the set. Or you can press SHIFT + F2

to load all the values from the default set.
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Course Limit

For Course Limit options on the Records tab, you can assign default class size and classes per term.
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Student
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Course Limit Options
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Fioom Class size 1
Course —

& Limit - Classes per berm 1
Courze Grading
Academic Year
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Course Limit Defaults. Enter the defaults for minimum, target, and maximum class size and classes per term.
The defaults appear in the Course Limits grid on the Restrictions 1 tab of course records.

Course Grading

For Course Grading options on the Records tab, you can select the default translation table for course grading
information.

Default translation table. Select the default translation table to appear in the Translation Table column on the
Grading tab of course records.

Academic Year

For Academic Year options on the Records tab, you can select the number of past and future academic years to
appear in lists.
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Show future Academic Years. Specify the number of future academic years to show in lists. The current
academic year always appears.

Show past Academic Years. Specify the number of past academic years to show in lists. The current
academic year always appears.
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Scheduling

For Scheduling options on the Records tab, you can select to receive a prompt when changing views and deleting
enrollments. You can also define how you want to display courses and cycle days.

Prompt to save when changing views. Mark this checkbox to receive a message prompting you to save \
changes when switching views. If unmarked, the program automatically saves any changes when switching
views.

Prompt to delete requests when deleting enrollment. Mark this checkbox to receive a message
confirming that you want to delete requests when you delete an enrollment. If you do not mark the checkbox,
you cannot delete requests when deleting enroliment.

Display cycle day using [ ]. Select to display cycle days as Display Code or Day throughout the scheduling
process.

Display course using [ ]. Select to display courses by Course ID or Course Name throughout the scheduling
process.

Display class using [ ]. Select to display classes by Course ID or Course Name throughout the scheduling
process.

When viewing course requests. Mark the checkboxes for the columns you do not want to appear when you
view course requests.

Attendance

For Attendance options on the Records tab, you can select the default attendance entry dates.
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Default attendance entry dates. Select default attendance entry dates of “Week”, “Day”, or “Month” to
appear when entering attendance. For example, if you enter attendance for the entire week on Fridays, you
can select “Week” to have the current week appear in the grid.

Default attendance date. Select the day to display when entering attendance.

Prompt to save attendance when switching views. Mark this checkbox to receive a message prompting
you to save attendance when switching views. If unmarked, attendance is saved automatically when
switching views.

When taking class attendance, show students who have withdrawn. You can select to show
withdrawn students when taking attendance.
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Show indicator for cells with comments attached. Mark this checkbox to view a comment indicator for
any attendance entry with an assigned comment. The indicator is a red triangle in the upper right corner of
the cell.

Show [ ] in column headers when entering attendance. Select the column headers to appear when
entering attendance. You can select “Both cycle day and day of week”, “Cycle day”, or “Day of week”.

Grades

For Grades options on the Records tab, you can select the columns appearing on the grades entry screen, the
appearance of student and teacher names, and to receive a prompt when switching views.

Show these columns. Specify columns that appear by default when accessing Enter Grades by Teacher, Enter
Grades by Course, or Enter Grades by Student. For each of these areas, you can choose from these options:

¢ Grade columns only — only the Grade column appears.

¢ Comment columns only — only the Comment column appears.

¢ Grade and Comment columns — both the Grade and Comment columns appear.

¢ Grade and Credit columns — the Grade, Credits Attempted, and Credits Earned columns appear.

¢ All columns — the Grade, Attempted Credits, Awarded Credits, Use in Calculations, Print Grade on
Transcripts, Print Grade on Report Cards, Comment, Print Comment on Transcripts, and Print Comment
on Report Cards columns appear.

Student Addressee/Salutation. Select the addressee/salutation to use for students’ names on screens and
grids.

Teacher Addressee/Salutation. Select the addressee/salutation to use for teachers’ names on screens and
grids.

Display course using. Select whether to display the course name or course ID in the Course column of the
grid.

Prompt to save grades when switching views. Mark this checkbox to receive a message prompting you to
save changes when you switch views. If unmarked, the program automatically saves any changes when
switching views.

Address

For Address options on the Records tab, you can select the default address type to use.
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Default address type. Select the address type to use by default for records.
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Residence Life

If you have the optional module Residence Life, you can set Residence Life options on the Records tab. You can
select the tab to display when a residence hall is opened, the default meal plan, and to receive a prompt when
switching views.
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Residence Life

Display this tab when a record is opened. Select the tab to appear first when you open a residence life
record.

Default Meal Plan. Select the meal plan to use by default for residence life records.

Prompt to save when changing views. Mark this checkbox to receive a message prompting you to save
changes when switching views. If unmarked, the program automatically saves any changes when switching
views.

Query Options

On the Query tab, you can define general, advanced, and code table preferences for queries you create. General
qguery options include several default settings, such as which tab appears first when you open a query and which
query format to use. For Advanced query options, you can specify how you want Yes/No fields to appear,
whether to automatically add criteria and sort fields as output fields, and how you want to apply filter criteria to
summary fields. For Code Table options, you specify how you want to display and sort table entries.
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General Query

For General options on the Query tab, you can set defaults to save you time during data entry.
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Tip: Default settings appear automatically when you create a new query. This feature can save you time,
particularly if you create queries primarily using either the dynamic or static format.

Default query format. Select Dynamic or Static, depending on which query format you create most often. You
can manually change this setting when you create a query.

Include in. This setting defaults to Query Lists.
Default tab. Specify the tab that appears first when you open a query record: Criteria, Output, Sort, or Results.

Automatically save query parameters on close. To automatically save the query when you close it
without the program asking you, mark the checkbox. Be aware that if you make changes that you do not want
saved, you must click Cancel to close the query or your changes will be saved automatically.

Display number of records found on all queries. To view the number of records found in each query in
the Records column on the Query page, mark the checkbox.

Automatically run queries when opened. To automatically run a query when you open it, mark the
checkbox. This saves a step if you routinely open dynamic queries in order to run them and view the latest
results.

Display selection fields alphabetically. To display the field selections under each field type on the Criteria,
Sort, and Output tabs of a query in alphabetical order, mark the checkbox. Otherwise, fields are listed in the
order they appear on the field type records.

For example, the first four field selections for the Account field type normally are listed as Account,
Description, Category, Class. When alphabetized, the first four field selections for Account are Account,
Active/inactive, Cash flow, and Category.
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Advanced Query

For Advanced options on the Query tab, you set options that affect the query output.
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How do you want to display “Yes/No” fields? When a value equals Yes/No, you can select this value to be
displayed as True/False, True/(Blank), T/F, Yes/No, Yes/(Blank), or Y/N.

For example, on a Vendor query, the 1099 Vendor field selection equals a Yes/No value.

How do you want to apply filter criteriato summary fields? When you select a Summary field, you can
have the program ask you each time if you want to apply applicable criteria to the summary field. If you are
sure you never want to apply existing field criteria, mark Do not automatically apply all query criteria. If you
always want to apply existing field criteria, mark Automatically apply all query criteria.

Note: If you normally select most of the criteria fields as output or sort fields, marking these checkboxes can
save you time. On the Output and Sort tabs, you can still individually remove any fields you do not want.

Automatically add criteria fields as output fields. If you want all fields selected on the Criteria tab to
automatically be added as output fields on query results, mark the checkbox.

Automatically add sort fields as output fields. If you want all fields selected on the Sort tab to
automatically added as output fields on query results, mark the checkbox.



140 CHAPTER

Code Table

For Code Tables options on the Query tab, you can determine how you want the program to sort and display
table entries that have been coded into the program.
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How do you want to display code table entries? You can select to display code table entries by short or
long description on query results.

How do you want to sort code table entries? You can select to sort table entries alphabetically or by the
table order set up in Configuration.

Export Options

On the Export tab, you can set a default export format, select to automatically save an export when closing it, and
select the format to export yes/no fields. These options apply only to files created in Export, not to exports
created elsewhere in the program.
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Automatically save export parameters on close. To automatically save the export when you close it
without the program asking you, mark the checkbox. Be aware that if you make changes that you do not want
saved, you must click Cancel to close the export or your changes will be saved automatically.

Default export format. Select the export format you use most frequently.
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When exporting yes/no fields, export [ ]. When a value equals Yes/No, you can select this value to be
displayed as True/False, True/(Blank), T/F, Yes/No, Yes/(Blank), or Y/N.

When exporting code table entries, export [ ]. With this option you can set the default format for how
code table entries are exported. Your choices are “Long description” or “Short description”. Keep in mind, this
is the default; you can change the setting when a code table entry is selected for export. You can choose
either the short or long description on a per-export basis on the Description Format screen.

Setting this user option affects what is exported from all code tables with short and long descriptions, except
those that currently have both options available as separate fields in export.

Reports Options

For Reports options, you can select a default print setup, set the program to automatically save a report
parameter file when you close it, and automatically resize the report preview window to full screen size. The
options you set on Reports tab affect all reports you create.
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™ automatically save report parameters on close

™ Automatically maximize preview window

YYou can chooze to print in landscape or portrait based on the
report or the print setup.

Az defined for the Repart
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Note: Be aware that if you mark Automatically save report parameters on close and make unwanted changes
to an existing report parameter file, you must click Cancel to close the report. Otherwise, the original report
parameter file will be overwritten.

Automatically save report parameters on close. To automatically save report parameters when you close,
mark the checkbox.

Automatically maximize preview window. If you want the report preview window to automatically appear
as full screen size, mark the checkbox.
You can choose to print in landscape or portrait based on the report or the print setup. Select

whether to use the print settings defined on the General tab of the report parameter file or the settings
defined in Print Setup. You can access the Print Setup screen by selecting File, Print Setup from the shell

menu bar.

Administration Options

For Administration options, you can define preferences for Global Change, Import, and the optional module
Accounting Queue.
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Global Change

Note: Be aware that if you mark Automatically save global change parameters on close and make unwanted
changes to an existing global change parameter file, you must click Cancel. Otherwise, the original global
change parameter file will be overwritten.
For Global Change options on the Administration tab, mark the checkbox if you want to automatically save a
global change parameter file when you close it. Be aware that if you mark Automatically save global change

parameters on close and make unwanted changes to an existing global change parameter file, you must click
Cancel. Otherwise, the original global change parameter file will be overwritten.

% Options

Calar | Erintingl File Localionsl

generall ﬂomel ﬂecordsl _D_ueryl E:-cporll Reports

'ou can uze these options to set personal preferences for global change and import,

gt Global Change Options

QE-L-‘-EGu;eraI ™ Automatically save global change parameters on close

+~Enport default:
“Schedule

Import

For Import options on the Administration tab, mark the checkbox if you want to automatically save an import
parameter file when you close it. Be aware that if you mark Automatically save import parameters on close and
make unwanted changes to an existing import parameter file, you must click Cancel. Otherwise, the original
import parameter file will be overwritten.

&% Options ME E3

; Calor | Erintingl File Locationsl

Eenerall ﬂomel Eecordsl _D_ueryl E:-cpoltl Reportz

% r'ou can uze these options to set personal preferences for global change and import,

Llobal Change Import Options

QE-L-‘-EGu;eraI [~ Automatically save import parameters on clase

B wport defaulks
=Sehedule
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Queue General

For Queue General options on the Administration tab, you can set the default program and module for which you
want to run the queue. You can also mark the setting to create a control report and designate how you want it
formatted and whether to export it, send it as e-mail, or print it. These options appear only if you have the
optional module Accounting Queue.

fita Dptions

ﬁenelall ﬂomel Becordsl _D_ueryl Expoltl Reports Color | Erintingl File Locationsl

% Y'ou can use these options to set personal preferences for global change and import.

Global Change General Options
Import

Queue

[ Automnatically save queue parameters on close

[ General
Export defaults
L-Schedule [refault system: IAccounts Papable 'l

D efault maduls: I Reparts j

I~ Create a control report

Format: I j
Action: I j

Note: Be aware that if you mark Automatically save queue parameters on close and make unwanted changes
to an existing queue parameter file, you must click Cancel. Otherwise, the original queue parameter file will be
overwritten.

Automatically save queue parameters on close. To automatically save queue parameters when you close,
mark the checkbox.

Default system. If you normally create queues for a specific program, select a default to save data entry time.
This selection can be manually edited on new queues.

Default module. If you normally create queues for a specific area of the program selected in the Default system
field, select a default to save data entry time. This selection can be manually edited on new queues.

Create a control report. Mark the checkbox if you want to automatically create a control report after running
a queue. In the Format field, select Detail or Summary as the default report format. In the Action field, you
can select to automatically print, export, or send the report as e-mail. If you select Print, fields appear for you
to select the printer and the number of copies. If you select Export, fields appear for you to designate the
export path and data format. If you select Send as mail, fields appear for you to enter the recipient(s) and
designate the data format.
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Queue Export Defaults

For Queue Export defaults options, you can set preferences for both export default types, Query and Reports and
Mail, by toggling between the two options. These options appear only if you have the optional module
Accounting Queue.

f% Options

Qenelall ﬂomel Eecordsl _D_ueryl Expoltl Reparts | Calor | Erintingl File Locationsl

% ¥ou cat uze these optiohs o set personal preferences for global change and import.

Flobal Change Export defaults Dptions
mpork

Queue
+General

Export defaults for: @ Quemy ¢ Reports and Mail

E---Schedule Format: I j

Destination: I _I

Separator: I [*.CHR Farmat only)
Drelimiter: I" [*.CHR Format anly)

Export defaults for. Mark Query to set query export default options and then mark Reports and Mail to set
reports and mail export default options.

Format. Select the default format to use when the export file is created.

Destination. Click the ellipsis button and browse to the correct directory where you want the file exported and
saved.

Separator. Type the character separator to use. This field is only applicable if you selected a character separated
values format.

Delimiter. Type the character delimiter to use. This field is only applicable if you selected a character separated
values format.

Lines per page. This option appears only when Reports and Mail is marked and if you selected a paginated text
data format. Enter a number in the box or use the arrows to increase or decrease the default number.

Use the same number/date formats selected in report. This option appears only when Reports and Mail
is marked. If you want the number and date formats in the export file to default from the settings on the
Format tab of the report parameter file, mark the checkbox.

Queue Schedule

For Queue Schedule options, you can set the program to show only the queues you have created. Queue options
appear only if you have the optional module Accounting Queue.

fit Options

ﬁenelall ﬂomel Eecordsl _D_ueryl E:-cpoltl Reports Color | Erintingl File Locationsl

% Y'ou can uge these options to set personal preferences for global change and import,

|G|°ba| Change Schedule Options
mpork

Queue
#-General

E---E:-:Eort defaults

¥ Only show my queues on the schedule list by default
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Only show my queues on the schedule list by default. To view only your queues and no one else’s
gueues, mark the checkbox.

Fast Options

On the Fast tab, you can define general and processing preferences for datasheets created in Fast! for Accounts
Payable or Student Billing. General options include settings for defaults, such as whether or not you want to use
a default row on the datasheet and how to enter default values in fields. For Processing options, you can specify

how you want to validate data entry, whether to display a confirmation message or create an output query when
you commit records, and when to search for duplicate records.

Fast General

options @]
ﬁenerall Home IBecordsl _D_ueryl Exportl Heporﬁsl gdministlationl Color I Erintingl File Locationsl
ml:'mcessing General Fast Options
Preference | Setking
Maximize data entry screen when opening Mo
Displary datasheet details Yes
Displary First row of datasheet as defaulk row Yes
Enter datasheet defaults by row when placing cursor in row
Automatically save entries in datasheet Mo
Save entries in datashest every 5

Maximize data entry screen when opening. To open the data entry screen automatically to the full size of

your screen, select Yes. To open the data entry screen in a smaller window where you can still view open
screens behind it, select No.

Display datasheet details. To display the Default set and Description fields on the datasheet, select Yes. To
hide these fields by default, select No.

Display first row of datasheet as default row. To use the first row of the datasheet (D) as the default row,

select Yes. Values you enter in this row can be used as defaults for all additional rows you add to the
datasheet.

Enter datasheet defaults. You can select how to enter default values from the default row. If you select by row
when placing cursor in row, default information appears in fields automatically when you select a new row. If

you select by field with the F2 key, default information is entered when you place your cursor in a field and
press the F2 key.

Automatically save entries in datasheet. To have the program automatically save the datasheet at regular
intervals while you enter data, select Yes.

Save entries in datasheet every. If you selected Yes for the Automatically save entries in datasheet option,
enter the number of minutes between saves. The maximum interval is 60 minutes.
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Fast Processing

e~ |
Qenerall Home Fast |Becords| _El_ueryl Exportl Flepor;s' édminislralionl Calar | Erinting' Fil= Localionsl

General

ng Fast Dptions

Preference I Setting
Yalidate data entry when saving the datasheet

Ask 'are you sure? before proceeding with committing records Yes
Displary successfulfunsuccessful message after committing records Yes
Search for duplicates when when committing records
Create autput query when committing records Yes

Validate data entry. select whether to validate data entry row by row or when you save the datasheet. If you
validate row by row, when you move to another row, the program validates the entries in the row you are
leaving. If you validate when saving, the program validates the entries each time the program automatically
saves the datasheet or each time you manually save the datasheet.

Ask ‘Are you sure?’ before proceeding with committing records. If you want the program to display a
confirmation message before committing, select Yes.

Search for duplicates when. Select when to run a duplicate records search on the datasheet. You can select
“row by row” to check each row individually during data entry, or you can select “when committing records”
to check all rows at one time when you commit records.

Note: The Search for duplicates options for FAST work only if you mark the Automatically check for duplicate
invoices checkbox on the Invoice, Business Rules page in Configuration.

Create output query when committing records. If you select Yes for this option, an output query is created
automatically when you commit records.

Color Options

Color options in each program enable you to customize fields and grids for easy recognition and distinction. You
can set General and Legend color options.

To use default colors, click the down arrow and select from the list. To set custom colors, click the paint palette.
When the Color screen appears, you can select from existing custom colors or click Define Custom Colors to use
the color spectrum and gradient.

General

Note: To select a custom color, click the paint palette.
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General color options apply to all programs.

ﬁenerall ﬂomel Becordsl Queryl E:-:portl Hepolﬁsl Administration  Color |Erinting| File Locationsl

A Y'ou can use color options to zet personal preferences for color in the program.

(e General Preferences
Lpgends

iBudget Management Specify the colors bo uze for all grids.

#Journal Entry

iWisual Chart Organizer Required field color: I DE_I,Jan j@l

dillozation Management

~Generate AR Trangaction Fly-over text color: li Blue j@l
Locked cell color: I DEustom Calor j@l

Note: You cannot save records until all required fields are filled.

Required field color. To make adding records quicker and easier, set a color for required fields. Being able to
easily identify required fields prevents you from trying to save a record before required fields are entered.

Fly-over text color. Fly-over text color affects any field with table entries that can be edited. For example, in an
account record in General Ledger, you can edit the field entries for Cash Flow, Working Capital, and Class on
the Account tab. If you set a fly-over text color, when your cursor hovers over the field text, it appearsin a
different color. You can click the field and make edits.

Locked cell color. To easily see which cells in grids and tables cannot be edited, set a color in the Locked cell
color field.
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Legends

Legends color options are program-specific. For each legend type you have highlighted in the left tree view,
options appear on the right. The following example is from General Ledger.

; x|
generall ﬂomel Becordsl Queryl E:-:portl Hepor;sl Adminiztration  Caolor |Erinling| File Localionsl
ﬁ “f'ou can use color options to set personal preferences for color in the program.
eneral Visual Chart Organizer Legends
Legends PRIET
iBudget Managerment Legend Priarity:
aunal Loty + |
zual Chart Hrganized Type
i~Allozation Management Ler'--'el hd |
“Generate AR Tranzaction Stc‘.ntus
Conira
Control
Legend Yalue:
Override other
Type Legend Colar T
Asset W vindow Text [l
Liability B viindow Text -
Met Assets Account . Window Text -
Revenue . Window Text -
Expense . Window Text -
Gift B vvindow Text r
Transfer W vindow Text r
Gain . Window Text -
Loss . Window Text r
Reset to Systemn Defaults | (0]4 I Cancel | Lpply |

Legend Priority. You can set the level of priority for each color legend. The colors for the first selection in the
Legend Priority box takes precedence over the colors of other legends that follow it. In the Legend Priority
box, use the arrows to move selections up or down.

Legend Value. Options appear in the Legend Value grid based on the selection you have highlighted in the
Legend Priority box.

For each item in the Type column, click in the Legend Color column to set a color. Click the down arrow to
select a basic color or click the paint palette to set a custom color.

To ensure the legend color you set in the Legend Value grid is used rather than a pre-programmed color or a
general color option, mark the checkbox in the Override other color settings column.

Printing Options

For General options on the Printing tab, you can define which report parameter files to use as the default when
printing, previewing, and exporting reports and mailings. The reports appearing in the Report column vary,
depending on the program from which you access options.
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To set a default parameter file, click in the Parameter column, and then click the binoculars. On the Select
Parameter File screen, you can select an existing parameter file previously created in Reports or you can add a
new parameter file. For more information about creating a report parameter file, see the Reports Guide for the

specific program.

% Options

ﬁenerall ﬂomel Becordsl Queryl Exportl Hepolﬁsl gdministlationl Caolor

% You can use printing options to determine which parameter files to uze when running reports or mailing functions fram

General Print Options

= other record tpes.

e

File Lozations I

Uze these options to determine what parameters to use when
printing, previewing, or exporting.

Repork

I Parameter

Account Profile
Chart of Accounts
Fund Profile

Project Profile

Fee Schedule Profile
Pool Profile

Wendor Profile
Purchase Order Forms
Asset Profile

Asset Labels
Recurring Invoice

F

Client Profile

Invaices

AR Receipts

Credit Memos ;I
Feszet ta Systern Defaults | [i]% I Catcel | Apply |

File Locations Options

On the File Locations tab, you can set default directory paths to locations where files are saved when exported
from the program. This saves time so you do not have to map the location each time. Also it increases
consistency, reducing the possibility of “lost” files. To select the default file locations for word processing
documents and letters, exported or imported data files, and Excel spreadsheets, in the Location column type the
path or click the ellipses to access the Browse for Folder screen.

@5 Dplions

ﬁenerall ﬂomel Becordsl Quelyl Hepol!sl gdministlationl Caolor I Printing ~ File Locations |

|Ho You can choose the default file locations when exparting files from the system.
-

s |

Locakion

Excel Spreadsheets

ExportfImport Data Files

‘Word Processing Documents/Letters
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If you need information as you work in Blackbaud programs, you can use the help file embedded in the program.

The help file is a compiled Microsoft HTML Help system. It provides information about the many features of
Blackbaud’s software, as well as step-by-step procedures to guide you through the program’s functionality.

Accessing Help

Our help file is context sensitive, which means you can quickly access topics about the program area in which you
are currently working. For example, you want to add payment information to an invoice in Accounts Payable, but
you have not done that before. While the invoice record is open to the Payment/Credits tab, press F1 to open the
help file to the Managing Payments and Credits topic. From there, you can access procedures about scheduling
an invoice payment, paying invoices, or applying credit memos.

To access the help file Welcome page from the menu bar, select Help, Help Topics. To access the help file
Welcome page from the navigation bar, click Help, and select Help Topics.

Using the HTML Help Viewer

The HTML Help viewer is the window where help topics are displayed. When viewing help, you can maximize the
viewer or resize it to your liking. The standard buttons for minimizing and maximizing the window are located in
the upper-right corner.

When you select a help topic, whether from the Search, Index, or Table of Contents tabs, the topic title appears at
the top of the page. Below the title is a list of related links. This information provides a helpful context while you
navigate in the help file. For example, you use the Search tab to find information about invoices, then you open
an invoice topic displaying the title “Generating Invoices”. By viewing the list of links under the title, you can tell
that the topic relates to accounts recievable invoices.

Buttons in Topics

Throughout the help file, links appear so you can find more information about similar topics. When a conceptual
topic corresponds directly to a procedure, the How? button appears at the bottom of the topic. Likewise, when a
procedure corresponds directly to a conceptual topic, the Why? button appears on the procedure.

Click the How? button to view the procedure for the
M information in the current topic.

Why? Click the Why? button to read background information relating
& 10 the procedure.

The HTML Help viewer also includes a Back button for navigating to the previous topic or page.

Using Tabs and the Navigation Pane

You can access all areas of the help file by using the tabs on the left side of the HTML Help viewer. When you
select a left-hand tab, information appears in the navigation pane below the tab.

Contents

The Contents tab displays books and pages representing categories of information in the help file. When you
double-click a closed book, it opens to display its contents. When you double-click an open book, it closes. When
you click pages, topics appear in the right-hand pane of the HTML Help viewer.
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Index

The Index tab displays a multi-level list of keywords and keyword phrases. You can type in keywords to help you
locate specific ideas and concepts. To open a topic associated with a keyword, select the keyword and then click
Display. If the keyword is used with more than one topic, a Topics Found dialog opens so you can select a specific
topic to view.

Search

On the Search tab, you can search the help file for specific words. A list of all the topics containing that word
appears. Full-text searching looks through every word in the help file to find matches. There are also options to
search previous results, find similar words, and search only topic titles. When the search is completed, a list of
topics appears so you can select a specific topic to view. A basic search consists of the word or phrase you want to
find. You can use similar word matches, a previous results list, or topic titles to further define your search.

Basic Rules for Searching

Here are a few basic rules for creating full-text search queries:

¢ Searches are not case-sensitive, so you can type your search in uppercase or lowercase characters.

¢ You may search for any combination of letters and numbers.

¢ Punctuation marks such as the period, colon, semicolon, comma, and hyphen are ignored during a search.

¢ You can group the elements of your search using double quotes or parentheses to set apart each element. You
cannot search for quotation marks.

Finding Information with Full-Text Search

Click the Search tab, and type the word or phrase you want to find.

To... Do...

Search only topic titles Mark Search titles only.

Find words similar to your search Mark Match similar words.
term

Narrow your search Mark Search previous results.

Highlight all instances of search terms Click Options at the top of the view
that are found in topic files screen and select “Search Highlight On”.

In addition, you can use boolean operators with the keywords to make the search more specific. (For more
information about Boolean operators, see “Advanced Search Techniques” on page 153.)

When you are finished entering keywords and setting search options, click List Topics. In the Select topic box,
select the topic to view. Click Display.

To sort the topic list, click the Title, Location, or Rank column heading. Clicking Title alphabetizes the list. Clicking
Rank sorts the list by the number of times the keywords are used in the topic.

Advanced Search Techniques

When using the full-text search feature in help files, you can use advanced techniques, such as wildcards and
boolean operators, to narrow your searches for more precise results.
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Wildcard expressions

You can search for words or phrases using wildcard expressions. Wildcard expressions allow you to search for one
or more characters using a question mark or asterisk. The table below describes the results of these different
kinds of searches.

Searches for Example Results

A single word mail Topics that contain the word
“mail”, and grammatical
variations, such as “mailings”.

A phrase “journal entry” or Topics that contain the literal

journal entry phrase “journal entry” and all its
grammatical variations.
Without the quotation marks, the
query is equivalent to specifying
“journal AND entry,” which will
find topics containing both of the
individual words, instead of the
phrase.

Wildcard expressions install* Topics that contain the terms
“install,” “installing,”
“installation,” and so on.
You can also use a question mark
(?) as a single character marker
when searching. For example, if
searching for a state
abbreviation, “S?” would return
SC and SD.

Boolean operators

The AND, OR, NOT, and NEAR operators enable you to precisely define your search by creating a relationship
between search terms. The following table shows how you can use each of these operators. If no operator is
specified, AND is used. For example, the query “validate database” is equivalent to “validate AND database”.

Note: The /, &, and ! characters don't work as boolean operators; you must use OR, AND, and NOT.

Searches for Example Results

Both terms in the same  merge AND query Topics containing both “merge”

topic and “query”

Either term in a topic preferences OR Topics containing either
options “preferences” or “options” or

both
The first term without vendor NOT Topics containing “vendor”, but
the second term report not “report”

Both terms in the same  post NEAR credit  Topics containing “post” within
topic, close together memo eight words of “credit memo”
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Favorites

On the Favorites tab, you can store a list of your favorite or most frequently used help topics. Whenever you open
the help file, you can quickly go to the topics you view most often by selecting them from this tab. It is simple to
add topics as favorites — when you have found a helpful topic, go to the Favorites tab and click Add. You can
update the list at any time by removing topics you no longer want included as favorites.

Using Buttons

Our help file contains buttons above the navigation pane and viewer to help you access information quickly.

Back

Use the Back button to quickly navigate to the previous topic or page.

Refresh

To reload a help topic that did not fully appear, click Refresh.

Print

While using the help file, you can print topics and information directly from the HTML Help viewer. The available
print options can vary depending on the version of Windows and Internet Explorer on your system.
To print a single topic

1. Click Print.

2. Mark Print the selected topic, and click OK.

To print all topics in a selected book

1. Click Print.
2. Mark Print the selected heading and all subtopics, and click OK.

Options

The Options button opens a menu with selections for hiding the left-hand tabs, going back and forward, stopping
a topic or Web page from loading, refreshing the information displayed in the window, printing, and turning
search highlighting on or off. You can also access Internet options from this menu.

Glossary

The glossary provides a list of words and short phrases, and their definitions, related to the program. To access
the glossary, click the Glossary button at the top of the view screen or click the link that appears at the bottom of
each topic.
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Blackbaud on the Web

Because the HTML Help viewer uses components of the Internet Explorer browser, it can take you to websites. To
visit the Blackbaud website, click Blackbaud on the Web.

Educational Services

You can find additional information about Blackbaud products on our website at www.blackbaud.com. We
encourage you to bookmark this site and check it often. If your organization participates in our maintenance
programs, you can access the Support area of our website where you can download latest versions of our
software, review the user guides, participate in forums and much more. You can also use Knowledgebase to
search for solutions to any issues you may encounter.

To help you get the most out of your Blackbaud software, we also offer a wide selection of education options:

Blackbaud University. Blackbaud offers a variety of classes in Charleston, South Carolina. For more
information about class descriptions, schedules, or online registration, visit the Training area of our website
at www.blackbaud.com.

Regional education. Blackbaud now offers education in more than 30 locations throughout North America.
State-of-the-art training facilities provide an ideal setting for you to develop your knowledge and skills with
the software.

On-site education. Training at your organization’s site is a cost-effective option if your organization cannot
afford to have staff members away from the office for several days. The Blackbaud instructor can teach
standard course curricula or create a special training program to meet your organization’s specific needs.
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options
records 68
general option 66
global change
options 142
glossary button, in help file 155
go menu 7
grade
options 136
grant activity
options 78
grant record
options 78
grid
filtering criteria 14
overview 5
sorting information 23
group, adding favorites 50
guide, user 9

H

help
accessing 152
overview 9
topics 9

help file
advanced search techniques 153
back button 155
boolean operators 154
buttons in topics 152
contents 152
full-text search 153
glossary 155
HTML help viewer, using 152
index 153
menu 9
navigation pane, using 152
options 155
printing topics 155
search tab 153
searching 153
tabs, using 152
topics 9
wildcards 154

help menu 9

help topic 9

hiding columns 24

home option 67, 68

home page
favorites 46
options 68

hot key 5

how? button 152

HTML help viewer, using 152

import
options 142

inactive record
making inactive 31
overview 31

index tab, help file 153

individual record, Admissions Office
options 125

individual record, Registrar’s Office
options 130

individual record, Student Billing
options 111

invoice activity
options 81

invoice line item
options 93, 117

invoice record, Accounts Payable
options 81

invoice record, Accounts Receivable
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options 93
invoice record, Student Billing
options 117

J

Journal Entry
batch reports options 77
options 74
post options 75
processes options 75

K

key
function 11
hot 5
Knowledgebase 9

L

line item
options 84
list, sorting 22
loading default sets 45
locating, see finding

M

media
adding 39, 41
overview 39
menu
edit 6
favorites 8
file 5
go7
help 9
record 8
right-click shortcut 10
tools 9
view 7
menu bar 4
miscellaneous search option 26
modifying, see editing

N

navigating
in The Education Edge 2
in The Financial Edge 2
navigation bar
overview 3

note, adding to records 35

open screen 26

buttons 25

opening records

from another record 27
from open screen 27
overview 25

using search field 29

option 141

academic years, Admissions Office 127
academic years, Registrar’s Office 134
account activity 69

account records, General Ledger 69
Accounts Payable 79

Accounts Payable, records 79
Accounts Receivable 86

activity summaries, Student Billing 114
activity, Student Billing 113

addresses, Admissions Office 128
addresses, Registrar’s Office 136
addresses, Student Billing 123
Admissions Office 123

advance deposit items 121

advanced query 139

applicant records 123

asset activity 101

asset records 100

Attendance 135

automatic payments 114

billing item, Accounts Receivable 89
billing item, Student Billing 110

billing schedule records 122

Budget Management 77

Cash Receipts 97

charge records, Accounts Receivable 91
charge records, Student Billing 115
charge/advance deposit items 108
charges/line items 88

client activity 90

client records 90

code tables 140

color 146

color legends 148

course grading 134

course limits 134

course records 133

create payment, Accounts Payable 86 ,
credit memo activity 83

credit memo records 82

credit records, Accounts Receivable 92
credit records, Student Billing 116
deposit records, Accounts Receivable 96
deposit records, Cash Receipts 98
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deposit records, Student Billing 120
editing print grid options 58

employee activity 104

employee records 103

employee summaries 105

Export 140

faculty/staff records, Admissions Office 124
faculty/staff records, Registrar’s Office 129
Fast 145, 146

file locations 149

financial aid items 121

Fixed Assets 99

general color options 146

General Ledger, records 68

general options 66

general query options 138

global change 142

grades 136

grant activity 78

grant record 78

home page 67

import 142

individual records, Admissions Office 125
individual records, Registrar’s Office 130
individual records, Student Billing 111
invoice activity 81

invoice line items 93, 117

invoice records, Accounts Payable 81
invoice records, Accounts Receivable 93
invoice records, Student Billing 117
Journal Entry 74

Journal Entry batch reports 77

Journal Entry post 75

Journal Entry processes 75

line items 84

organization records, Accounts Payable 82
organization records, Admissions Office 126
organization records, Registrar’s Office 131
organization records, Student Billing 112
overview 66

payment records, Accounts Payable 85
payment records, Accounts Receivable 97
payment records, Cash Receipts 98 , 106
payment records, Student Billing 120
payments/credits, Accounts Receivable 89
payments/credits, Student Billing 109
printing 148

product records, Accounts Receivable 89
product records, Student Billing 110

project activity 71

project budget 72

project records 71
purchase order activity 84
purchase order records 83
Query 137

queue export defaults 144

gueue general options 143
queue schedules 144

receipt records 85

records, Fixed Assets 99
records, General Ledger 69, 87
records, Registrar’s Office 128
records, Student Billing 107

recurring invoice records, Accounts Receivable

94
refund records, Accounts Receivable 96
refund records, Student Billing 119
Registrar’s Office 128
Reports 141
residence life, Registrar’s Office 137
return line items 95, 118
return records 94, 118
room records, Admissions Office 127

room records, Registrar’s Office 132 Scheduling

135

Student Billing 107

student records, Registrar’s Office 128
student records, Student Billing 110
time and attendance 105
transaction activity 102

transaction records 101

vendor activity 80

vendor records 79

vendor summaries 80

Visual Chart Organizer 73

options
general 66
help file 155

overview 141

options button 155

organization record, Accounts Payable
options 82

organization record, Admissions Office
options 126

organization record, Registrar’s Office
options 131

organization record, Student Billing
options 112

organizing favorites 54

output query 19

P

password, changing 56
payment record, Accounts Payable

options 85
payment record, Accounts Receivable

options 97
payment record, Cash Receipts
options 98
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payment record, Student Billing
options 120

payment/credit, options
Accounts Receivable 89
Student Billing 109

preferences, see options
print grid, editing options 58
printer, setting up 57
printing
action reminders 38
all help file topics 155
editing print grid options 58
help file topics 155
options 148
overview 57
selecting parameter files for reports 59
setting up printers 57
single help file topics 155
product record, Accounts Receivable
options 89
product record, Student Billing
options 110
project activity
options 71
project budget
options 72
project record
options 71
purchase order record
activity options 84
options 83

Q

Query
advanced options 139
general options 138
options 137

R

range of filters 17
range, filtering criteria 18
receipt record
options 85
record
actions tab 35
adding
actions 36
favorites 46
media 39, 41
notes 35
attributes, adding 33

deleting 30
designating favorites 46
finding 25
ID 29
making inactive
from open record 31
overview 31
media 39
media tab 39
menu items 8
opening
from another record 27
from open screen 27
using search field 29
parts of the screen 4
saving 30
search options 26
searching for duplicates
from open records 32
overview 31
searching the database 25
record menu 8
record screen
action bar 4
grids 5
menu bar 4
overview 4
status bar 5
tabs 4
title bar 4
toolbar 4
record, Fixed Assets
options 99
record, General Ledger
general options 87
options 69
record, Payroll
options 103
record, Student Billing
options 107
recurring invoice record, Accounts Receivable
options 94
refund record, Accounts Receivable
options 96
refund record, Student Billing
options 119
Registrar’s Office
duplicate records 32
options 128
report, selecting parameter files for printing 59
Reports
options 141
residence life, Registrar’s Office
options 137
return line item
options 95, 118
return record
options 94, 118
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right-click shortcut menu 10

room record, Admissions Office
options 127

room record, Registrar’s Office
options 132

S

saving records 30
Scheduling
options 135
screen element
overview 4
selection boxes 11
tree views 11
search
advanced techniques 153
basic help file rules 153
full-text 153
using wildcards 154
search field 29
search tab, help file 153
searching, see also finding
for duplicate records
from open records 32
overview 31
the help file 153
security, changing passwords 56
selection box
filtering criteria 16
overview 11
serial number 9
shell, overview 2
shortcut
menu 10
showing tooltips 67
sorting
columns 24
information in grids 23
lists 22
status bar 5
Student Billing
options 107
Student billing
duplicate records 32

student record, Registrar’s Office

options 128

student record, Student Billing
options 110

system information 9

T

tab, overview 4
table
editing entries 12

overview 12
time and attendance
options 105
title bar
on records 4
overview 3
toolbar
buttons 4
toolbar, showing tooltips 67
tools menu 9
tooltips option 67
training 156
transaction record
activity options 102
options 101
tree view 11

U

user guide 9

V

vendor record
activity options 80
options 79
summary options 80
version number 9
view menu 7
view screen, help file 152
viewing
action reminders 37
software information 9
Visual Chart Organizer
options 73

W

web page, designating as favorite 47
web site, accessing Blackbaud 156
why? button 152

wildcard 154
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